THE ESSENTIAL GUIDE TO LANDSCAPE PHOTOGRAPHY
EVERYTHING YOU NEED TO SHOOT STUNNING IMAGES WITH YOUR DIGITAL SLR

UPDATING CONTENT!
ADVICE AND TECHNIQUE FROM THE UK’S LEADING EXPERTS

FROM THE EXPERTS AT Digital SLR photography

2ND EDITION
Every once in a while there’s a world changing technological breakthrough. Here it is.

The Nikon D90. The world’s first DSLR to shoot D-Movie high definition video.

12.3 megapixel Nikon DX format CMOS sensor. ISO 100 to 6400 equivalence. Expeed image processing. Active D-Lighting.
11 point AF. 3-D tracking AF. Advanced Scene Modes. Live View with face detection. 3 inch LCD. Image Sensor Cleaning. Extensive in camera retouching. D-Movie High Definition 720p video. GPS compatibility. Welcome to Nikon.

For 2 year warranty on any camera and lens kit simply register your new Nikon purchase. Call 0800 498 5980 or visit www.nikon.co.uk/register.
Welcome...

"Heading out to the great outdoors to capture stunning images is a passion shared by millions of photographers from novices through to enthusiasts and professionals. Heading to a location, where we wait prepared for that fleeting moment where all the elements come together to bless us with an incredible scene, is what draws so many of us to landscape photography. Of course when that moment arrives, you need to know what to do to ensure you capture the scene to its maximum potential. The Essential Guide to Landscape Photography provides all the information, advice and inspiration that you need to take great landscape images. This guide is packed with expert guidance from some of the UK’s most successful and popular outdoor photographers. Our emphasis is on in-camera techniques, in other words, how to develop your creative eye and master your digital SLR, but we also cover the key Photoshop techniques and tools you need to add that final touch of class to your images. We hope this guide helps you improve how you compose a scene so you can shoot landscape images like a pro. All the best!"

DANIEL LEZANO, EDITOR

Meet our landscape experts

All our experts are regular contributors to Digital SLR Photography magazine. For expert advice and inspiration to help you improve your photo skills, pick up the latest issue, available on the second Tuesday of every month. For further information, visit: www.digitalslrphoto.com

MARK BAUER
Former teacher, now one of the UK’s leading landscape photographers and an expert on Donegal’s Jurassic coastline and the New Forest.
www.markbauerphotography.com

ROSS HODDINOTT
Ross is an award-winning photographer with many years of experience capturing the diverse beauty of the British’s landscapes and wildlife.
www.rosshoddinott.co.uk

HELEN DIXON
Helen is living the dream, having given up a full-time job to become a professional landscape photographer. She is one of the UK’s most talented, www.helendixonphotography.co.uk

LEE FROST
A pro for two decades, Lee Frost’s one of the best-known names in the UK photography business, with 20 books to his name and worldwide image sales.
www.leefrost.co.uk
THE ESSENTIAL GUIDE TO LANDSCAPE PHOTOGRAPHY

CONTENTS

007 Introduction to landscapes
Be prepared to learn and exploit the fundamentals of landscape photography

008 Composition
We reveal the key techniques you'll need to master to take perfectly-exposed landscapes
014 SPECIAL TUTORIAL: USING LEAD-IN LINES
016 SPECIAL TUTORIAL: FOREGROUND INTEREST

019 Exposure
Master these simple techniques and your handling of light levels will be right every time
024 SPECIAL TUTORIAL: APERTURE PRIORITY
026 SPECIAL TUTORIAL: SHUTTER SPEEDS
028 PHOTOSHOP TUTORIAL: RAW FILES

031 Sharpness
The best techniques for super-sharp scenes
032 SPECIAL TUTORIAL: HYPERFOCAL FOCUSING
034 SPECIAL TUTORIAL: FOCUS FOR SHARPNESS
036 SPECIAL TUTORIAL: SHUFFLE FREE IMAGES

040 Lighting
Predict and exploit the best lighting
046 SPECIAL TUTORIAL: TIME OF DAY
048 SPECIAL TUTORIAL: MAGIC HOUR & SUNSETS
050 SPECIAL TUTORIAL: MISTY MORNINGS
052 SPECIAL TUTORIAL: TWILIGHT SEASCAPES
054 SPECIAL TUTORIAL: STAR TRAILS

057 Filters
Use filters to improve and enhance your shots
062 SPECIAL TUTORIAL: USING AN ND GRAD
064 PHOTOSHOP TUTORIAL: DIGITAL FILTER

066 Water in landscapes
Why water works so well in landscapes
070 SPECIAL TUTORIAL: SHOOT MOVING WATER

073 Colour
Learn the relationship on colour in scenes,
076 SPECIAL TUTORIAL: Vaseline a scene
078 SPECIAL TUTORIAL: WHITE BALANCE
080 SPECIAL TUTORIAL: BLACK & WHITE
082 PHOTOSHOP TUTORIAL: B&W CONVERSION

086 Expert Gems: Seasons
Brilliant ideas to keep you busy all year round
088 PHOTOSHOP TUTORIAL: SEASONAL COLOUR

099 Landscape gear
The best equipment for outdoor photography
100 IDEAL KITS FOR YOUR REQUIREMENTS
106 WIDE-ANGLE LENSES
110 SPECIAL TUTORIAL: WIDE-ANGLE LENSES
112 SPECIAL TUTORIAL: TELEPHOTOS
114 CHOOSING THE RIGHT TRIPOD
116 CHOOSING THE RIGHT BAG
119 LANDSCAPE ACCESSORIES

123 UK location guide
40 great UK locations for you to explore!

154 Perfect exposures
Cut out and use our free grey card!
SanDisk Extreme®
The Memory for Professionals

As a photographer, you’ve carefully chosen your camera, lenses and kit, but have you chosen the right memory to get the most out of it?

You need speed and performance. SanDisk Extreme memory cards deliver unrivalled speed you can shoot faster to capture the shots that others miss – the key moment in the game, the instant the world changes.

Faster shooting is just the beginning. More speed means quicker workflow. Take less time to run through your shots – and they are on the picture editor’s desk while other photographers are still downloading theirs.

But performance means reliability as well as speed. SanDisk Extreme is built to perform in challenging environments. Desert heat, jungle humidity, arctic cold, shock and vibration; in conditions beyond those you can stand, your SanDisk memory keeps on working and keeping your images safe.

And with industry leading capacities, SanDisk Extreme will see you through the longest, most demanding assignments. Take all the shots you need – thousands of images, even with RAW formats – even on remote location shoots.

SanDisk Extreme memory is the choice of professionals around the world. Shouldn’t you go to the extreme?

www.SanDisk.co.uk

* Subject to stock availability. 1 gigabyte (GB) = 1 billion bytes. Speeds based on SanDisk internal testing. SanDisk, the SanDisk logo, SanDisk Extreme and CompactFlash are trademarks of SanDisk Corporation, registered in the US and other countries. SDHC and the SDHC logo are trademarks. Memory Stick PRO Duo mark and logo is a trademark and registered trademark of Sony Corporation. Other brand names mentioned herein are for identification purposes only and may be trademarks of their respective holder(s). Information correct as of April 2009 © 2009 SanDisk Corporation. All rights reserved.
THE BASICS

CAPTURE STUNNING LANDSCAPES – we all want to be able to do it. Fantastic landscapes inspire more photographers than any other type of image and on the face of it, well, it should be easy to do. Find an awesome vista and point your digital SLR at it; press the shutter and that should do the trick. This simple approach will probably bag you a decent snap, but often the image you capture will not do justice to the glorious scene in front of you.

We’ve all been a little bit disappointed by a photo that doesn’t quite live up to our great expectations. The difference between a decent snap and a stunning image is often down to a few versatile ideas, some easily-learned expert knowledge, the right equipment choice and careful planning. This inspirational guide will provide you with an excellent grasp of these fundamentals and help you transform your shots from the ordinary into something very special indeed.
COMPOSITION

MORE THAN ANY OTHER factor, composition can turn an OK image into a masterpiece. There are a small number of techniques that, once learned, will serve you well in many different situations.

Composing the elements in the frame is the real ‘art’ of taking great pictures. Carefully consider how points of interest are arranged and how they relate to each other.

Placing a subject centrally in the frame usually results in a static rather than dynamic composition. Placing the subject off-centre, encourages the eye to move around the frame more. One way of dividing the frame up to achieve harmony is to use the ‘rule-of-thirds’ (see below). This proportion often occurs in nature, and there is research to suggest that our brains are ‘hard-wired’ to find these arrangements more attractive.

1) The ‘rule-of-thirds’

This is a simple way of organising the elements in the frame so that they make a balanced composition. As a compositional tool, it’s been around for a few centuries and is a simplified version of the ‘golden section’ which is used in art and architecture.

Imagine two vertical lines dividing the viewfinder into thirds. Now, do the same with two horizontal lines. You then organise the main elements of the picture within this grid. For example, with a simple landscape, place the horizon on one of the lines, so that you have two-thirds land and one third sky, or vice-versa.

If you have a strong focal point, such as a tree or building, you can place it on one of the points where the horizontal and vertical lines intersect. This will make a much more dynamic composition than if you were to place the focal point centrally, which can make a picture look rather static. Inexperienced photographers often put the subject right in the middle and it rarely works.

Moving an element of a scene to a different intersection can create a startlingly different image, such is the power of the rule-of-thirds. Don’t be afraid to experiment with different variations on a theme.

RULE-OF-THIRDS GRID: This image follows the rule-of-thirds quite closely. There is approximately two-thirds land/sea and one-third sky. The lighthouse and obelisk are divided by the left vertical, each equi-distant from it.
2) Foreground Interest
You see, the problem is, the world is three-dimensional and a photograph is two-dimensional. One of the main reasons that landscape images fail is that they don’t convey the sense of depth that our eyes see. Fortunately, there are a few compositional tricks that we can employ to get round this rather frustrating little problem.

A very effective way to create depth in a photograph is to include a strong foreground, often in conjunction with a wide-angle lens. Emphasising the foreground in this way will add depth to the picture by creating an ‘entry-point’ for the eye, pulling the viewer into the scene and giving the picture a sense of distance and scale.

Wide-angle lenses help this technique because they stretch perspective, exaggerating the elements close to the lens and opening up the view beyond the foreground.

But be careful, this can result in the middle distance looking empty and lacking in interest so the trick is to shoot from a lower viewpoint. This compresses the middle distance, so that there isn’t too much empty space in the composition. You’ll also need to use a small aperture and focus carefully to maximise depth-of-field, keeping foreground and distant objects in focus (we’ll explain how to do this later).

3) Lead-in Lines
Lines represent depth in a picture and can be used to lead your eye into the picture and guide it around the scene. Lines are everywhere: man-made, such as roads, paths and hedgerows, or natural, such as rivers or the coastline - all will add dynamism to your photographs. Lines don’t have to be real, they can be ‘implied’ like the patterns created by waves over a longish exposure, or objects pointing into the frame. Lots of things can bring linear energy into your work.

Straight, converging lines are very dynamic and can give a lot of impact to a picture, but there is always the danger that the eye follows the lines into and then very quickly out of the frame again. Pictures with only converging lines might have immediate impact, but can still be unsatisfying. It’s a good idea to try and place some object of interest within the frame – a figure or a tree, for example – to give the eye something to settle on within the scene.

Lines that curve gently in an ‘S’ shape lack the immediate impact of straight, converging lines, but can result in a more satisfying image. They can lead the eye gently through the whole picture, allowing the viewer to take in other elements within the composition.

4) Layers and Planes
Another in-camera technique that can be used to add depth to an image is to create a ‘layered’ effect. Layers in an image can be created by having a series of overlapping shapes (see right) or by strong side-lighting, creating alternative bands of light and shade that can give the effect of a ‘layering of light’.

This kind of technique works particularly well with longer lenses that have the effect of compressing perspective and ‘stacking’ overlapping forms. Each layer, or plane, appears thinner and closer to the next, exaggerating the effect. Just remember longer lenses will produce less depth-of-field so you’ll need to use smaller apertures, such as f/16, if elements are in the foreground or near middle distance.

This shot was taken at dawn near Lyme Regis using a 70-200mm zoom at around 100mm. The longer focal length compresses the distances between the layers and the strong, directional light helps emphasise the layers – the early morning mists add bags of atmosphere.
Composition is all about what you choose to include in the frame—and also what you choose to leave out. Often, less is more and compositions that are uncluttered can be the most successful.
5) Break the rules!

Like all rules, the rule of thirds needs to be applied with judgement rather than as a matter of course and there will always be situations where it can be ignored. For example, when shooting a scene where the sky is reflected in water, you might want to place the horizon across the middle of the frame, giving the two elements of the shot – sky and reflection – equal weighting.

If there is no interest in the sky, place the horizon higher in the frame or crop it out altogether. To increase a sense of emptiness and isolation, the horizon can be placed very low in the frame. The beauty of shooting digitally is the ease at which you can review your efforts and experiment to ensure the perfect composition.
6) Find natural frames

A popular compositional 'trick' is to use something to frame the view beyond, such as an archway, doorway, window or the overhanging branches of trees.

Try using frost-covered plants and gateposts to create a 'natural' frame for the main subject of your shot. Use the 'frame' to draw the viewer's eye into the shot for some truly eye-catching results.

Control the amount of sharp focus carefully. Very out-of-focus framing leaves help keep attention on the main subject, slightly soft leaves might look like a mistake.

Use this idea with care as it can often be detrimental to the scene and can suggest to the viewer that the view beyond the natural frame is even more spectacular.

7) Experiment with viewpoints

Finding the right viewpoint is key to successful landscape composition. Rather than shooting everything from head height, experiment with high and low viewpoints.

Higher viewpoints have the effect of opening up the planes in the image and is useful with standard and telephoto lenses. When photographing well-known landmarks, it's tempting to use the established viewpoints, but spend time looking for a fresh view, as it's much more satisfying to capture something original.

While there's nothing wrong with the first picture, it's the 'standard' view of Old Harry Rocks in Dorset. Without having to move very far, however, a less photographed and more dramatic viewpoint has been found.
How to compose a scene

WITH ROSS HODDINOTT

Beautiful scenery and good light are still no guarantee that a photographer will take a great landscape image. While they might both be essential ingredients to great scenic shots, you, the photographer, still need to have the vision and ability to create a strong image. When shooting landscapes, you’ll have ample time to consider, arrange and fine-tune how you frame the scene.

Composition is the art of arranging the elements of a scene in such a way that they are visually pleasing. It is an ability that becomes instinctive the more you take photographs, so don’t worry if this is a skill that doesn’t come to you naturally – just keep practicing and you will improve over time. By using two relatively simple guidelines, based around the rule of thirds and lead-in lines, you will see an immediate improvement in your landscapes.

The rule of thirds requires that you imagine the frame is split into nine equal parts by two horizontal and two vertical lines. It is a technique I use for the majority of my scenes. A horizon that cuts centrally through an image normally weakens a shot, but a landscape composed of one-third sky and two-thirds foreground, or two-thirds sky and one-third foreground, looks far more dynamic.

Another useful ‘rule’ is to use some sort of lead-in line within your composition. A lead-in line uses the natural perspective of receding or converging lines to create foreground interest. The technique works well in tandem with the rule of thirds, so by combining the two wherever possible.

Powerful compositions often have strong lines passing through them, as they help to lead the viewer’s eye through the scene to the point in the distance where the line diminishes – the ‘vanishing point’. All types of subject can be used: a road, path, bridge, walkway, river, ploughed field, crop lines or fence. By using such an object in the foreground, leading into the picture, you can transform an otherwise ordinary looking view. Often a lead-in line that stretches diagonally works best, but don’t overlook positioning your lead-in lines centrally, as this can also create striking results.

I spent an evening on Dartmoor photographing the moors. Though the evening light was warm, the view looked quite ordinary, but I knew that a nearby stone wall would create more interest. A vertical format worked best, with the wall leading from the bottom of the frame to the distant view. I tried taking a few shots looking directly down its length, then changed my position so that the wall led from one corner into the distance. I composed the shot with one-third sky, two-thirds foreground, and, with my camera set to aperture-priority mode, I selected a small aperture of f/22 to ensure back-to-front sharpness thanks to lots of depth-of-field.

DON’T PANIC!

Positioning the horizon

Though it may seem natural to place the horizon in the centre of the image, more often than not, it will produce disappointing results. In this instance, composing the shot to be only one-third sky, as opposed to half, gives greater emphasis to the foreground and creates a better balance overall. However, there isn’t a set rule to follow and you should base your composition on the merits of each scene. For instance, if the sky had been more interesting, such as on a stormy day, I may well have considered giving it more emphasis in the frame.

RIGHT: Some DSLRs allow you to display grid lines in the viewfinder to assist composition. This can normally be selected by accessing one of the camera’s custom setting menus.

ABOVE: I used a Nikon D7000 with a Nikkor 24-85mm zoom, set to f/22, on a Gitzo tripod. I fired the shutter with a remote release. I also used a Lee Filter system using a polarising filter and 0.6ND graduate filters together.
Summary
How to compose the scene

1) STICK TO THE RULES! Placing the horizon along the centre of the frame will normally create a poor composition. Instead, try to follow the rule-of-thirds.

2) USE LINES A lead-in line will draw the viewer's eye through the image and create interest. Almost anything can be used.

3) DIAGONALLY DOES IT! Placing your lead-in lines so that they run diagonally often works better than if they're positioned centrally.

By altering my shooting position by a few steps, I was able to compose the scene so that the wall cut diagonally across the frame. This lead-in line creates an entry point and leads the viewer's eye on a journey through the image.
Using foreground interest

BY ADAM BURTON

Because I’m hooked on wide-angle photography, big foregrounds are a constant feature in my landscape images. When selected carefully and photographed well, a good foreground will bring a landscape shot to life and maximise its impact. Photographers with detailed foregrounds can give the viewer a sense of “being there”, instantly drawing their attention and gaze into the image. I should point out that I don’t go out primarily searching for foregrounds. The most important thing is always the main subject in your image, but for me, the foreground comes in a close second. So whenever I head out to take landscapes, I look for a location that has a lot of potential shooting opportunities. On arrival, I’ll scout around the area, looking for the most appealing subject and the best angle to shoot it from. Once I’ve chosen the area in which I wish to shoot, I begin to search around for foreground interest.

There are no rules as to what qualifies as good foreground interest but, as always, there are a few points to consider. Only you can be the judge of what you want to focus on and, obviously, this is also determined by which objects are close at hand. But it is important to pay careful attention to which objects you include, rather than just shooting the first thing you stumble across. As I favour landscapes, I almost always look for natural elements to make a foreground – rocks, flowers and water being the usual suspects. These know, will fit into the bigger picture that I am composing, whereas a man-made object could look unbalanced.

Once you’ve decided what to include as foreground, consider how to compose your shot to give the strongest possible result. Ideally, the foreground leads the eye into the main subject, but if composed wrongly, can become a distraction. One mistake many photographers make is to always shoot at eye-level, if you are including low-level rocks, and shooting from a standing position, your resulting image will lack impact. Try moving lower and closer to your desired foreground, and your image will spring to life! Having said that, be careful not to move too low and close or you risk unbalancing your image by making the foreground more dominant than your background. For this reason, try and keep your subject matter clean and simple – a fantastic background will be lost behind a cluttered or messy foreground! Finally, it’s important to use a small aperture and focus a third of the way into the scene to provide a good depth-of-field. By following these simple measures, you can greatly improve the composition of your landscape images.

TOP: While your natural instinct may be to extend your tripod and shoot from a standing position, it’s worth trying low viewpoints too.

ABOVE & RIGHT: Using a tripod really helps with landscape photography. I adjusted the height until I was happy with the composition and used a polariser to improve the colours. By reviewing my shots on the LCD monitor, I was able to check the exposure and depth-of-field to ensure I got the best possible result.

NO FOREGROUND INTEREST Without a foreground, the image lacks impact and can look dull and uninteresting. While water can make a more attractive subject, its muddy colour in this shot lacks appeal.

WITH FOREGROUND By including a foreground, the image immediately looks more balanced and eye-catching. However, don’t just settle on the first thing you find. This plant is quite unattractive.

LOW VIEWPOINT Composing from a low viewpoint helps to pick out details in this messy rock. It is simple, uncluttered and provides a satisfactory foreground: but it still lacks something special.
Summary

Foreground interest

1) DO YOUR HOMEWORK
Spend some time searching for the best foreground interest in your chosen area. Don’t just shoot the first thing that you stumble across.

2) AVOID CLUTTER
Try to keep the foreground simple and clutter-free.

3) GET DOWN!
Get low down and close to the foreground to add impact.

4) ENSURE SHARPNESS
Set a small aperture and focus a third of the way in.

5) USE YOUR LCD
Review results on the LCD, revise composition and reshoot.

FINAL IMAGE:
Adding a few leaves to the rock adds interest and impact; and by slightly adjusting my viewpoint, the foreground interest is moved into an off-centre position, which strengthens the composition.
HOYA
ALL NEW HD FILTERS

CIR-PL

HIGHEST RESOLUTION IMAGES EVER
HD CIRC-PL uses a newly developed HD polarising film made from the same ultra fine material used in the latest HD LCD TV screens. Made under the highest manufacturing standards, this film provides excellent transparency, lasting durability and an 85% light transmission, substantially more than the usual 60% offered by other polarising filters. Furthermore, based on Crossed Nichols testing, this HD polarising film produced a 99.99% polarising effect, compared to the standard 99.4% for most polarising films. It is a difference in clarity you must upgrade to see.

Available sizes
52mm  55mm  58mm  62mm  67mm  72mm  77mm  82mm

UV ABSORBING
HD CIRC-PL filter absorbs ultraviolet rays

8-LAYER MULTI-COATING
8-layer anti-reflective HD multi-coating. The difference is clear.

ULTRA THIN FRAME
Compatible with wide-angle lenses, avoids vignetting

HIGH END CONSTRUCTED FRAME
Glass mounted with high pressure press technology

LENS PROTECTION & EASY MAINTENANCE
Water & oil repellent, scratch and stain resistant

MORE LIGHT RESISTANT & DURABLE
HD CIRC-PL film will not change colour & light transmission

Hoya HD Filters also available in UV & Protector in sizes from 52mm to 62mm

Imported in the UK by Intro2020 Ltd
Priors Way, Maidenhead, Berks SL6 2HP
Tel: 01628 674411
sales@intro2020.co.uk
www.intro2020.co.uk
The Basics #2

PERFECT EXPOSURES

DIGITAL SLRs HAVE EXTREMELY ACCURATE, multi-zone metering systems, with a histogram function to help us check accurate exposure, so getting it right has never been easier. However, for more creative control, you need to take things into your own hands.

The basic problem is that as we gaze at a beautiful landscape, our eyes adjust constantly to register detail in the highlights and the shadows. Our pupils open and close according to the level of light and our optic nerve has impressive range and latitude. Our cameras, despite their impressive technical specifications, make exposures within fairly limited parameters – the aperture and shutter speed combination will be chosen for the level of light in the scene. A perfectly-exposed sky results in gloomy shadows; detail in the shadows results in a burned-out sky. We need to help our camera to expose the right part of the scene, or find the right balance. The following expert techniques will help you capture perfect exposures by knowing what types of scenes causes problems and what action you’ll need to take.

1) Get the balance right

This image presents the landscape photographer with the greatest challenge – extreme light levels with a need to capture detail in the bright sky and the shadows. And don’t be fooled by that wet sand in the foreground, it’s reflecting a lot of light from the sky.

Of course, it will be possible to manipulate the image on your computer, but first you must make sure the exposure settings are going to capture the maximum amount of information across the whole image. Overexpose and you will lose cloud detail and the blue sky; underexpose and the shadows on the pier will fill-in and become solid. If your digital SLR doesn’t capture the information, you will have nothing to work with on the computer. There will be an optimum exposure setting but it could be a compromise, so if in doubt, use your camera’s bracketing function to take several images, some underexposed and some overexposed.
2) Getting the right exposure

Mark Bauer was looking for a ‘different’ view of Corfe Castle in Dorset, so he sauntered along to the graveyard in the village. Having found a composition based around one of the crosses, the next problem was sorting out the exposure. Mark explains, step-by-step, how he tackled the challenge:

3) “This is what the camera’s multi-zone meter came up with, without the aid of any filtration. The scene is very contrasty, and the camera has struggled to capture all the tonal information.”

2) “Spot meter readings from the base of the cross and the sky revealed a difference in brightness of about 4½ stops. Setting an exposure for the land, I fitted a 0.9ND grad filter (three stops) and pulled it down below the level of the horizon, to the edge of the darkest shadow area at the bottom of the frame. I used a soft grad, so that it wouldn’t cut into the cross. But there is loss of detail in the brighter parts of the sky so I reduced exposure by two-thirds of a stop and reshoot.”

3) “The result is ‘exposed to the right’ (see over the page) as far as possible without clipping the highlights – the histogram shows there are still dark tones, but also plenty of information in the top section, and crucially, no ‘clipped’ shadows.”

4) “A straight conversion of the Raw file looks dull, the picture lacks contrast. For the final version, I’ve brought the exposure down slightly and added more contrast, especially in the shadows, to recreate the drama of the original scene. I’ve also tweaked the white balance to add warmth and increased saturation too.”

5) “For comparison purposes, I also took a shot underexposed by one stop. This leaves the shadows muddy and lacking in detail, which is very apparent in the crop.”

---

**MID-TONE METERING**

Metering systems in digital SLRs are calibrated to an 18% grey mid-tone. Basing exposure readings on a mid-tone, such as grass, provides a good starting point for accurate exposures.

---

**EXPOSURES**

**Shadows**

These two examples on the right show why it’s not a good idea to underexpose and then try to pull up the shadows in post-processing. The nearest image is around one stop underexposed (to maintain highlight detail) and the shadow curve has been pulled up to match the exposure in the correctly exposed version on the right. As you can see, not only is there ‘posterisation’ in the shadows, rather than smooth tonal transitions, and tons of noise, but also the sensor has recorded significantly less detail.
Exposure for coastal landscapes

Achieving the correct exposure in coastal shots can be a bit trickier than for inland landscapes, as there are several things that can fool the camera’s meter: bright highlights on water or bright white foamy waves can lead to underexposure. On the other hand, if you have chosen a large, dark rock for your foreground, this could cause the camera to overexpose. So you need to keep an eye out for any large areas of particularly bright or dark tones and apply exposure compensation accordingly. It is good practice to check the histogram after each shot and be prepared to re-shoot if necessary.

There can also be a huge range of contrast within any one scene, with bright skies, dark rocks, and bright highlights on water. Neutral Density (ND) gradient filters are essential, and depending on the conditions and the brightness of the sky and sea relative to your foreground, you may need to pull the grad down very low in the frame. This could even be below the horizon, to the top of your foreground. If you don’t, you might end up with a correctly-exposed sky and foreground with a band of over-bright water in the middle of the picture. So when metering the scene to choose the strength and placement of the filter, remember to take readings from the foreground, sky and sea.

**LONG EXPOSURES**

Exposing to capture movement

One of the great things about taking photos by the sea is the opportunities it gives for capturing the movement of waves and adding atmosphere. In low light, with the lens stopped down to extend depth of field, long exposures are a necessity. They may range from several seconds to minutes, depending on lighting conditions. As waves wash around rocks or up and down the shore while the shutter is open, they will record as a romantic, mysterious mist. To capture the drama of waves breaking on the shore, speeds of 1/60sec or slower work well.
4) Histograms: An aid to checking exposure

THE BASICS In basic terms, a histogram is a two-dimensional graph, often resembling a range of mountain peaks, that represents an image’s tonal extent. Whilst, at first glance, histograms might appear quite complex and confusing, they are actually very simple to read. They are an essential aid for digital SLR photographers striving to achieve consistently correct exposures in-camera and are a more accurate method of assessing exposure than looking at images you’ve taken on the LCD monitor. Therefore, if you are not already in the habit of regularly reviewing your images’ histograms, it is time you do so. With the help of this guide, you will soon feel confident assessing histograms.

WHAT IS A HISTOGRAM? A histogram is a visual representation of an image’s tonal range. The horizontal axis indicates the picture’s extent from pure black (0, far left) to pure white (255, far right). The vertical axis shows how many pixels have that particular value. Looking at an image’s histogram, you can tell whether the picture is made up of predominantly light, dark or mid-tones.

Although its appearance is also dictated by the colour and tone of the subject, a histogram with a large number of pixels (or a sharp peak) grouped at either edge is an indication of poor exposure. For example, a histogram with a large number of black pixels (grouped to the left) often signifies underexposure – subject detail will be obscured in the shadow areas. A large number of pixels grouped to the right of the histogram normally indicates an image which is overexposed. The image’s highlights will burn out (or ‘clip’) and this detail is irretrievable. A graph with a narrow peak in the middle and no (or few) black or white pixels indicates an image lacking contrast.

SO WHAT SHOULD A HISTOGRAM LOOK LIKE? This is a tricky one to answer. Despite what some people may say, there is no such thing as the ‘perfect histogram’. It simply tells us how a picture is exposed, allowing photographers to decide whether – and how – to adjust exposure settings. Therefore, a histogram of a light scene will be very different to one with predominantly black tones or one with a mix of both. However, generally speaking, a histogram should show a good spread of tones across the horizontal axis, with the majority of pixels positioned near to the middle (100, mid-point). Normally, it is desirable to avoid peaks to the right-hand side of the graph, as this is usually an indication of ‘burnt out’ (overexposed) highlights, resulting in lost detail.

When assessing a histogram, it is important to consider the brightness of the subject itself. For example, a scene or subject boasting a large percentage of light or dark tones – like snow or a silhouette – will naturally have an effect on the overall look of the resulting graph. Therefore, whilst it is possible to make recommendations, it is impossible to generalise about what is and isn’t a good histogram. What an even spread of pixels throughout the grey scale is often considered desirable, you will also need to use your own knowledge gained through experience.

HOW DO I CHECK A PICTURE’S HISTOGRAM? Most digital SLRs allow you to view the histogram on the LCD monitor during playback. To do this, press the playback button to view the image and then cycle through the additional photo info screens until the histogram is displayed. It’s worth making this your default setting, so that you can quickly access the histogram and assess exposure immediately after taking the picture when required.

If the histogram indicates underexposure, apply positive exposure compensation. If pixels are grouped to the right hand side and the image appears overexposed, dial in negative compensation. Using the histogram is a far more reliable method of assessing exposure than looking at images on the LCD screen, particularly when trying to view images outdoors in bright light when the light reflecting from the LCD can prove deceptive.

---

**PEAKS TO THE LEFT** The histogram is skewed to the left, as the dark background means many of the pixels are in shadow areas, but the image is well exposed.

**PERFECT EXPOSURE** A typical landscape scene gives a so-called ‘perfect histogram’ as it has a good spread of tones and peaks through the mid-tones.

**PEAKS TO THE RIGHT** A well-exposed shot of an overly-light scene gives a histogram skewed to the right, much like that of an overexposed image.

---

**DON’T PANIC!**

Exposure warnings

The majority of DSLRs are designed with a playback function known as the ‘highlights screen’. Whilst histograms provide a graphic illustration of an image’s tonal extent, helping you assess exposure overall, the highlights screen – or highlights alert – is aimed specifically at helping photographers avoid highlights burning out. Whites or very light subjects in direct sunlight are especially prone to this. A histogram with a sharp peak to the far right will normally indicate that an image is suffering from areas of overexposure. However, the highlights alert actually identifies the pixels that exceed the value for pure white (255). Pixels that do so are not given a value, meaning they cannot be processed and are effectively discarded – having no detail or information recorded. When the image is replayed on the camera’s LCD monitor, the pixels falling outside the camera’s dynamic range flash or blink – providing a quick and graphic illustration of where picture detail is ‘burnt out’ and devoid of detail. To rectify this, set negative exposure compensation so that the next image is recorded darker.

A digital camera’s highlights alert is not always switched on by default. Therefore, consult your user’s manual and switch it on when you feel this type of exposure warning would prove useful. Normally this is done via the camera’s Playback Menu.
5) Expose to the right

‘Exposing to the right’ is fast becoming a widely-accepted approach to help maximise image quality – although it only applies if you shoot in Raw. With this technique you effectively push exposure settings as close to overexposure as possible without actually clipping the highlights. The result is a histogram with the majority of pixels grouped to the right of mid point – hence the name ‘expose to the right’. So, when you’re confident you understand exposures well enough, give this technique a try and try pushing the exposure as far to the right of the histogram as you can, without clipping the highlights. The image will probably look a little light once in the Raw converter, but this is easily corrected with the brightness and contrast controls and will give much better results than trying to lighten a darker image.

CCD and CMOS sensors count light in a linear fashion. Most digital SLRs record a 12-bit image capable of recording 4,096 tonal values over six stops. But the tonal values are not spread evenly across the six stops, each stop records half the light of the previous one. So, half of the levels are devoted to the brightest stop (2.048), half of the remainder (1.024 levels) are devoted to the next stop and so on. As a result, the last and darkest of the six stops, only boasts 64 levels. This might seem confusing but, simply, if you do not properly use the right side of the histogram, which represents the majority of tonal values, you are wasting up to half the available encoding levels. So, if you deliberately underexpose to ensure detail is retained in the highlights – a common practice among many digital photographers – you are potentially losing a large percentage of the data that can be captured.

MAIN IMAGE & INSET: Exposure to the right of the histogram will capture maximum detail and minimum noise. Once in the Raw converter the image will look too light and washed out so use the brightness and contrast controls to adjust the image’s appearance.
Aperture-priority is the mode for you!

So what is it that makes the aperture-priority mode more useful than any of the other exposure modes when shooting landscapes. Read on, and all will be revealed.

APERTURE-PRIORITY GETS ITS NAME because it allows you to decide which aperture (f/number) you want to use to take a photograph, while the camera automatically sets a shutter speed, based on light levels, to achieve the correct exposure. In other words, if you wish to prioritise the aperture selection, and it chooses the shutter speed accordingly.

As the lens aperture is the most influential factor over the depth-of-field (the zone of sharp focus) in a photograph, aperture-priority mode is the most practical choice of shooting mode. If you are photographing a subject or situation in which control over depth-of-field is important.

Landscape photography is the best example. Generally, when shooting landscapes, you will achieve a balanced focus from the immediate foreground to infinity, which means you’ll need to set a small aperture, such as f/11. Aperture-priority mode lets you do that easily, so you can actively set the required aperture.

When shooting portraits, the opposite tends to apply – you want shallow depth-of-field, so that your subject is recorded in sharp focus but the background is thrown out of focus. That means making sure you take the picture at a wide aperture such as f/4 or f/2.8, which again is easy when shooting in aperture-priority mode because it’s you, and not the camera who decides which aperture to use.

That said, you can still control which aperture is set using the aperture value dial, but it only requires a slightly different (and longer) way of working. In shutter-priority (S or Tv) mode, for example, all you need to do is change the shutter speed until the camera sets the aperture you want. Similarly, in program mode, you can use the program shift function to change the aperture and shutter combination that the camera has set until you get the right aperture.

Where aperture-priority triumphs over these alternative modes is that once you’ve set a particular aperture the camera won’t change it, even if light levels change. Instead, the shutter speed adjusts to maintain the correct exposure. This wouldn’t be the case if you set the camera to shutter-priority mode – if light levels change your DSLR automatically adjusts the aperture to maintain correct exposure, giving the shutter speed priority, so your control over the depth-of-field is diminished. Similarly, in program mode, the camera would change the aperture/shutter speed combination in response to changing light.

Aperture-priority is also a handy mode to set for general use, when you’re just wandering around, shooting anything that takes your fancy, whether it’s architecture, details, abstracts or candids. Depth-of-field requirements will vary depending on the shot – one minute you need lots of it, the next, as little as possible – but this can be quickly altered with the flick of the camera’s input dial, and the viewfinder display will keep you fully informed of exactly which aperture (and corresponding shutter speed) you’re using.

Setting aperture-priority on your DSLR

Choosing aperture-priority mode is simple – all you need to do is turn your exposure dial (or in some cases push the exposure mode button) and select A or Av. Your DSLR will then be set to aperture-priority mode and all you need to do is rotate the small adjustment dial (found either on the handgrip or on the top-right corner of the rear of your camera) to change your aperture. If you lightly depress the shutter button to activate the exposure system, you can keep a check on the shutter speed the camera has selected.
APERTURE INCREMENTS

Most cameras allow you to change the aperture in 1/2-stop increments. Check the custom function menu on your DSLR – many models allow you to also set it to 1/3-stop increments if you so wish.

Shot at f/22

Aperture-priority allows landscape photographers to control how much of the scene is sharply in focus.
**EXPERT TUTORIAL**

**Shutter speeds & landscapes**

WITH ROSS ARMSTRONG  Landscape photographers understandably give priority to apertures, but in some situations, shutter speed is just as important, as it can be used to capture the effect of movement within a scene. Because you want to maintain sharpness in landscape images by maximising depth-of-field, you can really make shutter speeds work for you as the smaller apertures you’ll require also mean slower shutter speeds. This is easily done by setting your camera to shutter-priority (Tv or S) on the mode dial. This ensures you get the right exposure as you set the shutter speed for the desired length of time, while your DSLR adjusts the aperture accordingly. So why choose the shutter speed rather than the aperture? Well, setting the slower speed means anything moving when you fire the shutter, such as flowing water or foliage blowing in the wind, is captured as a soft blur, while anything static, like a fence or rock, remains sharp and in focus. The effect of setting a long exposure is to give images extra depth and dimension whilst illustrating a real sense of movement. The result is usually closer to how you remember the scene, rather than a lifeless image of grass with every blade in focus.

But remember, even digital SLRs can be fooled. Be careful not to overexpose an image when shooting, for example, a field of golden sweeping grass in the evening sun. As you lower the shutter speed, the camera’s chosen aperture will eventually flush, indicating that the image will be overexposed. You can, of course, check the image and the histogram on the LCD monitor for blown-out highlights.

For even slower shutter speeds and the chance to lift your landscape photography to another level, use filters. A polariser will cut out reflections and darken blue skies to give clouds that ‘wow’ factor, as well as reduce the amount of light reaching your sensor by two stops at the same time. You can further enhance movement and blur by using a Neutral Density filter, which is a neutral grey filter that doesn’t affect colour balance but has the effect of reducing the amount of light passing through it, allowing you to select slower shutter speeds as a result.

For optimum results shoot at dawn and dusk and always use a tripod. Shoot on darker, cloudy days, and let nature work for you – less light means you’ll get slower shutter speeds. On windy days, hang your camera bag from the tripod to keep your outfit stable. A helpful hint is to use a remote release/self-timer and mirror lock-up to avoid contact with the camera during the exposure to gain the maximum effect. Wait for the wind, open the shutter and whatever happens, don’t get blown away!

**ABOVE, POLARISER AND ND GRAD:** "I used a polariser combined with an ND grad filter to hold back the bright sky and ensure a well balanced, long exposure. Shooting in Raw, I used the self-timer and an exposure of 3.6 seconds."

**SHUTTER SPEED COMPARISON:** "For this series, the lens (10-22mm set to 13mm) was focused on the long Marram grass in the foreground. The only thing I changed was the shutter speeds in a sequence from 1/500sec to 1.6sec. Note how the movement of the grass in the breeze becomes increasingly blurry as the shutter speed is slowed. My favourite image from the sequence is the longest exposure, which captures the movement in the Marram grass exactly like I remember it, in the low, winter sunshine.”
Dunstanburgh Castle, Northumberland. "The movement in the foreground really adds to the impact of the image. I used the histogram and the image on the review screen to check the exposure and any blown-out highlights."
Combining Raw files

WITH LUKE MARSH Setting your DSLR to shoot in Raw means you're able to recover hidden detail from areas of the scene that are overexposed, such as bright sky. Photoshop expert Luke Marsh shows how to use the Photoshop Elements Raw converter to create two different images at different exposure levels exposures from the same Raw file and then recombine them for the perfect result. Techniques used in this easy-to-follow step-by-step tutorial include exposure adjustment, layer creation and editing, level adjustment, sharpening control using the High Pass filter, opacity effects and colour adjustment. This technique is especially satisfying as you are only working with image data captured in the original single exposure. Elements 4.0 was used here, but more recent versions are suitable too.

1 If you’ve never used the Elements Raw converter before, the first thing you’ll notice on opening the file is the image opens in the Raw control window (above). For the first step, I simply click Open, leaving the settings as they are, then go File>Save As and create a Photoshop file (.psd) as we are going to be working with layers.

2 I reopen the original Raw file, and again the Raw control window appears with the image. This time, I use the Exposure control (circled) and move the slider left to underexpose the image, pulling back the detail from the sky area hidden on the original image. Happy with the results, I click Open to take the image into Elements.

3 I now have two files open. One contains the original exposure and the other is the new underexposed image. With the underexposed file active, I go Select>All then Edit>Copy placing the image into the pastedboard memory. Now I can close this file and use Edit>Paste to place this image into a new layer on the original file.

4 With the two exposures in place I want to combine the correctly-exposed foreground with the newly-exposed sky. With the sky layer active and using the Rectangular Marquee I select a large area of foreground, just short of the horizon, and use Edit>Delete to remove the area noting the effect in the layer palette preview (inside).

5 Now it’s time to tidy up the horizon, so with the Eraser tool set to a medium-sized, soft-edged brush at an Opacity of 55%, I gradually erase areas of the newly-exposed layer, revealing the original horizon exposure. The slight feathering effect between the two layers creates a misty effect which further enhances the image’s mood.

6 The initial layer work is complete, so to save my work so far, I go Layer>Flatten Image then File>Save As to create a new file. With both layers merged, it’s time for some overall enhancement, so I go Enhance>Adjust Lighting>Levels to lighten up the image and improve the definition. I click OK to apply the changes.
The **High Pass** filter is a far more forgiving way to enhance detail than sharpening. To use it, I first go to **Layer> Duplicate Layer** to preserve the original image. Then I go to **Filter> Other> High Pass**, adjusting the **Radius** to around 20 pixels before clicking **OK**. I change the **Blend Mode** in the layer palette to **Soft Light**.

Use **Layer> Flatten Image** again, saving a copy if required. Now, using the **Burn** tool (inset right) with a large soft-edged brush and the **Opacity** at approximately 25%, I darken the exposure of specific areas, which helps to improve the depth of the image. I focus on the edges of the frame and build the effect up gradually.

The image is predominately blue in hue and I'd quite like to inject a different tone to the sky area. Using the **Rectangular Marquee** tool, I select the area above the horizon and **Select> Feather**, entering an amount of 50 pixels to soften the selection, then I go **Edit> Copy** then **Edit> Paste**, placing the selection into a new layer.

Change the **Blend Mode** of the new layer to **Soft Light**, and then go to **Enhance> Adjust Colour> Adjust Hue Saturation**. In the window, I start by clicking the **Colorize** box and immediately see the effect in the preview. Finally, I adjust the **Hue** and **Saturation** sliders until I am happy with the colour, and click **OK**.
Now you can have a professionally designed website for just £35 p.a.

Clikpic is an easy-to-use service for photographers who want a website without the cost and hassle of setting one up. With minimal technical expertise required, you can use our online admin system and a wide choice of template designs to create and edit your own website quickly, easily and very cost-effectively.

- Update or change your site whenever you want and as often as you like.
- Link up to PayPal or Google Checkout to sell your prints online - you can even have a shopping basket facility within your website.
- Opt to have your own domain name for an extra £6 p.a. (or if you already have one, link it to your Clikpic site at no extra cost).
- Have as many pages as you like, in a variety of formats.
- Dozens of style features and options to customise your site and give it your own feel and look.

Many more features

We are continually adding features to the system, usually at no extra cost. Here are some of the additional things you can do with your website, all within the £35 price band. Many more features are available and there are many more to come!

- Add a slideshow on your homepage.
- Add a guest book.
- Receive enquiries through the contact form.
- Create a calendar, blog or an events diary.
- Add your own logo.
- Change design styles whenever you want.
- Use the free stats service provided.
- Image watermarking facility.
- Create links pages.

Visit www.clikpic.com for a FREE 7 day trial
Let's imagine you've just focused on an object that is five metres away. How sharp will something be at six metres? Or even five-and-a-half metres? The answer is governed by depth-of-field—the distance either side of the point of focus that is deemed to be acceptably in focus. As long as you control the aperture that you are shooting at, then you are in control of depth-of-field, and you can use it creatively. There will be occasions when you don't want much of it at all, and you'll get that effect by shooting with a large aperture like 1/4. However, for most of the time that you're shooting landscapes you'll want to maximise depth-of-field to get as much of a scene in focus as possible.

Foreground detail is important and has to be in focus, but so does the rest of the scene. This means using small apertures to get good sharpness either side of the focus point. But just consider this last phrase for a moment, and then think about where you might focus when shooting a landscape. Many novice landscape photographers are happy focusing at infinity when shooting a landscape, but don't forget that depth-of-field extends either side of the point of focus. In fact the area of depth-of-field extends one-third in front of the focused point and two-thirds behind, in other words, you get more depth-of-field behind the subject than in front of it. Obviously there is no benefit to having acceptable sharpness extending beyond infinity, but what you can do is pull the point of focus back towards you, so it's the end of the depth-of-field zone that is at infinity instead. This way you'll get more of the scene sharp. This technique is called hyperfocal focusing, and has been used by professional landscape photographers for decades. The optimum point of focus for any particular scene relies on the choice of aperture setting and the focal length of the lens you use—and changes for full-frame and cropped sensor DSLRs! There are calculators and pocket reference tables you can stash in your camera bag, or you can use a dependable rule-of-thumb that suggests you aim a third of the way into the picture with your lens set to a small aperture. We'll be covering both focusing techniques, as well as providing you with other expert advice to ensure you maximise image sharpness. This includes revealing why using the smallest aperture won't necessarily produce the sharpest results, even though it gives the most depth-of-field!
Focusing with the hyperfocal distance

Landscape specialist Lee Frost explains how to use the hyperfocal focusing distance and aperture-priority for super-sharp scenarios.

ONE OF THE FUNDAMENTALS of successful landscape photography is being able to control and assess depth-of-field to ensure that the image is sharp from front-to-back.

Aperture-priority mode helps you to achieve this, not only by forcing you to think about which aperture to set, but also by making sure that once it is set, that aperture won’t change if light levels fluctuate or you put filters on the lens. If the exposure has to be adjusted when shooting in aperture-priority mode, the camera does it by changing the shutter speed, so the aperture remains constant. This is vitally important because achieving extensive depth-of-field is not just about aperture selection, but also focusing distance, and a careful balancing act between the two is required to ensure the best possible results. You could take every picture at 1/22 with the lens set to infinity and most wide-angle shots would be sharp from front to back. Unfortunately, this simple approach won’t always work – so you’re not going to get the best results. Wide-angles and zooms tend to give their worst optical performance when at minimum aperture and their best around f/11, so ideally you should shoot as close to f/11 as you can to achieve optimum optical quality, and focus the lens at a distance that maximises depth-of-field at that aperture.

Over the page, Helen Dixon provides a simple focusing method along these lines that yields excellent results. My favourite technique is based around something known as hyperfocal focusing, which involves focusing on a point known as the hyperfocal distance, where depth-of-field is maximised for the aperture in use. Lenses used to feature a hyperfocal distance scale on the barrel but virtually none do today. There is an equation for calculating hyperfocal distance for any lens and aperture, so in true Blue Peter fashion, I did just that and created a hyperfocal distance chart, which you can copy and refer to when you’re on location. The distances in feet (ft) represent the hyperfocal distances for each focal length and aperture. If you focus your lens on that distance and set the corresponding aperture, depth-of-field will extend from half the hyperfocal distance to infinity. So, if you’re using a APS-C sized sensor, shooting at 24mm and f/11, focus on a point 9ft away and depth-of-field will extend from 4.5ft (half the hyperfocal distance) to infinity – which is more than enough depth-of-field in most situations.

Aperture-priority and multi-zone metering

Before finally ‘going digital’ back in the spring of 2008, I’d spent 20 years shooting with film cameras that had no internal metering, so I used a handheld spot meter to determine correct exposure – which then had to be manually set on the camera. Thankfully, those days are long gone. Digital SLRs have fantastic integral metering systems that are capable of producing perfectly exposed images in all but the most demanding situations, so I can’t see the point in making my life more complicated than it needs to be. These days my digital SLR is set to aperture-priority mode and multi-zone metering and generally stays that way. Combined with the feedback provided by the camera’s preview image and the image histogram, I’ve got all I need to ensure I get perfect exposures in any shooting situation. The same applies to you.

<table>
<thead>
<tr>
<th>Hyperfocal Distance: APS-C Sensors</th>
<th>Focal length</th>
<th>12mm</th>
<th>15mm</th>
<th>17mm</th>
<th>20mm</th>
<th>24mm</th>
<th>28mm</th>
<th>35mm</th>
<th>50mm</th>
<th>70mm</th>
<th>100mm</th>
<th>135mm</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aperture f/8</td>
<td>3.2ft</td>
<td>3.1ft</td>
<td>3.0ft</td>
<td>2.9ft</td>
<td>2.8ft</td>
<td>2.7ft</td>
<td>2.6ft</td>
<td>2.5ft</td>
<td>2.4ft</td>
<td>2.3ft</td>
<td>2.2ft</td>
<td>2.1ft</td>
</tr>
<tr>
<td>f/11</td>
<td>2.3ft</td>
<td>2.2ft</td>
<td>2.1ft</td>
<td>2.0ft</td>
<td>1.9ft</td>
<td>1.8ft</td>
<td>1.7ft</td>
<td>1.6ft</td>
<td>1.5ft</td>
<td>1.4ft</td>
<td>1.3ft</td>
<td>1.2ft</td>
</tr>
<tr>
<td>f/16</td>
<td>1.9ft</td>
<td>1.8ft</td>
<td>1.7ft</td>
<td>1.6ft</td>
<td>1.5ft</td>
<td>1.4ft</td>
<td>1.3ft</td>
<td>1.2ft</td>
<td>1.1ft</td>
<td>1.0ft</td>
<td>0.9ft</td>
<td>0.8ft</td>
</tr>
<tr>
<td>f/22</td>
<td>1.2ft</td>
<td>1.1ft</td>
<td>1.0ft</td>
<td>0.9ft</td>
<td>0.8ft</td>
<td>0.7ft</td>
<td>0.6ft</td>
<td>0.5ft</td>
<td>0.4ft</td>
<td>0.3ft</td>
<td>0.2ft</td>
<td>0.1ft</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Hyperfocal Distance: Full-Framesensors</th>
<th>Focal length</th>
<th>16mm</th>
<th>20mm</th>
<th>24mm</th>
<th>28mm</th>
<th>35mm</th>
<th>50mm</th>
<th>70mm</th>
<th>100mm</th>
<th>135mm</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aperture f/8</td>
<td>3.8ft</td>
<td>3.6ft</td>
<td>3.4ft</td>
<td>3.2ft</td>
<td>3.0ft</td>
<td>2.8ft</td>
<td>2.6ft</td>
<td>2.4ft</td>
<td>2.2ft</td>
<td>2.0ft</td>
</tr>
<tr>
<td>f/11</td>
<td>2.6ft</td>
<td>2.5ft</td>
<td>2.4ft</td>
<td>2.3ft</td>
<td>2.2ft</td>
<td>2.1ft</td>
<td>2.0ft</td>
<td>1.9ft</td>
<td>1.8ft</td>
<td>1.7ft</td>
</tr>
<tr>
<td>f/16</td>
<td>1.9ft</td>
<td>1.8ft</td>
<td>1.7ft</td>
<td>1.6ft</td>
<td>1.5ft</td>
<td>1.4ft</td>
<td>1.3ft</td>
<td>1.2ft</td>
<td>1.1ft</td>
<td>1.0ft</td>
</tr>
<tr>
<td>f/22</td>
<td>0.4ft</td>
<td>0.3ft</td>
<td>0.2ft</td>
<td>0.1ft</td>
<td>0.1ft</td>
<td>0.0ft</td>
<td>0.0ft</td>
<td>0.0ft</td>
<td>0.0ft</td>
<td>0.0ft</td>
</tr>
</tbody>
</table>
ALWAYS USE A TRIPOD

If you want to shoot great landscapes, in good light, without compromising image quality, mount your camera on a tripod so you don’t have to worry about slow shutter speeds causing camera shake.

FINAL IMAGE: F/11

If you’re an absolute beginner, start off by shooting at F/11 if you can, to optimise image quality, and only use a smaller aperture if you need to get more depth-of-field. How easy is that!
Focus a third of the way into the scene for sharp results!

WITH HELEN DIXON The normal practice for beginners shooting landscapes is to place their DSLR on a tripod, focus on infinity and set a very small aperture to give enough depth-of-field to keep most or all of the scene in focus. It's a tried and tested method that works well, but can be improved upon by fine-tuning focusing technique and the choice of aperture.

Looking at focusing first, when you focus on 'infinity', i.e. on the distance, the depth-of-field will extend a third of the way in front of the focusing point and two-thirds behind. So while part of the foreground is sharp, the area closest to you may well be out of focus. Also, you'll have wasted two-thirds of the available depth-of-field, which stretches beyond infinity. Instead, by focusing part of the way into the frame, you can maximise depth-of-field so that it covers the foreground and the distance.

The optimum distance at which you should focus is termed the hyperfocal distance and there are various elaborate ways of calculating it. The simplest method for focusing by eye (and one that works 99% of the time) is to focus one third of the way into the scene. By doing this, and setting a small aperture, you're ensuring that the depth-of-field in front of the focusing point covers most, if not all, of the foreground, while the area behind is kept sharp by the other two-thirds of the depth-of-field. If you want to be as precise with your focusing as possible, use the table on the previous page.

With the focusing technique taken care of, we'll move onto your choice of aperture. While setting the smallest aperture (e.g. f/22) gives the most depth-of-field, it doesn't necessarily give the sharpest results. That's due to two main reasons: most lenses are optically designed to give the sharpest results at apertures of around f/8 to f/11, while at smaller apertures the effects of diffraction soften the image, thus negating any benefits provided by depth-of-field. The optimum aperture to use varies from lens to lens so the only way to discover for yourself is through trial and error. Shooting at different apertures and comparing the sharpness on your LCD monitor or ideally at home on your computer, where you can magnify images for close scrutiny.

For the sharpest possible results, using the hyperfocal distance method explained by Lee Frost on the previous pages is best. Of course, you must make sure that you set your camera up on a tripod, to reduce the risk of camera shake. But this process can be time-consuming and for most people, my technique is ideal. The images shown here were shot using a fairly dominant foreground to emphasise the effect of changing the focusing distance. The aperture was f/13 for all three images.
SHARP SCENE
Focusing a third of the way into the scene and using f/13 ensured maximum sharpness.

Summary
How to maximise image sharpness
- Set your DSLR up on a tripod to minimise shake
- Focus one-third of the way into the scene
- Choose a small aperture like f/13-f/16 to get the best possible optical quality
- Check depth-of-field using Live View
- Check image sharpness by zooming in to the image on your LCD monitor
The effects of diffraction

The more you close the aperture down, the greater the depth-of-field, so the usual advice given for sharp results is to use very small apertures, such as f/16 and f/22. However, stopping down too far can actually be detrimental to image sharpness and this is due to an optical effect called ‘diffraction’.

The simple explanation of diffraction is that when light passes through the aperture of a lens, the edges of the hole disperse the light waves. As the aperture is stopped down, the amount of diffracted light becomes a larger percentage of the total amount of light being recorded and the image becomes noticeably less sharp, meaning less detail is resolved on the image.

APS-C and full-frame sensors are affected slightly differently, and certain lenses will be more prone to diffraction than others. But in general, with an APS-C-sized sensor, you’ll start to notice the effects of diffraction if you stop down beyond f/11 and with a full-frame camera, once you go beyond f/16.

Of course, you can use apertures smaller than that and decide between overall sharpness and depth-of-field relevant to the amount of fine detail you think it’s necessary to record in any one particular image. That said, it’s worth remembering that a 17mm lens on an APS-C-sized sensor will give you a depth-of-field from 1/4 foot to infinity when set to the hyperfocal distance at f/11 – enough for most situations.

To illustrate the effects of diffraction at different apertures, we’ve shown a series of pictures at f/8, f/11, f/16 and f/22 – focusing and overall exposure remained constant – the only change was the lens aperture. The pictures were all processed using the same software and settings when post-processing.

More sharpening than usual has been used to make the effects more obvious.

**EFFECTS OF DIFFRACTION:** This image shows the full frame. The box shows the cropped section used to illustrate the effect of diffraction. It was taken with a Canon EOS 20D and 17-40mm lens.

**COMPARISON RESULTS:** The results may not be so obvious in magazine reproduction, but are very clear in large prints. At f/8, everything looks pretty sharp, with good detail in the background foliage. Things still look good at f/11, but once stopped down further than this, instead of becoming sharper as depth-of-field increases, the image becomes noticeably less sharp and detailed. This is crucial in landscape photography, especially when making large prints, and it is this “mushy” looking foliage that spoils digital landscapes for many photographers.
Digital sharpening

Even after shooting, the quest for sharpness, or, more accurately, its control, can continue. All digital images benefit from sharpening and it's best done in post-processing for more control. If you are using Photoshop's Unsharp Mask (USM) filter, a smallish pixel radius of 0.6 will usually give the best results. Increase sliders gradually, monitoring the effect in the preview window as you do so.
Shake-free landscapes

Landscape photographer Ross Hoddinott shows how using a tripod and mirror lock-up is well worth the effort.

There's always a risk of camera shake spoiling landscape shots. Setting a small aperture for lots of depth-of-field, along with a low ISO rating for the best possible image quality, means that shutter speeds are always likely to be slow, even in bright conditions. This is why a tripod is seen as essential for this type of photography, but even then, there is always the risk of shake. Let's see how using a remote release or a self-timer can help you to reduce the risk of blur, and how seeking out your camera's mirror lock-up facility can lead to sharper results too.

Essential kit for shake-free results

A sturdy tripod is an essential accessory and the right one will last you for years. But just how do you pick the right one? It's all about compromise: you want something solid, but not so heavy that you always leave it at home. Turn to page 114 for a selection of tripods at various price points that are all ideal for landscape photography. You should also look at investing in a remote release, an inexpensive accessory that offers an alternative to using the self-timer for contact-free firing of the shutter.

Handheld

At 1/15sec at f/2.2, it's not surprising that handholding the camera resulted in a lot of shake that has blurred the image. I need a small aperture though, to maintain front-to-back sharpness. I could raise the ISO rating to compensate, but I prefer to use a tripod instead to preserve picture quality.

Tripod

Putting the camera on a tripod has made a huge difference to image sharpness, but zooming on fine detail reveals that there is still some blur present. This is probably because I'm wobbling the camera very slightly as I press the shutter release. I need a way of tripping the shutter without touching it.

Tripod & self-timer

An easy way to avoid moving your camera while it's on a tripod is to fire it with the built-in self-timer. This way you can touch the camera, but any movement will have subsided by the time the shutter fires. Many DSLRs give you the option of setting the self-timer delays at two or ten seconds.

Tripod & remote

Better still is a remote release. This will also let you trip the shutter without wobbling the camera but, because there is no delay involved, you can be more precise with your timing. This can be very useful if you have rapidly changing lighting conditions, as I did when shooting this location.
Mirror lock-up. Even with a self-timer or remote release, some shake can still cause blur, thanks to the camera's mirror swinging violently as the shutter opens. In my final picture, I've used my D700's mirror lock-up function to move the mirror out of the way before firing the shutter with the remote. It's the sharpest result by far.

**Image Stabilisation**

Many cameras (and lenses) now feature a shake reduction system of one type or another, and this can be a real bonus if hand-holding. However, this should be switched off when using a tripod.
The Basics #4

LIGHTING

LANDSCAPE LIGHTING IS always changing. Sometimes it changes slowly, as with the seasons. Throughout the day it changes more quickly, but at dawn and dusk it’s changing quite fast. Weather can transform the light on a scene in a matter of seconds and by choosing between shooting into or with the light you can instantly make a massive difference. Over the next few pages we help you to predict the light, handle and control it effectively and understand how to make photography’s most critical element work for you, not against you.

1) Light direction

The direction of light has a dramatic influence on how the landscape will appear behind the lens. Front lighting, with shadows falling behind the subject away from the camera, can make a scene look flat and uninteresting – although with the sun low over the horizon, it can provide good colour saturation. With low front lighting and wide-angle lenses, an added problem is that you have to be careful to avoid getting your own shadow in the picture.

Side-lighting is a favourite with many landscape photographers, because it reveals texture and shadows falling across the scene that highlight shape and form, therefore adding more depth to a scene.

Backlighting can be very dramatic, with shadows racing towards the camera and the emphasis is very much on shape and form, with objects being recorded as silhouettes. Depending on the conditions, these objects might be placed in front of a boldly coloured background. Trees, backlit by the rising or setting sun, can look very effective.
2) Weather and light
In theory, there's no such thing as good or bad weather in landscape photography – good images can be produced in any conditions. Of course, certain conditions will produce more dramatic shots and the trick is learning how to recognise and anticipate them.

If you're planning a sunset or sunrise shoot, don't cancel it if there's cloud cover. If there's a break on the horizon, there's a possibility that the clouds will be lit from below when the sun is very low, giving a very dramatic sky.

Sunshine and showers can be stunning in the moments when the rain stops and the sun breaks through, with foreground objects spot-lit against a dark, brooding sky. These moments are fleeting, however, and don't last for long, so you need to have your camera prepared beforehand.

If the weather is bad – grey, overcast and raining – there are still shots to be made. In these conditions head for woodland: the diffused, less contrasty lighting suits this type of location.

Surprisingly, using a polariser can really enhance a picture, by cutting out the reflections and glare from wet foliage as well as saturating the colours.

3) Capture the right mood for the scene
Shoot in lighting conditions that will enhance the natural mood of your subject. For example, some scenes are naturally more tranquil and will look best in the corresponding soft light of dawn and with pastel colours. Others have a naturally brooding atmosphere and demand dramatic, theatrical and directional lighting. And the best light might be months away.

Look at the pictures of the Norman Chapel at St Alphelm's Head in Dorset on the right. The chapel has a brooding presence, which, as can be seen from these pictures, is best suited to low light and heavy skies.

4) Enhance low light with reflections
Pre-dawn and twilight are very moody times for landscape photography, but the land itself can be almost completely in shadow, with very little detail.

Near water you can include reflections as a foreground, which will help to balance the shot and throw more drama and impact into your image. The more still the conditions the more mirror-like a surface. With the sun yet to appear above the horizon, the wonderful colours in the sky can be used to add colour and impact into the foreground. The slight breeze of this scene in Mudeford (right) had to drop before the water was still enough to provide this perfectly clear reflection.
5) Backlight for impact!
There's a fancy name for this. It's called contre-jour photography from the French for 'against the daylight'. If you want to avoid the funny looks, stick with 'backlighting'. Objects are turned to silhouettes, shadows, rays and reflections explode into the lens and create that powerful feeling of being there. Expose carefully, mind, it's tricky.
6) **Seasonal light**

In winter the landscape is more exposed and the low sun casts long shadows throughout the day. The air has less dust, giving the light clarity. Clear, cold nights lead to frosty mornings with pastel skies.

The light in summer is often less favourable for landscape photography, with the high sun creating harsh light for a large part of the day, with more dust and heat haze meaning the light is generally less clear.

In early spring and late autumn, the light and clarity are better than in summer and it’s possible to shoot for most of the day. The weather is changeable, which can create moody and dramatic photo opportunities. In late spring and early autumn, after a cool night, mist can often form at dawn as the land begins to warm up.

**BE READY TO GO:**
A covering of snow might only last a few hours, even at high altitude. It’s a good idea to have a bag packed and ready to go when the weather forecast mentions the white stuff. Time saved not having to hunt for your filters or a charged battery might make the difference between a shot like this (below) and a later one with slushy footprints all over it.

**KIT WATCH!**

Keep comparisons in camera

Digital SLRs make seasonal comparisons like the set of four, above, much easier. When you revisit a location every three months, carry the previous images on the memory card to help you to recreate the exact distance and crop.
Lighting ‘on the edge’

A lot of the action in landscape photography happens ‘on the edge’ – the transition between one state and another. In terms of light, this means the transition from day to night and night to day; the change from one season to another; the transition from calm to stormy weather and so on. Capturing these moments can result in powerful pictures, especially when combined with other themes, such as the boundary between land and water, wilderness and civilisation etc.

Several ‘edge’ themes come together here: the interval between one storm passing and another arriving, the edge of land and water and the transition between night and day.

In the first shot (left), the storm is still clearing as the sun is setting and in the second (above) there was a fantastic afterglow before the next storm rolled in.


**EXPERT TUTORIAL**

**Light and the time of day**

TIME OF DAY is one of the key factors that influences the mood of a landscape image. The low sun in the mornings and evenings can add warmth and colour to a scene, but it’s equally important to know how different seasons and certain weather conditions can provide particular types of lighting.

Remember that some locations work better at certain times of the year – the position of sunrise and sunset varies throughout the year, so research your location first.

Arrive early and learn to pre-visualise and spot the potential in a scene. This is a key ingredient to capturing great landscape images, as it gives you time to find the best composition before the most photogenic light of the day arrives, so you can prepare without having to rush.

This location at Botallack in Cornwall looks best in the evening light, especially in August when the high sun during the day can make it look a bit boring. In the sequence shown here, I arrived at late afternoon, anticipating attractive evening light. I found my spot and took a frame at 5pm to use as a comparison shot for my time of day sequence. As you can see, the light is harsh and the scene appears ‘flat’ and colourless.

At 6pm, it’s improved a little – a break in the cloud meant that the blue sky was reflected in the sea, adding to the colour intensity. I had to wait over 2½ hours for the perfect light – the sun broke through the clouds, bathing my view in a beautiful warm light for all of ten minutes, before the clouds merged again.

The sun had set but I hadn’t finished yet, as the twilight was still to come. At this time, there is no directional light and the scene now takes on a new dimension – a more surreal, calming quality. This is all down to the light, or should I say lack of light. Shooting the scene at this time of day means a longer exposure, and this creates a calming effect. The sea appears smooth, the colours are cooler and more subtle and there is a kind of harmony between the two.

Successful landscape photography is as much a state of mind as a technical skill. Patience and dedication are as important as the right camera, lenses and tripod. It felt good knowing that it was worth the wait, and it really does prove that although patience is a virtue, you should always give yourself plenty of time to find a good viewpoint. Waiting is the name of the game, as light can be very fickle and difficult to predict – you can never know how it will turn out.

---

The second in the series shows a difference, the scene has more colour and because it was taken at a later time, the light is already starting to get better.

This was the last shot of the day and shows how the twilight can make even the roughest of seas seem calm. The longer the exposure, the calmer it looks.
“GOLDEN LIGHT”

“This is the image that I had been waiting for. The light transformation is why I do so much photography at these times. To watch it unfold is truly breathtaking.”

Summary

The right light!

1) PLAN AHEAD: Check out the weather forecast and if you are visiting the coast, check the tide times.
2) PREPARATION: Make sure that your gear is ready: batteries charged, memory card in the camera and spares packed. Check the ISO rating. White Balance and that the lens is clean.
3) ARRIVE EARLY: Give yourself plenty of time. The last thing you want is to be rushing around looking for a suitable composition while the best light fades!
4) TEST SHOTS: Take some test shots. Are you happy? Is the exposure OK? Check the image histogram.
5) COMPOSITION: Are you satisfied with your initial composition? Reassess and relocate if necessary.
Get up early for ‘magic hour’ lighting

WITH HELEN DIXON

Waking a couple of hours before sunrise, which is often in the middle of the night, is not the most popular idea of fun. But if you’re prepared to make the effort, you will almost always reap the rewards. To do it right, planning is essential. Check the weather forecast and the sunrise times on the internet. Remember to check the tide times if you are travelling to the sea – a low tide is usually the best time to visit. If the light fails to materialise, you can always do beach close-ups.

I try to be on location at least half an hour before the sun rises – if not earlier – because it’s often before the sun appears that the real magic happens. This also gives me time to set up the camera and to find the best viewpoint. Don’t just look for clear days; it’s better to have clouds around as this creates wonderful colours in the sky as the cloud reflects the light of the sun. Try to pre-visit and research your location before the day of the shoot. I use Ordnance Survey maps for detailed information on rights of way and parking. Look for appealing places where there will be opportunities for shots that include foreground interest.

Mist primarily develops during a cold night and it will only linger for a short time during the morning or until the heat of the sun burns it away. Something to bear in mind is that during misty conditions, your camera’s metering system will often underexpose the scene, resulting in a dull, lifeless landscape. To compensate for this, alter the exposure by +1/3 or +1 stop as this helps bring the scene to life. Check the histogram on the camera’s LCD monitor to make sure you haven’t overexposed the scene.

The use of Neutral Density graduate filters is pretty much standard in landscape photography. They help to control the brightest part of the scene, which is usually the sky. Early in the day, there is a noticeable difference between the light in the sky and the light on the land.

Be aware of lens flare if the sun is included in the frame. To help eliminate this make sure that your filters and lens optics are spotlessly clean. I rarely use a warm-up filter. A disadvantage with these filters is that it will make any green foliage appear a yellow-brown colour. Instead I set my camera’s White Balance to cloudy or shade to help warm the scene. Try to avoid using the Auto White Balance (AWB) setting as you are sure to cool down the light, unless of course this is the effect you want.

There are a number of reasons why I personally prefer dawn light over sunset. I like to capture atmosphere in my shots if I can, and early morning is the best time to do this as you are more likely to have a misty or frosty start to the day. The light is often diffused and softer at this time, but it’s more of a challenge to include the sun in the shot during the morning than in the evening; because at sunset the pollution levels rise throughout the day, which helps to diffuse the brightness slightly. Another great advantage of early morning is that it’s so peaceful; I rarely see another soul. The world belongs to me – it’s so satisfying to watch the day unfold and witness the magical light of dawn.

Once the sun has risen and become too strong to photograph, turn away to the side or even put your back to the sun, but be careful not to cast a shadow in the foreground.

It’s now time to start using the warm light illuminating the land. Light is never static but continually changes – it’s the main ingredient that allows us to create something beautiful.

KITWATCH!

Helen’s magic hour kit

“Consider what equipment you will need. An absolute necessity is a good sturdy tripod as at this time of the day you’re working with long exposures. I use a Manfrotto MF4 carbon-fibre with 325RC2 head – it’s a lightweight but stable support and I can hang my bag from the centre post for extra stability on really windy days.

I always use a remote release but if you don’t have one, use the self timer to stop any vibrations and use mirror lock-up if your SLR has this facility.

I find my 17-40mm wide angle zoom and my 70-200mm telezoom particularly useful. These two lenses cover most of my requirements.

I use the wide-angle zoom when including plenty of foreground elements. Its wider field of view is especially good for compressing perspective and creating layers on misty mornings.”
Stay out late and shoot stunning sunsets

WITH MARK BAUER

Although it’s possible to take landscape photographs at most times of the day, there are two times when most landscape photographers agree the light will give the best results – the first and last hours of the day. What makes these times of day special is that the low sun casts long shadows and helps to pick out the features of the landscape. If you’re out pre-dawn or post-sunset, you can also see some spirocular skies as the clouds are lit from below.

The light is quite similar at these two times of day, and whether you prefer one or the other often depends on which direction of light will best suit your chosen subject. So, for example, the south coast in winter will look best at the end of the day rather than the start. Having said that, the light in the final hour of the day tends to be warmer, and as the sun sets, the landscape is often bathed in a golden glow. And, of course, the nice thing about sunset compared to sunrise is that you don’t have to force yourself out of bed at a ridiculous hour to make the most of it. Let’s be honest: not everyone has the willpower and enthusiasm for sunrises as Helen Dixon (see previous page).

Almost any type of landscape looks good in the magic hour, but some features really benefit, such as stone buildings or rocky cliffs. When the low sun warms everything up and picks out the texture of rock and stone, scenes that might look dull at any other time of day can be lifted out of the ordinary.

Water is also an excellent subject at this time, because if you have an interesting sky, you can double the impact by using reflections. Moving water can sparkle like diamonds or be made to blur during long exposures. Again, the amount and type of light falling on it will determine the result.

The direction of the light can have a strong influence on the mood of pictures taken at the beginning or end of the day. Front lighting can look flat, as the direction of the shadows doesn’t help to pick out the details of the landscape. With the sun to one side, shadows help create depth in the picture and reveal form and texture. Side-lighting is best if you want to use a polariser to saturate colours, as it will have its strongest effect if the camera is at a 90° angle to the sun. Back-lighting can be very dramatic, but exposure is difficult to control and you will have to be careful to avoid flare as light falls directly onto your filters or the front element of your lens.

So, with weather being notoriously unpredictable, how can you tell if the magic hour will live up to your expectations? Looking at weather forecasts is a good idea. The Met Office’s website (www.metoffice.gov.uk) is reliable and you can get a fairly detailed forecast for specific regions. Remember that the longer the range of the forecast, the less reliable it will be. Checking the forecast online the night before a dawn shoot gives you the best guide to what to expect.

If you drive to your location, listen to local radio stations in the car, rather than national ones and keep an eye on what’s happening in the sky as you can tell you a lot.

For sunsets you’ll need to look to the west, as this is where the sun will be at magic hour. Most of our weather fronts come from the west too, so by keeping an eye in that direction, it’s possible to see if clouds are likely to break up or thicken.

Being aware of wind direction, the points of the compass and weather patterns will help enormously and you will eventually start to recognise the signs of a magic moment.

**KIT WATCH!**

Mark Bauer’s magic hour kit

“Wide-angle lenses are the most popular for landscape work, but longer lenses can also be useful for picking out the kind of patterns and textures that the magic hour can reveal.”

“Polarising filters will help you make the most of side lighting by improving overall saturation, but is especially effective when used with blue skies.”

“A sturdy tripod is another essential. If you’re shooting in the period after sunset, light levels will be low and handheld is out of the question. But it’s good practice to use a tripod, whatever the lighting conditions: it will slow you down, it makes you think and it enables you to make small but often vital changes to composition.”

“Neutral density graduated filters are essential, especially if clouds are lit from below and there is no direct light on the land. ND grades help control contrast.”

**WHITE BALANCE**

The White Balance you use has a major effect on the final result. Avoid using the Auto setting. If you shoot in P mode, you can try out all the settings later on your computer and choose your favourite.

**OSMINGTON MILLS BEACH**

“The light lit up the details of the rocky ledge and gives the cliffs a warm glow. A 0.9ND grad, angled so as to reflect into the cliff edge, retains details in the sky.”

Canon EOS 5D with 17-40mm lens.
**EXPERT TUTORIAL**

**Shoot a misty morning**

True landscape fanatics don’t believe in ‘lie-ins!’ Get up early for a mist opportunity rather than a missed one!

**WITH MARK BAUER**

Late winter/early spring is excellent for shooting atmospheric landscapes, especially if you’re prepared to get up early. As one season slips into another, it often brings interesting weather with it. At this time of year, misty mornings are common, often combined with a touch of frost. Foggy scenes convey a sense of romance and mystery, and add an element that can lift otherwise bland scenes out of the ordinary. With careful planning, it’s possible to capture dramatic, atmospheric scenes.

**How to meter to perfection every time**

Mist and fog tend to fool the camera into underexposure, so be prepared to add at least a stop over the metered reading using exposure compensation. If shooting Raw, you’ll record the maximum amount of tonal information by exposing ‘to the right’ (pushing the exposure as far into the highlights as you can without actually ‘clipping’ the highlights.) You’ll need to do some work in the Raw converter on exposure, brightness and contrast, but the end result will be a better image.

1. **Choose your day**
   - At this time of year, fog and mist are formed when mild, moist air passes over cold ground – the lower layers of the air get cooled down rapidly to the temperature at which fog or mist forms. Keep an eye on the forecast and look out for cold, clear nights with a light south-westerly wind, as this gives a high chance of mist or fog. Even if the conditions seem right, however, an atmospheric sunrise isn’t guaranteed – often, for example, you can get a thick fog rather than mist – so persistence is important.
   - Be prepared to make multiple visits to your favourite locations.

2. **Be well prepared**
   - Mist often forms at the bottom of valleys, where the ground is colder, so the hills above a valley are good place to be, as this enables you to shoot from above a layer of mist, with hills rising out of it. Being near water also helps, as this helps to cool any air moving over it. Research suitable locations well in advance and arrive a good half an hour before sunrise, as the pre-dawn light can be magical. For this shoot, I set up overlooking the west Wiltshire Downs, with mist lying at the bottom of the hills.
   - Also, be sure to wrap up warm – gloves, a hat and a thick fleece are essential!
I zoomed in slightly from my initial composition, to remove the slightly distracting band of colour at the top of the frame and keep the shot as monochromatic as possible. I used a daylight White Balance preset to keep the pre-dawn colours cool, and added a touch of vibrance to enhance the blue tones. Keep shooting as the mist swirls around and the light changes.

**CHECK YOUR composition** You need to look for strong, bold shapes, as mist hides shapes and dilutes colours, making a scene monochrome. I like to look for overlapping and interlocking shapes that help add a sense of depth to the scene. Backlit scenes can also work well, as the shapes of hills are silhouetted in the mist. Flare isn’t too much of a problem with backlit shots, as the mist diffuses the sunlight. For this shot, I selected a hill rising out of the mist as the main focal point, and arranged it according to the rule-of-thirds. Behind the foreground hill, the layering effect leads the eye into the backdrop.

**exposure & filtration** Mist can fool the meter into underexposure, so as a starting point, set +1 stop exposure compensation. Meter from the land and the sky to check the difference in brightness, to see if you need a graduated filter and, if so, which strength. Take care not to over-filter the scene (e.g. if there’s a four-stop difference in brightness, use a three-stop grad so that the sky remains a little lighter than the land and therefore looks natural). For these shots, I used a one-stop soft grad as, although there wasn’t a huge range of contrast, I felt that the sky needed a little bit of help to add interest.
EXPERT TUTORIAL

Evenings by the coast

As well as rising early, landscape enthusiasts tend to stay out until the twilight hours to capture mood and drama.

WITH MARK BAUER

Seascapes are a hard subject to resist photographing, especially during a sunset when you can get beautiful blue and purple hues from the sky and silvery water from a long exposure. When planning your shoot, remember that location and composition are important elements to determine the success of a seascape image. I try to pick places where there are rocks, so the bold shapes and jagged edges contrast with the softness of the water. Leave plenty of space around the static objects too, to allow you to capture movement in the water. I try to shoot low-light seascapes with an incoming tide, so that the waves wash up around the foreground, adding brighter tones. If you shoot when the tide is falling, you could end up with rocks being rendered as dark masses in the foreground because there is not enough light to show their wet, shiny surfaces. Getting the timing right for individual waves is important too: time the exposure so that there is water movement in the frame for at least some of the time the shutter is open.

1 This isolated cove on the Purbeck coast is ideal for low-light seascapes, with its jagged, rocky ledges and boulders on the foreshore. However, with the sun only just below the horizon, the light is still a little harsh, and the tide is too far out and would be too far away in the frame.

2 Spot meter readings from the foreground and the sky tell me that there is a five-step difference in brightness between them. A three-stop ND grad brings it all within the camera’s sensor range. Waiting a few minutes means the waves are now washing up onto the foreground.

3 Even with the waves intruding into the foreground area, there are still too many dark tones, especially to the right of the frame, so I tweak the composition, moving the camera’s view to the left. Now it’s just a case of waiting for the light to drop further and the right waves to come in.

KITWATCH!

Protect your gear

Protect your equipment with a raincover. You can improve by using a freezer bag, or there are several which are commercially available. I favour the Optech Rainleave – they’re cheap, do the job well and you can see all your camera settings properly, which isn’t true of some of the more pricey alternatives.

TECHNIQUEWATCH!

Calculating exposure

Most DSLRs allow you to set a maximum exposure time of 30 seconds. You could raise the ISO to stick within this limit but to get the best image quality, stick to ISO 100 and switch to the Bulb setting, which allows you to keep the shutter open for as long as you want. To calculate how long that should be, in aperture priority mode, increase the ISO until you get a meter reading. Then work out what the equivalent exposure is at ISO 100, switch to Bulb and take the shot. For example, if at ISO 400 the correct exposure is 30 seconds, the equivalent at ISO 100 is two minutes. At dusk, light levels drop so keep checking and adjust accordingly.
The low light levels produce a lovely blue-purple in the sky and the sea. This one’s almost there but just needs a little more water washing up on the right-hand side of the picture, to break up the dark tones and help to balance out the foreground interest.

The incoming tide forces a change of position. By this time, the light is low enough to allow a 45 second exposure (ISO 100 and f/16) without having to use an ND filter. A three-stop grad is still necessary because there is no direct light falling onto the land or sea, but the sky is lit from below.
EXPERT TUTORIAL

Shooting star trails

If you're in a remote location, take advantage of clear night skies by aiming high and trying to capture star trails.

WITH JOHN PATRICK

Star trails are rewarding subjects that can add an element of magic to a landscape shot, revealing the scene in a way that isn't visible to the eye. They allow you to extend the day's potential shooting time, and to get out with your camera – especially if you work through the week and can't get outdoors during the daylight hours in winter. If there's any 'secret' to the technique, it's getting the exposure right, but that's simple when shooting digitally...

1 FIND THE LOCATION

If you can, it helps to find your location in advance, in the daylight hours. Mid-day is a good time to do this for a couple of reasons. One is that it's often dead-time in the landscape photographer's day when the light is too harsh for shooting. The other is that, with the sun to the south, shadows will point north towards where the stars will be circled around Polaris later. Previsualising that will help you create a good composition. You'll need to ensure that you're a decent way from major light pollution too.

KIT WATCH!

Manfrotto 055 Pro B Tripod

You'll need to keep the shutter open for the long exposure and the best way to do that is to use a remote release with a lock to hold the shutter open. This helps avoid inadvertently knocking or moving the camera. A sturdy tripod is important too and a wide-angle lens is handy as it helps get plenty of sky in the shot. Other than that, star trails don't need any particular specialist kit. Don't forget plenty of warm clothing though. Even if you're used to being out in cold weather, standing around for half an hour or more in the dark in sub-zero temperatures can bring a whole new level of chilliness, so pack a few extra layers to keep you comfortable.

2 SETTING UP

Pick your night (a night with a half-moon is a good choice if possible) and set up the camera on the tripod. If it's too dark to see properly through the viewfinder, you can take a few shots with a high ISO and wide aperture, gradually making adjustments to fine-tune the composition. Autofocus is unlikely to work in very low light, so you'll need to focus manually – either by using the distance scale or by placing a torch somewhere in the scene to focus on.

3 METER THE SCENE

You can meter the scene before taking the final shot by taking test shots at a high ISO and wide aperture. I'm using ISO 1600 and 1/4 here. Set the camera to manual and start with an exposure time of around 20 seconds. Take a shot and check the histogram, then simply alter the exposure time and re-take test shots until the histogram looks correct. After a bit of experimentation I find that one stop underexposed works best.

The glow from urban areas is known as light pollution and can be seen from miles away on a clear night. This might not be obvious to the naked eye but will show up clearly on a long exposure.
4 SETTINGS FOR THE FINAL SHOT When you're happy with the exposure, set the camera to 'Bulb'. Select ISO 100 and set a wide aperture. I tend to use f/5.6. Now you can use the exposure time from step 3 to work out the time needed for the final shot, compensating for the change in ISO and aperture by increasing the time. For instance, if you needed a 30-second exposure in step 3: 30secs x 2 (for a one-stop change from f/4 to f/5.6) x 16 (for the change from ISO 1600 to ISO 100) gives a 16-minute exposure.

5 TAKE THE SHOT Turn all lights out, note the time and lock the shutter open with the remote release. Get out some coffee and chocolate, have a break for a while and enjoy staring at the stars. Just don't do what I did and discover at this point that the coffee's back down the road, still in the car! If you need to put a light on at any point to read the time, be careful not to illuminate the foreground at all, as it will show up in the final shot (unless you're deliberately attempting light painting, but that's another topic).
In the Niger Delta, even routine cooking looks extraordinary.
ED KASHI: Born in 1957 in New York. Earned a degree in photojournalism at Syracuse University.
Photographed in more than 60 countries. Received numerous awards for a wide range of work.
Photographs appeared in National Geographic magazine, among many other publications.
Photo data: SIGMA 10-20mm F4-5.6 EX DC HSM, 1/250 second exposure at f13.

ED KASHI SHOOTS THE WORLD
WITH A SIGMA LENS

The ultra-wide angle capabilities of this Sigma lens open up new possibilities to digital photographers.
The image circle of the lens is specially designed to suit digital SLRs with APS-C size sensors. Special Low
Dispersion (SLD) glass and aspheric lens elements correct aberrations for clear, distinctive image quality at
all times and allows a minimum focusing distance of 24cm (9.4 inches) throughout the entire zoom range.
The Hyper Sonic Motor (HSM) provides silent, responsive auto-focus with full-time manual focus override.
This compact lens is finished to advanced EX standards and comes complete with a matched petal-shaped
lens hood.

This affordable, extraordinary ultra-wide-angle zoom lens will transform your photography.
SIGMA 10-20mm F4-5.6 EX DC HSM

*Vignetting (a darkening of the corners of the image) will occur if the lens is used with digital SLR cameras with image sensors
larger than APS-C size or 35mm SLRs, and APS SLRs

Sigma Imaging (UK) Ltd, 13 Little Mundells, Welwyn Garden City, Herts. AL7 1EW. Tel: 01707 329 999 Fax: 01707 327 822
www.sigma-imaging-uk.com E-mail: sales@sigma-imaging-uk.com
LANDSCAPE FILTERS

THE HUMBLE FILTER OFFERS arguably more creative possibilities for making the most of your digital SLR than any other accessory. We're all aware that digital SLRs are a great way of capturing wonderful images, but some photographers are still oblivious to how filters can dramatically improve their results.

Take a look at the work of established photographers and you'll see them regularly use filters like polarisers or ND Graduates to capture the best possible results. There is a reason why dedicated landscape photographers spent time and money using filters: they give better results. This section looks at the main filter formats, which types of filters you'll find most useful and explains how you should use them.

With image manipulation software such as Adobe Photoshop available, the question of whether or not you need filters any more is a fair one to ask. Our answer is simple: Yes. Read on to find out why.

SCREW-IN FILTERS
These attach via the filter thread on the front of most lenses. They offer the advantage of using high quality optical glass, while their small size means they're easy to store and carry around in their protective cases. The disadvantage is that each only fit one diameter of lens, so if your lenses require different filter thread sizes, you'll need extra filters. Using more than one filter together risks vignetting (dark corners on your images).

SLOT-IN SYSTEM FILTERS
If you plan to use a number of filters or own several lenses, a slot-in system is more cost-effective. You only need to buy one of each filter type, which is inserted into a holder attached to the lens via an appropriately sized ring. You need a ring for each lens but swap the holder between them. Most slot-in filters are made from a tough resin, which is of high optical quality, but you need to take more care than with glass filters to avoid scratches.
Polarising filters

If you only ever buy one filter, buy a polariser. By simply rotating it, in its mount, you can bring your images to life. A polariser is designed to eliminate glare, minimise reflections and enhance saturation.

Polarising filters are best known for their ability to darken blue skies. However, they are equally useful for reducing reflections on non-metallic surfaces (in particular water) and the glare from foliage.

Not only does an enriched, blue sky look appealing as part of a landscape photograph, but a polarised sky can also create an attractive backdrop. Try shooting buildings, people, trees or flowers contrasted against a polarised sky – the results will be bursting with impact.

To understand how polarisers work, it’s necessary to get a little technical. Basically, light is transmitted in wavelengths. Light travels in straight lines, vibrating as waves in all directions and at all angles.

When light strikes a surface, a portion of the wavelengths are reflected while others are absorbed. It is the absorbed wavelengths of light that define the colour of the surface it’s striking. For example, a red-coloured object will reflect red wavelengths of light whilst absorbing others.

Polarised light is different. It occurs due to the reflection or scattering of light waves and only travels in one direction. It is these wavelengths that create glare and reflection, reducing colour intensity. A polarising filter is designed to block polarised light, thus restoring contrast and saturation.

Polarisers are made from a thin sheet of polarising material, sandwiched between two circular pieces of glass and screwed onto the front of your lens. The front part of the mount can be rotated, affecting the angle of polarisation. As a result, the amount of polarised light passing through the lens can be altered to control the amount of polarisation. Look through the viewfinder while rotating the filter (or using the LCD monitor with Live View), reflections will come and go and the intensity of colour will strengthen and fade again. Simply stop rotating the filter when you feel the effect is at its best for the scene or subject.

One last thing. A polariser has a two-stop filter factor and, while your camera’s automatic metering will allow for this, it’s worth bearing in mind how this will affect the range of shutter speeds and apertures you have available. It’s worth ensuring you mount your DSLR on a tripod whenever you use a polariser to ensure you avoid the risk of camera shake.

**KIT WATCH!**

**Polariser choice: Linear or circular?**

There are two types of polarising filter on the market – Linear and Circular. Only the Circular type will work properly with your digital SLR. Although both varieties are physically circular and similar in appearance, the Linear variety will affect the accuracy of your camera’s metering system. This is because digital SLRs polarise some light inside the camera. If this light has already been polarised by a Linear polariser, a false meter reading is given. Circular polarisers are constructed with a wave retardation plate, allowing the light waves passing through to rotate and appear unpolarised to the camera’s metering system. Buy Circular.

---

**Get the best from reflections**

Reflections can either be good or bad. For example, rolling hills or snowy mountain peaks will be enhanced if they’re mirrored in the still, reflective surface of water. But the light and glare reflecting from shiny non-metallic surfaces or glass, in a cityscape or on a skyscraper, can be ugly and distracting. A polariser can be used to either emphasise reflections – by reducing surface glare – or eliminate them.

However, the strength of the effect will depend on the camera angle in relation to the reflective surface. The maximum effect is at an angle of 30-45°.
DON'T PANIC!

Avoiding polarising problems

UNEVEN POLARISATION Natural light polarisation is uneven across the sky. Its maximum effect is when facing 90° to the sun and its minimum is at 180°. So when taking pictures at certain angles, you may find that the colour of the sky darkens more noticeably in one area — this region of the sky contains more polarised wavelengths. This effect can look odd and is best avoided. Ultra wide-angle focal lengths (10-14mm) are most prone to this problem. To try and side-step this problem, use a lens with a long focal length lens or adjust your shooting angle. However, if this just isn’t practical, you could try positioning a Neutral Density Grad filter at an angle so that it filters the lighter region of the sky. Although this isn’t a faultless solution, an ND grad can greatly reduce the effect.

OVER-POLARISATION A deep blue polarised sky may be appealing, but it is possible to overdo the effect. In some situations, a polariser isn’t needed at all — or only partial polarisation is required — to produce the best-looking result. If the effect is too great, the sky can appear almost black in colour. This will look unnatural and degrade the aesthetics of the image. So use image playback to check the effect and adjust the rotation of the filter accordingly.
**Graduated filters (grads)**

Grads are half-coated, half-clear, with a transitional zone where the two halves merge. There are two distinct types of grad: Neutral Density (ND) and colour grads. ND graduated filters are designed to darken bright skies and lower contrast levels, whilst the coloured variety are intended to add a splash of colour to otherwise dull, nondescript skies.

ND grads work by absorbing all the colours in the visible spectrum in equal amounts, with no colour cast. This is necessary as the contrast in light between sky and land is often greater than the dynamic range of the sensor – making it impossible to capture a correctly-exposed scene.

They are available individually or in a set of different strengths to suit different conditions. Their strength, or density, is indicated on the filter. 0.3 equals a one-stop exposure reduction, 0.6 a two-stop and 0.9 equates to three stops. ND grads are also available in both hard- and soft-edged transitions.

Soft NDs are designed with a feathered edge, providing a gentle change from the coated portion of the filter to the clear area, whilst a hard ND grad has a more sudden transition. Both types are useful: soft grads are better suited to shooting landscapes with broken horizons as they don’t noticeably darken objects like buildings or trees. Hard grads are designed so the full strength of their specified density is spread over a greater proportion of the coated area, allowing you to reduce the brightness of the sky with greater accuracy.

Whilst colour grads are not as useful on a day-to-day basis, they shouldn’t be overlooked. To an extent, they also lower contrast, but instead of having the practical role of an ND grad, colour grads are designed for creative effect. There are a wide variety of different colours available, from subtle looking shades of blue, coral and orange, to the artificial look of red, pink and tobacco. Some, such as the wholly-coloured sunset filter, lack a clear area. Instead the whole filter graduates from a strong to weak colour tint.

Colour grads may not be for the purists, but combined with a suitable scene, they can help produce eye-catching results. However, a quick word of warning. They should be used with care and in moderation. Only employ a colour grad when its effect genuinely enhances the image you are about to capture – if you have any doubts, take an unfiltered shot as well. You also need to ensure accurate placement: if you push the filter too far down in the holder, the coated area of the grad will stray over the foreground, running the realism of the result.

**Neutral Density (ND)?**

Neutral Density filters work using a similar principle to a graduated ND. However, unlike a grad, the entire filter is coated.

They are designed to limit the amount of light passing through the lens. Therefore, if after adding the filter the shutter speed is kept the same, a larger aperture must be selected to obtain the correct exposure. You can use this to reduce depth-of-field and control how much of a scene is out of focus.

Alternatively, if the f-stop is maintained, a slower shutter speed must be selected to achieve the right exposure. This can help to blur moving water during longer exposures.

ND filters are available as both slot-in and screw-in types and also in progressive strengths (densities), whilst they can be employed to compensate for too much light – in situations where you’d like to increase the aperture more than the light or camera capabilities permit – an ND filter is more commonly used by landscape photographers to emphasise movement, especially water.

**KIT WATCH!**

**Angle your grad**

When using graduated filters, a slot-in filter holder – like the Cokin P system – is virtually essential. Whilst circular, screw-in type graduated filters are available, they are hugely restrictive.

This is because, unlike a slot-in filter, the position of the graduated zone cannot be adjusted up or down to suit your composition, greatly limiting your creative possibilities.

Another advantage of using a holder is that, if the scene you are photographing has a sloping horizon, it is possible to adjust the orientation of the holder to match. This will avoid the graduated area of the filter overlapping your foreground, which will either artificially darken or colour part of your scene.

You may also wish to position a grad at an angle to help alleviate uneven polarization. However, by angling the holder, there is an enhanced risk of vignetting (darkening at the corners of the image) with wide-angle lenses. Therefore, check images through both your viewfinder and via your LCD monitor.
ND GRAD RESULTS

The sky in a scene such as this will be several stops brighter than the shaded rocks in the foreground. An ND grad filter means detail in both is captured.
EXPERT TUTORIAL

ND grads and Photoshop

An ND graduate darkens skies for a more balanced image but post-processing can be necessary in certain scenes

WITH MARK BAUER One of the main technical challenges in landscape photography is controlling the contrast in a scene so that you can accurately record detail in both the land and the sky. Often the sky is a lot brighter than the land, and the contrast in the scene is beyond what the camera’s sensor can record, resulting in either a well-exposed sky and underexposed foreground, or the opposite. The usual way around this is to use a Neutral Density (ND) graduated filter. These filters are brilliantly simple – they are dark at the top and clear at the bottom and all you do is position the dark half over the brighter area of the picture, reducing the contrast between the light and dark areas and therefore enabling you to capture detail in both the foreground and the sky. The only problem is that the dividing line between the dark and light areas of an ND grad is a straight line, and not all landscapes have a straight horizon – often the horizon is broken by an object such as a tree, a hill or a building, and the filter can cause an unnatural-looking darkening of the top of these objects. However, help is at hand as, most of the time, post-processing will rescue the shot. Here I explain how to use an ND Grad and remove its effect from specific areas.

1 Arriving at Portland in Dorset just before dawn, I took a spot meter reading from the foreground rocks and the sky, which revealed a difference in brightness of around four stops. Although this falls within the dynamic range of the sensor, shadow detail has been compromised a little, and lifting this in post-processing could reveal noise in the image.

2 With a four-stop difference between the rocks and the sky, I chose a three-stop ND grad filter, as it would leave the sky a little bit lighter than the foreground. The next choice was to use a soft or hard grad (see panel). Soft grads aren’t always the best choice for seascapes, as the brightest part of the scene is often across the horizon line, so I decided on a hard grad.

3 Using the hard grad filter has resulted in a much more even exposure, but there is a problem. The top half of the lighthouse, where the filter has cut into it, is a bit too dark. The effect is fairly subtle, but it’s definitely there, and doesn’t look natural. Fortunately, this common problem can be easily sorted out with a spot of post-processing work.
4 Using the Magnetic Lasso Tool in Photoshop, I selected the darker top half of the lighthouse, so that I could work on the problem area without affecting any other part of the image. I decided not to apply any feathering to the selection, as this could leave a ‘halo’ around the lighthouse once I’d finished lightening the selection.

5 There are various ways of lightening or darkening images, such as Curves and Levels, but for this selection I decided to use the Dodge Tool, as I could paint the effect on gradually and build it up in the areas that needed it more. I set the Exposure value to 10%, which enabled me to work gradually on lightening the selection.
Add a digital graduated filter

WITH LUKE MARSH Using Photoshop to recreate the effect of a graduate filter allows a variety of effects to be created in minutes. Photoshop expert Luke Marsh explains how to create a stunning graduated effect using adjustment layers, so the effect can be repeated and adjusted until the combination of layers and original image is perfect. In this easy-to-follow step-by-step tutorial, Luke introduces you to Adjustment Layers, Gradient Fill, Gradient Editor, Color Picker, Blending Mode and Photo Filter for mood. Photoshop isn’t an alternative to optical filters, it’s a complementary skill. Use it to produce images that are not possible on location or when you forgot your grad. Photoshop Elements 4.0 was used here, but more recent versions are suitable too.

1. The aim is to create a similar effect to a conventional grad filter, but using a series of digital graduated layers instead. I create my first gradient by clicking the Create Adjustment Layer icon (*) situated at the top of the layers palette, and scrolling to Gradient which opens the Gradient Fill window.

2. In the Gradient Fill window, tick Reverse so the gradient runs top to bottom, then click anywhere within the Gradient field (situated top) to open the Gradient Editor sub-window. The sliders at the top of the visible gradient control opacity, and moving the White slider will increase the transparent ratio of the gradient.

3. The sliders at the bottom of the gradient control colour, the left representing black. Click the black slider and note that the colour now appears in the field below, clicking here opens the Color Picker sub-window. Use the vertical spectrum (centre) and the main window (left) to select the desired colour then click OK.

4. Click OK in the subsequent windows to apply the gradient, then choose Multiply from the Blending Mode menu situated at the top of the layer palette (inset) to create a more natural merging of the gradient to the original image. This Adjustment Layer Gradient can be tweaked at any time by selecting it in the layers palette.

5. It’s quite often necessary to create more than one gradient layer to build up the filter effect. Here, I duplicate steps 1 and 2 creating a gradient that is black to transparent, then, choosing Soft Light in the Blending Mode menu and reducing the layer Opacity (inset) creating a natural darkening effect that can easily be adjusted.

6. The final gradient layer is going to add a subtle fall-off to the rocks leading out of the image to the bottom of the frame. Again, I repeat steps 1 and 2, this time leaving the Reverse box unchecked so the gradient runs from bottom to top. Once again, I set the Blending Mode to Soft Light and reduced the Opacity.
Adding the final touch with Filter > Adjustments > Photo Filter

Photoshop Elements and CS have mood filters that can be used to change the overall tone of your image, much like using a coloured gel or filter on your digital SLR. This handy action, found in the top menu under Filter > Adjustments > Photo Filter, has several preset filters including Warming, Cooling and Sepia or you can choose to manually filter through the Color Picker. The intensity of the selected tone can then be adjusted with the Density slider to allow for some very subtle effects, giving far greater control than that of an optical lens filters. When you’ve finished adding a grad effect to an image, it’s well worth the time trying some of these out to see if the image can be improved upon further.

**ABOVE**: Choose from a range of preset filters available in the Photo Filter function or use the Color Picker to customise.

**RIGHT**: **FINAL COLOUR SELECTION** Although happy with the results of my grad filter effect, I found the image could be improved upon further with the use of the Photo Filter action. After a little experimenting, I began to favour the use of the Deep Blue preset filter at about 80% Density, making the overall mood of the image slightly cooler, which I think works better with the subject matter.
WATER IN LANDSCAPES

It is essential to life and landscape photographers are intuitively drawn to water — regardless of the form it takes. It can greatly influence the feel and look of our shots. Water can create drama, have a calming effect, or create the impression of motion. Whether it’s the rapid flow of a river, cascading over rocks and boulders; the reflective quality of a large body of still water; or big, menacing waves crashing over jagged, rocky outcrops, water is often a key ingredient to successful landscape images. However, water presents digital SLR photographers with a variety of challenges, particularly with exposure. But these considerations are relatively straightforward to overcome. Over the coming pages, we will help show you how water can be used in your compositions to improve your landscape images.
Water and composition

You won’t have to travel far to find water. In hilly regions, waterfalls are relatively common, whilst rivers and streams meander through our countryside. In towns and cities, waterways and canals are a common sight and large bodies of water, like lakes, lochs and reservoirs, are dotted around all over the country.

In the UK, you are never that far from the coast and the sea provides photographers with a huge number of opportunities. It creates the perfect backdrop to sandy or rocky bays and rugged cliffs. Whilst the sea is photogenic on calm days, it is at its most dramatic in rough, stormy weather when large, crashing waves bring energy and movement to coastal landscapes. A river, winding its way through your composition, will guide the eye through the image – effectively increasing the photo’s depth and interest. Streams and rivers are perfect subjects to create an ‘S’ curve or ‘lead-in’ line. Small puddles can also help composition, creating ideal foreground interest. For example, the shallow pools exposed at low-tide are very photogenic. They will help to add a three-dimensional feel to your pictures if you attach a wide-angle lens and photograph them from nearby to emphasise their curves and reflections.

Water works well when photographed as the main subject. A wide-angle lens, such as an 12-22mm, together with a low viewpoint close to the surface of a river, will create the impression that the water is practically flowing into the camera – but only do this if it’s completely safe. To ensure maximum sharpness, ensure sufficient depth-of-field by choosing a small aperture, such as f/13-16, and focus one-third of the way into the scene, using the LCD monitor to check the result.

Reflections in water

On calm, still days the surface of any body of water will act like a mirror, perfectly reflecting its surroundings and the sky above. Reflections are a favourite subject among landscape photographers, particularly on large bodies of water when strong colours are also evident – during sunrise or sunset, for instance.

Rocks jutting out of the water, tall reeds, a jetty or rowing boats are among the objects that work well as part of a reflected landscape, adding scale and context to the image. The rule-of-thirds states that landscape photographers shouldn’t place the horizon centrally in the frame. However, when photographing reflections of a reservoir or loch, a centred horizon will often create a symmetrical result and actually strengthen composition.

Be careful if you are using a polarising filter to saturate colour and deepen blue skies. A polariser can also reduce the intensity of reflections – although to what degree will depend on the camera angle in relation to the reflected surface. In some situations, you may have to decide what is of higher priority – a deep blue sky and saturated colours, or poor reflections; or strong, vivid reflections, but sky and colours that are weaker. A polariser can actually intensify reflections by removing the sheen from the water’s surface. Therefore, continue using a polariser, just carefully regulate its effect on the reflections within the scene, by peering through the camera’s viewfinder as you rotate the filter in its mount.

If there are distracting ripples on the water, consider using a solid ND filter to lengthen exposure time. A shutter speed exceeding a second will help to eliminate gentle ripples and help maximise the strength of the reflections.
Water and exposure

Moving water has a tendency to appear white. As a result, accurate exposure is essential – overexposure will lead to white water being ‘burnt out’ and devoid of detail. Even if you shoot in Raw, such detail cannot be retrieved during post-processing, which is why it is important to achieve the correct exposure at the time of capture.

Your camera’s multi-zone meter can normally be relied upon to achieve the right exposure. However, don’t rely on the replayed image on your DSLR’s LCD monitor to assess exposure. Instead, view the image’s histogram. The graph represents the distribution of tones within the scene. Far left (0) represents pure black; far right (255) pure white; whilst the middle area covers mid-tones. If water is overexposed, this will be indicated by sharp peaks to the far right of the graph.

Most DSLRs also have a ‘highlights’ screen. This alert causes groups of pixels that have exceeded the sensor’s dynamic range to flash as a warning. If water within your landscape is overexposed, apply negative exposure compensation.

Problems occur in very bright daylight – particularly around midday. Brightly lit, frothy white water can prove very intense and there is no single way to achieve an overall correct exposure in-camera. This is why the softer, less intense light of early morning and evening is better suited to shooting water.

The quality of light on overcast days is also excellent for photographing water, particularly if using a long exposure to blur its movement. So, if it’s a dull day, don’t stay indoors thinking you can’t shoot landscapes, head to your nearest river or coast instead and start shooting!

Water movement - freeze or blur?

How best to capture water’s motion is a contentious issue. Some photographers like to capture water authentically, freezing its movement using a fast shutter speed. Others prefer to intentionally ‘blur’ it, in order to create the feeling of motion. Both techniques work well in the right situation. However, it is important to do one or the other – somewhere in between, when the water is neither blurred or sharp, will usually just look messy and unintentional.

If you wish to suspend water movement, you will normally need to employ a shutter speed of 1/500sec or faster – although the exact speed required will depend on the speed of the water.

Landscape photographers normally use a small aperture (large f/number) to achieve a depth-of-field big enough to render both foreground and background detail in sharp focus. As a result, they are often working with relatively slow exposures, especially when light levels are low.

This is one reason why many photographers go to the other extreme, employing a lengthy exposure to blur the water’s flow. To many eyes, this ‘blurred’ effect, creates more pleasing results – adding life and movement to images.

An exposure of 1/6 second should do the job, but a speed of several seconds is preferable – this is guaranteed to create an attractive silky, white blur. In order to generate a long exposure, employ the lens’s minimum aperture (typically f/22) and ensure that the camera’s lowest ISO setting is selected. If the resulting shutter speed still isn’t sufficiently slow, you will need the help of filtration.

Neutral density (ND) filters are designed to block light entering the camera – basically, they alter the light’s brightness, but not its colour. They allow photographers to employ artificially long exposures in order to blur subject movement. They are available in different strengths – commonly 1-, 2- and 3-stop densities – and as both screw- and slot-in types. A two-stop version will normally be sufficient. Your camera’s TTL metering will automatically adjust for the density.

USE AN ND FILTER

Sometimes you might have to reduce the amount of light coming into the lens to force down shutter speeds and create the blur. Neutral Density (ND) filters will do the trick. Polarising filters also reduce the light level by two stops, facilitating slow shutter speeds, but watch out for the effect on reflections.
EXPERT TUTORIAL

Shoot moving water

Lee Frost reveals how choosing the correct shutter speed is essential when including running water in landscapes

WITH LEE FROST LEE FROST: Although it has become something of a cliché, using a slow shutter speed to record moving water as a graceful, milky blur is an undeniably effective technique, which is why so many photographers, including myself, like to use it. From tumbling mountain streams to bubbling brooks and thundering waterfalls, wherever you find moving water, the same basic approach can be used to capture it and turn an ordinary scene into a creative image that’s full of atmosphere. Even better, moving water is best shot on an overcast day with soft light so there are no blinding highlights to contend with, caused by sunlight reflecting on the water. This makes it a perfect subject for those dull, grey days photographers in the UK know so well!

1 Because a slow shutter speed will be used to blur the water movement, always mount your camera on a sturdy tripod to keep it nice and steady. It’s also a good idea to attach a remote release so you can trip the shutter without touching the camera, which risks vibrations that could lead to your images being ruined by shake.

2 In dull weather, stopping your lens down to f/16 or f/22 and setting a low ISO may give you a shutter speed slow enough to blur the water. If not, use a Neutral Density (ND) filter to increase the exposure. A polarising filter can also be used to increase the exposure by two stops so 1/4sec becomes one second, for example.

3 Before taking a shot, check the lens or filter for water droplets. If you’re shooting close to a waterfall splash or spray may get on the lens. In this case, drizzle was the culprit. Wipe the water away with a clean microfibre cloth otherwise image quality will suffer. Holding an umbrella over the camera can help in rainy weather.

4 Take your first shot and review it. I was initially attracted to this spout of water hitting a rock and cascading in all directions. Shooting side-on proved to be a good angle and a shutter speed of one second offered enough blur. The shot worked, but there were many other options to explore.

5 I decided to try a wider view, using the water spout in the previous step as foreground interest, carrying the eye up the ravine towards the distant peaks of the Cuillin Ridge. It took a few attempts to get the shutter speed just right so no areas of the moving water were overexposed.

TECHNIQUE WATCH!

Select a slow shutter speed

The key to success when shooting moving water is to use a shutter speed that’s slow enough to blur the water, so it records with a smooth, milky appearance, but not so slow that areas where the water is more concentrated start to overexpose and burn out. This is a matter of trial and error, but an exposure of one second usually makes a good starting point. The great thing about digital capture is that you can check each shot you take to see how it looks, then shorten or lengthen the exposure time until you get the perfect result.

If tiny areas of water burn out, don’t worry – when you download the images and view them as full-size files, chances are those highlight warnings will have disappeared. And if they haven’t, it’s a simple job to use the Clone Stamp tool in Photoshop to copy and paste water from a different part of the image over the overexposed areas.
Here's the end result, shot with an exposure of 1.3 seconds at 1/22 (ISO 50), using a 0.9ND filter to increase the exposure and a 0.6ND hard grad to hold detail in the sky. The dull weather and soft light worked well, perfectly revealing the subtle colours in the scene, while the blurred water captures the feel of the tumbling mountain stream.
Try 3 issues for £1
Master your DSLR with this trial offer!

Claim 3 issues of Digital SLR Photography magazine today for only £1! You’ll get the next 3 issues delivered direct to your door and if you like what you see, your subscription will continue at the LOW RATE of £18.99 every 6 issues. A saving of 18% on the shop price – only £3.16 an issue, instead of £3.90 in the shops!

If Digital SLR Photography isn’t for you, simply write to cancel, and pay no more than £1!

YOUR GREAT DEAL
✓ 3 issues for £1 to start your subscription
✓ FREE delivery of every issue
✓ SAVE 18% on the shop price
✓ Improve your DSLR skills with our expert advice

Get your 3 issues for £1 today

PHONE: 0844 249 0482 Please quote offer code below
ORDER ONLINE: www.dennismags.co.uk/dslr
Entering the offer code below

Offer Code: G0912GSD
The Basics #7

UNDERSTANDING COLOUR

A LOT OF TIME, energy and thought has been devoted to the study of colour, its practical applications and its psychological effects. Often those applications and effects are linked. It’s not an accident that stop signs are red, cool settings on air conditioning are blue or that the environmental movement has adopted the colour green.

Much can be learned about the relationships between colours, too. Colours work together in different ways, with certain combinations creating energy and tension, while others harmonise and create calm. When a colour appears in nature with a greater than normal intensity, the stage is set for great landscape photography. Learning their relationship will reap rewards.

1) Harmony and contrast

There are basically two types of relationship between colours – harmony and contrast. Looking at a colour wheel helps us to understand this. Colours that are next to each other, for example blue and green, are harmonious, while those that are opposite, for example blue and yellow, contrast with each other.

Also, colours that are on the ‘warm’ side of the wheel harmonise with each other, while all those on the ‘cool’ side also harmonise. Harmonious colours are more calming to look at, and blues and greens in particular are very tranquil. Contrasting colours are more dramatic and create a tension that can challenge the eye – blue and yellow is a strong contrast.
2) Colour and emotion

As well as having visual impact, colours can suggest different moods, evoke different emotions and can have symbolic significance related to our culture and background. Think about the effect a dominant colour might have on your image. It might be appropriate to subdue a colour, or emphasise it. Consider colour in the composition, the lighting and through careful use of filtration.

- **RED** is an intense colour, especially when contrasted against a dark background. It is a colour universally used for warning or danger and is hard to ignore. Red is the most powerful and attention-grabbing colour in photography, though it can prove distracting if included small within the landscape, for instance, a distant car, boat or letterbox.

- **BLUE** is a retiring colour, which can be employed to convey restfulness, sadness or tranquility. In photography, it is commonly used to convey coolness, which works especially well when combined with water and wintry scenes. Blue is a very important colour for landscape photographers as a saturated sky creates a flattering backdrop.

- **GREEN** is often used to signify health and life. Obviously, green is the predominant colour of vegetation and therefore it is dominant in many scenic images. Green is easily overwhelmed by bright advancing colours, like red and, generally speaking, has less impact. However, when isolated, green can still create strong, interesting images.

- **YELLOW** is another bold, advancing colour, often used to represent happiness or brightness. It will add warmth to your image and works particularly well when combined or contrasted with blue. Yellow, along with similarly rich colours, like gold and orange, epitomise autumn. It can prove a good background for still-life images.
3) Using only one colour

Single colours often give an image a particular mood and it’s possible to make successful compositions using just one colour – or shades of one colour. Certain lighting conditions can create this effect and add atmosphere to a scene. An intensely orange or red sunset will give every neutral colour a strong bias, bathing a scene in a fiery warmth.

Also, strong backlighting can desaturate colours, creating an almost monochromatic effect; while at pre-sunrise and post-sunset, there is no single strong light source and the light is diffused and reflected down from the sky.

The two images on the right are really good examples of monochromatic images. Startling them on the far right you can see how backlighting has drained the colours from this scene, resulting in an image that appears almost devoid of colour.

The pre-dawn light bathing the lake and dead wood in the near right picture is diffused, falling on the scene from virtually the whole sky. It has given the whole scene a fairly cold cast, but the mood is very tranquil. It really suits the cold, wind-free stillness of a winter morning.

4) Colour saturation

OK, if we were going to be strictly technical about this, the term ‘saturation’ refers to how pure any given colour is. But over time and in practical terms, saturation has come to mean how intense or strong a colour appears in an image.

Producing saturated images involves much more than simply boosting colours in Photoshop – although much can be done that way, with great results – there are plenty of options at the picture-taking stage. Let’s consider those first.

The time of day has an impact on colour saturation. Early-morning and late-evening light, with the sun low in the sky and less glare, will produce more intense colours than at other times, as will front lighting rather than side or back lighting.

A polarising filter, by reducing reflections and cutting down on glare, also improves saturation. A polariser has the maximum effect when the camera is at 90° to the sun. Polarisers are simple to use as the effect is clearly visible through the camera’s viewfinder – the most obvious one being the increase in saturation of blue skies.

There are a couple of things to watch out for. It is possible to ‘over-polarise’ a scene, resulting in skies appearing almost black, and also, when using wide-angle lenses (wider than 28mm on a full-frame SLR or 17mm on an APS-C-type SLR), the degree of polarisation can be uneven across the frame.

Of course, it’s not always desirable to have strong, vibrant, saturated colours. Muted, pastel tones are more subtle, but can be just as effective with the right subject matter, creating an atmosphere of calm and tranquility. Early morning mist will dramatise colours, and also give a cold, bluish hue to a scene, which you can enhance by tweaking the White Balance either in-camera, or later, if you’re shooting Raw, at the conversion stage.

Of course, a lot can be done at the processing stage. Experiment with different White Balance settings to try to fine-tune the overall atmosphere and find an overall cast that suits the image best. Over the page, we’ll show how varying the White Balance of a Raw file can have give dramatic results.

FILTER CHOICE

Types of polariser

There are two types of polariser: circular and linear. This doesn’t refer to the physical shape – they’re both actually circular, but the way the light is polarised. Make sure you buy a circular polariser for use with your DSLR as linear types interfere with your camera’s metering, which can’t handle linearly-polarised light.
EXPERT TUTORIAL

Blur your vision!
Smearing Vaseline on a filter might not sound sensible, but it can help you capture creative results of colourful scenes.

WITH DANIEL LEZANO

Photoshop has allowed all sorts of weird and wonderful effects to be applied to images in post-production, but I still prefer to get as close as possible to the final image in-camera. Much of this is because I’m not particularly good with Photoshop to be honest, but mainly because I actually find it fun (as well as occasionally frustrating), to go ‘old-school’ and use more traditional photographic techniques to give the results I’m looking for. I’ve recently started experimenting with producing unusual soft-focus effects by smearing Vaseline on a filter. As I discovered, it’s very easy to try, so why not give it a go this month and see how you get on.

KIT WATCH!

Filter, Vaseline & cloth
The minimum of additional kit is required, so it’s an affordable technique to try. A tub of Vaseline won’t break the bank, but you’ll need a UV or skylight filter to screw onto the front of your lens. I cannot over-emphasise how important it is that you apply Vaseline to the filter and not to the front element of your lens, as it could permanently damage the optics. You should also keep a clean lens cloth handy, for wiping away Vaseline when you want to clean the filter and try again, or at the end of your day’s shooting. That’s about all you need in terms of accessories, with the exception of a tripod, which will keep your camera steady when you’re preparing the composition and focusing on the scene.

TECHNIQUE WATCH!

Applying Vaseline
As you’ll discover, getting a desired effect requires lots of trial and error when it comes to smearing the filter. Start off by applying a thin line of Vaseline across the central part of the filter and apply further smears until you’ve covered the whole surface. Take a few shots, rotate the filter so the smears are diagonal and shoot again. Apply thicker smears of Vaseline to create random patterns, and then wipe the filter clean and try again.

1 The first thing you need to do is to find a suitable scene. Ideally, the location you choose should have some well-defined shapes and areas of strong shadows and bright highlights, such as woodland. However, this colourful field of poppies caught my eye and I hoped to be able to use the Vaseline to create a strong abstract effect based around the bold reds. I mounted my DSLR on a tripod, to ensure images were shake-free, and used Sigma’s excellent 70-200mm f/2.8 lens to crop fairly tightly on the poppy field.

2 With the camera supported on a sturdy tripod, it’s important to ‘lock’ the focus before smearing the filter with Vaseline – the AF system will struggle to focus once it’s been applied. To do this, focus on the scene normally and then switch the lens from AF to manual focus, so when you press the shutter button later on, to take a shot, it won’t affect the focusing.

3 With everything prepared, it’s time to apply the Vaseline. Rather than scoop big wedges from the tub, gently smear relatively thin lines of Vaseline across the frame. Here, you can see how just a single smear affects the scene. I looked through the viewfinder the whole time I was applying the Vaseline, to see how it was affecting the overall scene.
Once I'd applied the Vaseline across the filter, I fired off a few frames, choosing a variety of apertures from f/5.6 to f/13, so that I could see how the results varied (in truth, it made little difference). After a few frames, I used my finger to apply more Vaseline, to see if a thicker layer would improve the effect. However, I found that using too much of it led to too soft a result.

As well as horizontal smears, I also rotated the filter so as to make the smears run diagonally and then vertically – this made a big difference to the result. I also tried a variety of smear patterns, such as criss-crossed lines and wavy lines to see what effect it had on the scene. It’s worth trying this, as it’s impossible to predict what works best.
EXPERT TUTORIAL

Colour temperature and White Balance (WB)

WITH MARK BAUER Different light sources produce different colour casts, basically in terms of how ‘warm’ or ‘cool’ the light is and how much green or magenta is present. For example, a household tungsten light bulb will produce a much warmer light than you will find outside on a cloudy day. Fluorescent lighting will have a green colour cast.

The warmth or coolness of a light source is referred to as its ‘colour temperature’, which is measured in degrees Kelvin (K). The lower the number, the warmer the light – for example, a sunset will have a colour temperature of around 3000K, neutral daylight (noon on a sunny day) is around 5000–5500K, and an overcast sky around 7000–8000K.

Our eyes adapt very quickly and easily to the colour of different light sources and will see a white object as white whether we view it under tungsten light or outside on a cloudy day. To render colour accurately with a digital SLR, however, you will need to set the correct White Balance, which can either be done when taking the picture or when processing the image in your Raw converter. Personally, I’d always recommend shooting in Raw, as it provides a lot more flexibility.

If shooting subjects such as portraits, colour accuracy and correct White Balance is essential, to achieve natural looking skin tones. With landscapes, however, absolute colour accuracy is not always what we strive for – capturing pleasing colours is more what it’s all about. So, in the old days of film, landscape photographers would use films like Fuji Velvia for its vibrant colour and use colour correction filters – amber warm-ups and blue cooling filters – to enhance mood and atmosphere rather than produce neutral, accurate colours. For example, a warm-up filter could be used to enhance the already warm light of a sunset. Digital photographers can use different White Balance settings to achieve similar effects.

Enhancemood with WB

For this series of pictures, I took the same Raw file and applied different White Balance settings to find out which ones suited the overall mood of the picture.

1) DAYLIGHT (5500K) The dusk light was cold and blue. There was just a hint of a glow from the sun below the horizon, picked up by the clouds over the distant headland. The daylight WB has rendered the scene well, with cool blue shadows that suit the mood of the image.

2) CLOUDY (6500K) The cloudy setting has warmed things up and added some magenta. This works well for the sky, but for my taste, has failed to enhance the water and shadows. I suspect a lot of people will like it, though.

3) SHADE (7500K) Too warm and magenta, and doesn’t reflect the mood of the scene. However, some people will probably like this.

4) FLUORESCENT (3800K) I actually quite like this, as it’s true to the mood of the actual scene, though it is a bit over the top and the sky has lost a lot of ‘oomph’.

5) CUSTOM WB (4800K) As a compromise, I went back to the daylight WB and cooled things down just a little. I felt that this was a good representation of the mood of the scene, though the sky lacked punch.
For the final result, I blended the sky from the cloudy WB into the custom WB image, then faded the sky a little, so that it looked natural with the cooler bottom half. The result was a picture that had the cool blue shadows and a more dramatic sky.
**EXPERT TUTORIAL**

**Shooting landscapes in black & white**

**WITH HELEN DIXON**

I always shoot my landscapes in colour and convert to black & white afterwards (see the feature on converting colour images over the page). This provides me with the full three channels of information to play with at the Raw processing stage, rather than just one. I do know some people who shoot JPEGs and use the in-camera monochrome setting, often in combination with a red filter to darken greens and blues to give really dark skies, but to get an image with the potential to give the best possible mono results, shoot in colour and convert to black & white on your PC.

You’ve got to try and visualise a scene in black & white; it’s much more challenging than a regular colour landscape. You need a good range of tonal detail, or you will end up with a scene lacking in contrast.

I wouldn’t normally shoot an image with a plain blue sky, for example, as you’ll just end up with a flat shade of grey. You’re looking for an active sky, something with plenty of cloud drama – a scene as a whole that has plenty of shadows and highlights, and separation between foreground and background.

A beach scene, for example, doesn’t tend to offer much tonal contrast. You’ve got the sand and the sea, maybe some cliffs, and the sky, each of which is fairly uniform in tone and texture and can end up looking fairly dull. It’s for this reason that I tend to gravitate towards country scenes for my black & white photography: there’s a lot more variation going on in texture and tone.

I also look for more lead-in lines with monochrome; the composition needs to be that much stronger because of the absence of colour. The viewer’s eye is much more focused on other aspects of the shot, such as shape, form, and texture. The viewer’s imagination has to work harder. Another great thing about shooting landscapes in black & white is that you don’t need the best weather. A dark, brooding sky can add a lot of drama to an image, and you don’t need to worry about using ND grad filters either, though I do still make sure to use a polarising filter to enhance the sky.

I don’t think enough people dedicate time towards black & white photography anymore. You need to see the image in print, hanging on a wall, to really appreciate it. It seems to have that much more power in exhibition than on-screen. The other advantage is that a black & white image will sit nicely on any interior wall, without the risk of it clashing with the colour. Monochrome imagery really does lend itself to display.

**“Another great thing about shooting black & white is that you don’t need the best weather. A dark, brooding sky can add a lot of drama to an image”**
Converting to black & white

One of the wonderful things about digital is that it is easy to convert your colour images to monochrome. There are several ways that you can convert a colour shot into black & white using image manipulation packages like Photoshop. Learning how to convert colour images to black & white is important as you should always shoot in colour, rather than switch your camera to a black & white mode (if it has one). We’d certainly recommend you leave your DSLR set to colour and convert later, rather than set it to its monochrome mode, simply because it’s impossible to later convert the monochrome image back to its original colours. With a colour original you have all options covered. Here we cover the four most popular methods to convert colour to black & white and we’d suggest you give each one a try and choose your favourite. In no time at all, you’ll be a mono master!

1) Desaturate

This is one of the quickest and easiest routes to convert a colour shot and you’ve guessed it, the least favourable! Use the shortcut Cmd/Ctrl+Shift+U or Image>Adjust>Desaturate to remove colour. Alternatively slide the desaturate slider to 0 in the Hue/Saturation dialogue box (Image>Adjustments>Hue/Saturation).

Looking at the Swatch colour chart, all tones are distinctly muddy – especially yellows, which go more mid-grey than light grey. It can be fine for occasional use but spending a little more time and effort using one of the other methods will yield much better results.

2) Greyscale

This is a good starting point for most general shots and we’d recommend using this method most of the time. It’s a much better way forward and quickly gives an interesting high contrast black & white image that often needs little extra work doing to it. Go to Image>Mode>Greyscale to convert to mono.

You can see that the image looks less muddy and that the blues are a little darker. The tonal separation has created an interesting image. From here you can tweak using Curves/Levels, especially if you select areas like skies or backgrounds beforehand.

DESATURATION COMPARISON: The Desaturate method is very quick and easy but, as you can see here, it produces a flat b&w image with muddy tones.

GREYSCALE COMPARISON: Using Greyscale is very easy and usually delivers very good results. Here, there is excellent tonal range and good contrast.
3) RGB channel adjustments

Photoshop uses a Red, Green and Blue channel to create the full spectrum of colours – just like a TV or your camera does.

Open the Channels palette and click on one of the colours and it shows the channel in Greyscale. Each one reveals different tones which together create a colour image. This is how colour photography was first created – by shooting on b&w film through consecutive exposures with a red, green and blue filter. You can choose any channel and then go to Image>Mode>Greyscale and save it as is. Remember to do a Save As and rename the image to preserve the original.

RGB CHANNELS: It’s quite amazing to see how the different channels reproduce the various colours. Shoot a test yourself and study the results.

4) Channel Mixer

Channel Mixer is available for Photoshop CS and Paint Shop Pro but not Elements. This is a more complicated version of the previous technique but can yield some very exciting results if you play around with the sliders for a while.

The results are very similar to using a red, green or blue filter in front of your lens and you can mix the sliders to create an orange or yellow filter effect.

Go to Image>Adjust>Channel Mixer to open the dialogue box. You will have a choice of Red, Green or Blue channels in the Output Channel menu. Now tick the Monochrome box to convert to mono.
The Red channel is a good starting point but check out each before deciding.

You can mix a bit of one channel with another to create new effects. When adjusting the sliders you should aim to keep the combined values of all three sliders to about 100%. For example Red -20%, Green +140% and Blue -20% – some strange effects can be created by ignoring this! The Constant slider acts as a general brightness control. Try boosting colours beforehand by increasing saturation using Hue/Saturation, this will boost contrast significantly in the black & white version. You can even pick a single colour to boost, like Blue from the Edit menu if you like.

CHANNEL MIXER: The Channel Mixer is the most involved and time-consuming method but your efforts will be rewarded with the best results.
100% DSLR EVERY MONTH
With your subscription you’ll get:
✓ 3 issues for £1 to start your subscription
✓ FREE delivery of every issue
✓ SAVE 18% on the shop price
✓ News, reviews and advice, hot-off-the-press

CLAIM TODAY
PHONE
0844 249 0482
ORDER ONLINE
www.dennismags.co.uk/dslr
Using the offer code GO905LBK
OVERSEAS
If you live outside of the UK, please call the number below to find out about our overseas subscription rates:
+44 (0)1795 414 953
Subscribe to *Digital SLR Photography* today and get your first 3 issues for just £1

If you decide that *Digital SLR Photography* is the magazine for you, then your subscription will **save you 18%** on the shop price – that’s just **£3.16 an issue**, instead of £3.90 in the shops! Whether you’re a beginner, enthusiast or a professional, *Digital SLR Photography* is packed with all the essential advice, reviews and tips you need to take your best-ever images!

**Including:**
- Expert tips and tricks
- Easy to follow step-by-step guides
- Essential equipment advice
- Inspirational articles
SEASONAL LANDSCAPES

LANDSCAPES TAKE ON completely different colours and characteristics depending on the season, so make sure to visit your favourite locations at different times of the year.

Winter is many landscape photographers’ favourite time of year. The bare trees mean that the texture of the land itself is fully revealed by the low, raking sun that characterises this time of year. The winter air is clear, and the sun is low enough in the sky to make all-day shooting a possibility. Keep an eye on the weather conditions – a heavy frost or, if you’re really lucky, a hoar frost, can create a fairy-tale scene. Take care with metering – the light tones and reflective nature of a frosty landscape can fool the camera’s meter into underexposure. Snow looks its best under a blue sky, which can be enhanced with a polarising filter.

Spring is characterised by freshness and an abundance of flowers like daffodils, tulips and bluebells. Spring is also the time for showery weather, which experienced landscape photographers love, as the light immediately after a shower passes is often very dramatic, with the sun bursting through and dark, threatening clouds still in the sky.

Summer is the least favourite season for many landscape photographers. For much of the day, the sun is too high in the sky to provide any textural relief on the scene, the land itself is often obscured by dense foliage and there is a lot of dust and haze in the air. However, all is not lost, and there are shots to be found. Although there is less variety of flowers than in spring, those that are around have plenty of colour – poppies and sunflowers, for example, or the heather that starts to appear at the end of summer; the time when straw and hay bales start appearing in fields. These make great subjects, especially as they have become one of the great symbols of the British summer.

Autumn is a dream season to shoot. The sun is relatively low in the sky for much of the day, so you can be out taking pictures for hours. The colours are fantastic, so fill the frame with autumnal oranges, reds and yellows. In early autumn, a clear sky and a cold night will often result in early morning mist-filled valleys, rivers and lakes as the sun appears. Mist can look effective if you shoot into the sun but take care to avoid underexposure by setting +1 exposure compensation.
1) Winter wonderland
A layer of frost adds an instant magical atmosphere to your landscape pictures. You’ll find a wide-angle lens will allow you to fill the frame with the magic of a winter wonderland. The cold weather usually brings a clear blue sky, which complements the crisp, frozen landscape and the pastel colours that can be seen in fields and woodland. Go in low and close with a wide-angle lens and remember to include interest in the foreground.

2) Frozen waterfalls
Partially-frozen waterfalls can make stunning abstract shots. Use a long lens to get close to the base of the fall. Most winter water shots are either flowing water or ice, so include both to add some contrast. A long exposure will soften the water and create a stark division between the static ice and flowing water.

3) Low-lying sun
This kind of image is worth getting up early for. You can capture a similar image at sunset, but you won’t have the added appeal of frost. Polarisers perform well on sunny winter days, mainly because the sun remains relatively low in the sky all day long during winter. As well as deepening blue sky it also takes glare off snow. To get the best results, rotate it slowly while looking through the viewfinder. When using wide-angles, take care not to get unevenly polarised skies.

4) Winter sunsets
Although winter light can be harsh, especially in strong sunshine. winter sunsets can be some of the most spectacular of the year. They tend to be very brief, so make sure that you get to your location early, leaving yourself plenty of time to set up and prepare for your shot.

5) A touch of frost
The best time to take winter scenics is without doubt shortly after sunrise when the landscape is covered with a coating of frost. If you’re willing to wake up early and head into the great outdoors, you could be blessed with a view like this.

ESSENTIALS
Winter clothing
The best method of staying warm and dry is to wear lightweight layers - thermals, followed by a long-sleeved shirt, a lightweight fleece top, a heavier fleece and finally a decent wind/waterproof jacket. Avoid jeans and instead wear cotton trousers. Hat and gloves are a must and sturdy walking boots to keep your feet warm and dry. In long grass, wear waterproof leggings or gaiters.

See page 121 for more clothing advice
POLARISER POWER

The advantage of using a polariser for waterfall shots is that in addition to reducing reflections and glare, it has a filtering effect of about two stops, making it easier to shoot at slower shutter speeds and blur water.
1) Spring flowers
Go in low and close with a wide-angle lens to get maximum impact from flowers as foreground interest. Make sure the flowers are in good condition, once petals start to wither and dis-colour, you’ve missed your chance. Pin-sharp flowers tend to work best, so try to shoot when they are perfectly still. Experiment with moving flowers and slow shutter speeds too, but make the blur effect really obvious.

2) Chasing rainbows
There is no time like spring for shooting rainbows. When you see dark rainclouds hovering above brightly lit landscapes, there’s a good chance that you’ll also see a rainbow. Bracket your shots to give you the best chance of capturing the bands of colour at their best. You could combine these later in Photoshop to create an image with an extended range, which will allow you a greater degree of control over the details, colours and textures of the final image. Finally, a polarising filter will add contrast to the scene, as well as saturating the colours.

3) Bluebell woods
One of Britain’s most popular flowers, bluebells usually flower from early April until the end of May. They are predominantly found in the west of Britain, usually in or around woodland, but can also be found near heath, sea cliffs and even mountain tops. When you’re deep in the woods, shooting with the sun in front of you can create stunning lighting effects, as it allows you to capture the beams of sunlight penetrating the canopy above, projecting rays of light into the image.

4) April showers
Lots of spring showers offer you the chance to capture scenes packed with moody storm clouds, although you will probably find yourself waiting for breaks between the showers. It can be quite tricky to get the exposure right if there is a dark sky with a bright foreground. A weak Neutral Density graduated filter can help even out the exposure across the frame and add mood. We recommend you try a 0.3ND or 0.6ND Graduated filter.

ESSENTIALS

Tripod: Serious landscape photographers don’t set out without a tripod. This will help you with composition, keep the horizon level and reduce the risk of unwanted shake, which could ruin your shots. They’re also useful if you want to try one of our creative techniques.

Polarising filter: Polarising filters are ideal for enhancing detail and saturating colours. For the best results, shoot at 90° to the sun. Make sure you buy a circular and not linear polariser.

5) In-camera effects

ZOOM BURST With your camera on a tripod, set a low ISO rating (eg ISO 100) and a shutter speed of around 1/6sec. Fire the shutter and during the exposure zoom in from the widest setting. Zoom evenly over the exposure time to reduce the risk of a jagged zoom burst. Experiment with shutter speeds to vary the results.

MOTION BLUR This technique works really well with bluebells, and the effect is reminiscent of an impressionist watercolour. To achieve this, mount your DSLR on a tripod with a tilt head. Set an exposure of around one to two seconds and a low ISO rating. Use a remote release (or self-timer) to fire the shutter, and smoothly tilt the tripod head down throughout the exposure.
1) **Blueskies of summer**
We’ve written it before and you’ll certainly read it again. Nothing deepens a blue sky better than a polariser. But don’t overdo it. On a bright day with good light on the foreground, a slightly underexposed (i.e. dark) blue sky can pack plenty of punch. Pure blue skies tend to disappear by mid-morning.

2) **Seaside sunsets**
First of all, if you are visiting the east coast, make that sunsets. There are rare coastal areas that loop back on themselves (Hunstanton in Norfolk enjoys sunsets across The Wash) but make sure you head to your location at the right time! Halos around clouds make the very best sunrises and sunsets. Check the exposure via the histogram to ensure you get it right.

3) **Evening moods**
Evening light stretches very late in summer. The sun hits the horizon at an oblique angle and there is a long afterglow that will produce stunning landscapes long after sunset. Long exposures will capture this soft dreamy time allowing clouds to paint their progress across the sky, emphasising the mood.

4) **Fields of dreams**
Take a break from the ubiquitous rape fields and their powerful yellow energy and find out what else is growing in the area you’re photographing. Lavender fields are appearing across the country, thanks to the plant’s essential oils, said to aid sleep. Keep awake to the possibility of trespassing and don’t be tempted to pick the flowers. In late summer shoot wheat fields in morning or evening light.

5) **Bold colours**
Let’s shake you out of your lavender-induced reverie and shock you between the eyes with strong colours at lunchtime. We just mentioned the yellow rape field under clear blue sky clichés, but it’s still a great shot. These poppies look stunning, contrasting with the green. This shot can work even when the sun is high and the thin cloud softens the light like a great big studio softbox.

---

**ESSENTIALS**

**UV or skylight filter:**
Although we would always recommend fitting a clear filter to your lens to protect the front element, it’s during the summer months that these protective filters will make most difference to your photographs. The ultraviolet filter and the skylight filter both help to remove the haze from summer landscapes. Some film photographers used to fit a gentle warm-up filter to deal with the cool blue cast in shadows on sunny days, but digital technology has made this unnecessary.

See page 57 for more filter advice.
1) Misty mornings
Autumn is a great season for shooting misty scenes, and some areas, such as parts of the New Forest, seem to act as ‘mist traps’, so head out in the early morning to see what the dawn light reveals. Using the long end of a 24-105mm zoom lens, this composition is based around the overlapping shapes of the hills rising out of the mist. A 0.6ND graduated filter helped keep detail in the sky, and a tripod kept everything steady.

2) Nature’s mirror
Use reflections in areas of still water such as ponds and lakes to accentuate the season’s golden colours. A beautiful display of colour is emphasised by the late afternoon sunshine in this image, taken beside a small brook in the New Forest. An ND graduated filter was positioned over the upper half of the image, to achieve a balanced exposure over the whole picture. After converting the Raw image to a TIFF file, the picture was tone-mapped using Photomatix software to help bring out some detail in the darker areas of the scene.

3) Blanket of colour
Research areas renowned for autumn colour, such as Westonbirt Arboretum in Gloucestershire, with its spectacular display of Japanese maples. Here you’ll find colours ranging from bright golds to deep reds. Revisit locations during the season as colours constantly change. Return late season and take advantage of the opportunity to shoot the fallen leaves creating a carpet of colour on the woodland floor.

4) Isolate a single tree
Admit it, you want to climb this tree, don’t you? Its gnarly roots and angle of the trunk and branches provide a perfect lead-in to the scene. The composition takes your eye on a journey that your feet want to follow.

5) Blur water
Only a shutter speed of two seconds or more will blur a woodland stream this much. A long exposure needs a small aperture, giving front-to-back sharpness and the sprinkling of golden leaves adds interest to the moss.

**ESSENTIALS**
**wide-angle zoom:**
A wide-angle zoom lens, such as the Sigma 10-20mm, will allow you to make the most of the majority of autumn picture-making opportunities. On this page, only the misty mornings shot was taken with a telephoto. When the wider end of your “standard” zoom isn’t wide enough, autumn is a good time to open up even more.
See page 106 for more lens advice
Creating autumnal colour

WITH LUKE MARSH In this tutorial we show you how to turn a lush green scene into a misty morning with soft autumnal colour. All from the relative comfort of your desk. There is a hint of diffused light in the original image, around the second curve in the road. This got Luke imagining what the scene might look like with the same bright sunlight but even more mist. Then, using the magic of Photoshop, he made it happen. In this easy-to-follow, step-by-step tutorial you will learn the value of the Adjustment Layer in post-processing, how to adjust Hue/Saturation and Gradient Fill. Luke will show you how to select a section of the tree trunk and then, using layers, create mist that appears to be in front and behind the tree. Photoshop Elements 4.0 was used here, but more recent versions are suitable too.

The best way to alter the hue of an image is with Hue/Saturation through the Adjustment Layers menu. Adjustment layers are good because they allow you to edit and re-edit your image without actually altering the original. So, go to the Adjustment Layer symbol (⊕) in the layers palette (inset) and scroll to Hue/Saturation.

In the Hue/Saturation window I drag the Hue slider left (-), changing the hue of the image. I stop when I reach the desired autumnal mood and click OK. Because this command affects the entire image, certain areas may look a little odd, such as the road. This is where the Adjustment Layer comes in handy.

Selecting the Eraser tool (inset) with a large soft brush, I begin to 'paint' out the areas of the foreground that look odd due to the change in hue, allowing the original image to be seen from beneath. The thumbnail preview in the Layers palette allows me to check my progress, with the erased areas indicated in black (inset).

To create the fog effect, I’ll use a Gradient Adjustment Layer. The gradient will be based on the foreground colour, which by default is black, so to change it to white I click the Switch Foreground Color icon at the base of the tool palette (inset). I select Gradient through the Adjustment Layer (⊕) and name it.

The Gradient Fill window appears and the gradient is previewed live on the image. Click in the Gradient Field and the Gradient Editor opens. You must ensure that Color to Transparent is active, the colour being white as set in step four, then click OK to close and return to the canvas, complete with gradient.

I need another identical gradient to build some depth to the fog effect so I go to Layers-Duplicate Layer, naming the new layer accordingly. I won’t be using the new layer yet so I want to hide it. To do this I click the Layer Visibility icon – note that the eye disappears (inset) to indicate that the layer is no longer visible.
GOLDEN BROWN
There we have it. A five minute autumn walk in the park and I didn’t even leave my seat!

Before moving on, I ensure that the original gradient layer I created is active by clicking on its thumbnail in the Layers palette (inset). With the Polygonal Lasso selected from the tool palette, I draw an accurate selection around the trunk of the foreground tree using Select>Feather at three pixels to soften the selection.

I’m going to use the Brush tool to add some depth to the fog behind the tree so I go Select>Inverse to select the background. I’ll now need a new layer as Adjustment Layers only allow for application of specific tasks, in this case, gradients. I go to Layer>New Layer and with the brush set to 20% opacity, I create denser fog areas.

Back to the Eraser tool, this time with a smaller soft brush and the Opacity to 25%, which allows for a gradual removal and so offers more control. I begin to ‘paint’ out the ‘fog’ from the gradient layer, the polygonal selection ensuring only the trunk is affected, giving the illusion that the tree is in front of the layers of fog.

I use Select>Deselect to remove the trunk selection, then activate a second gradient in the layers palette, clicking the empty box opposite to make it visible. This gives a denser fog effect, which I tone down by setting the opacity to 45%. Using the Eraser with opacity at 35%, I erase creatively to complete the effect.
Karen finds it easy to take beautiful pictures.

Karen, the most wanted holiday photographer of the week.

Nikon D3000

Nikon image quality with 10.2 megapixels and EXPEED image processing • Simple operation with Guide Mode to assist you in adjusting camera settings • 11-point autofocus system for amazingly sharp results • Huge 3.0-inch LCD monitor, in-camera editing functions for fun and creativity after taking the shot • Wide range of high quality NIKKOR lenses to choose from. Welcome to Nikon with the new D-SLR D3000.

2 YEAR WARRANTY

Your 2 year warranty on any camera and lens kit simply register your new Nikon purchase. Call 0800 408 5060 or visit www.nikon.co.uk/register.
LANDSCAPE GEAR

REVISED & UPDATED
THE LATEST KIT & ACCESSORIES ADDED!

ESSENTIAL KIT FOR ALL LEVELS OF PHOTOGRAPHER

EXPERT ADVICE!
THE GEAR YOU NEED TO TAKE YOUR BEST EVER LANDSCAPES
THE NOVICE PHOTOGRAPHER

Screw-in filters
While there is little doubt that square slot-in filter systems make better sense in the long run for keen photographers, when starting out, screw-in filters are very tempting. Without any doubt, the circular polariser should be top of the list, as it’s by far the most useful for shooting landscapes. Check out filters from Hoya, Kodak and Jessops.
Digital SLR & kit lens

ENTRY-LEVEL DSLR OUTFIT

There is a wide choice of entry-level DSLR outfits available for beginners, all priced along with a kit lens (eg 18-55mm) under £500. DSLR kits that we recommend include the following models: Canon EOS 100D, Nikon D3200, Olympus E-450, Pentax K5 and K20D and Sony’s Alpha 380.

Novice photographer

The gear options presented to newcomers to digital SLR photography is nothing short of intimidating. However, to get started, all that is needed is a basic outfit made up of a camera and standard zoom, a decent budget-priced tripod, one or two screen filters and a small bag to hold all this kit, along with some snacks, water, maps etc.

Tripod & head

As you’ll find when you read our review of tripods, the key factors to consider when choosing a tripod is weight and stability. You’ll find several models available for under £130, which provide a very sturdy support for your kit. As you spend more, you find that models provide a couple of extra features but more importantly, they’ll weigh far less.

Additional accessories

While you should look to keep your bag as light as possible, especially if you’re heading outdoors only for a few hours, there are still some accessories that you should consider essential. These include extra memory cards, a lens cloth to keep your optics clean, a map and a mobile phone, for emergency use should you get lost or hurt.

Photographic daypack

If you’re new to photography, it’s very likely that you’ll only have a modest outfit made up of your camera with kit lens (and possibly one other zoom), along with a few other photo accessories, as well as other essentials such as clothing. A £40 photographic daypack with separate sections for kit and other items should prove more than suitable.
THE ENTHUSIAST PHOTOGRAPHER

Enthusiast photographer
A natural consequence of developing a passion for photography is wanting to invest in a more sophisticated DSLR, better optics and more accessories like a light meter and a remote release. This means specialist lenses like a wide-angle zoom, more filters, a better tripod and more accessories.

Clothing
With the early starts and late finishes and adventures that will see you sit through showers, storms and sunshine, you'll need to dress appropriately. A light waterproof jacket like this Fjällräven, plus fleece beneath and sensible walking shoes, like Patagonia's Thatchers, are well worth investing in. Headwear like this Berghaus beanie hat is important, as is keeping hands warm – check out Outdoor Design's mitten gloves.

Photobackpack
The dedicated photographer is likely to want to spend hours outdoors, even when weather conditions aren't good, so a well-made, waterproof pack is essential. And the additional kit means you need extra capacity. Backpacks we recommend checking out include the LowePro Vertex 200AW and Tamrac Expedition 8.

Digital SLR
Enthusiasts with a couple of years experience under their belt will most likely be looking to upgrade from an entry-level model to something more durable and sophisticated. Models worth checking out include the Canon EOS 550D and EOS 50D, Nikon D3000 and D300, Pentax K7 and the Sony Alpha 500.
**Ultra wide-angle zoom**
While the 38-65mm kit lens does a reasonable job, it’s time to upgrade the optics to something better. An ultra wide-angle zoom should be top of your list as they provide a wider field-of-view and sharper results. You might also want to invest in a modestly-priced telephoto zoom for when you want to pick out details in the scene.

**Slot-in filter system**
While screw-in filters are fine if you only have one lens, once you start adding lenses to your system, which most likely have different filter thread sizes, you’ll have to choose between additional screw-in filters or a slot-in system. The latter is the better choice, especially as you’ll want to use ND grads. Check out Cokin’s P system, which is affordable and very good quality.

**Carbon-fibre tripod**
If you’re looking to invest in your first ever decent tripod, it’s worth spending the extra on a lightweight model made from carbon-fibre. While you might think the few hundred grams you’ve saved in weight aren’t worth the extra cost now, once you’ve trekked miles carrying your three-legged beast, you’ll soon change your mind.

**Additional accessories**
As you get more and more into your photography, you’ll find your outfit slowly expand as you buy more and more accessories. A remote release will prove useful when shooting long exposures, you may want to protect maps with a waterproof cover, such as the Aucamp, while a decent light meter like Sekonic’s L-308S, may appeal too.
THE SEMI-PRO/PRO PHOTOGRAPHER

Professional photographer
After years of shooting for a hobby, many enthusiasts find they start to find a market for their images, allowing them to class themselves as a ‘semi-pro’. Others throw themselves into a full-time career as a professional photographer. One thing that’s common for all photographers looking to make money is a wish to invest in top kit.

Clothing
Have a quick chat about clothing with any professional outdoor photographer and you’re left in no doubt as to the importance of waterproof outer layers and layers of warm, breathable inners. Paramo’s Cascada jacket is complemented by its trousers, while warm gloves, thick Berghaus fleece and socks by Bridgedale and quality Berghaus walking boots ensures comfortable days shooting outdoors.

ProSlot-infiltersystem
All pro landscape photographers a decent set of slot-in filters. Most use a 100mm system, which are suitable for use with wide-angle lenses to avoid vignetting. Many use Lee Filters (www.leafilters.com), which offer an excellent range of superb quality filters, including ND grads, colour grads and polarisers.

Prophobobackpack
When most professional outdoor photographers head out to shoot landscapes, they’ll spend a couple of days at least on location, staying at a local B&B, so will need to keep everything they need in one big pack. Therefore they’ll usually own a larger than average backpack with excellent capacity (as well as protection), such as the Lowepro Pro Runner 350AW.
Prodigital SLR & lenses
An inevitable consequence of starting to make money from your photography is the need to upgrade gear. For landscape pros, this means investing in a full-frame DSLR like the Canon 5D Mk II, Nikon D700 or D3, or Sony’s Alpha 900. Larger sensors reveal the inadequacies of budget optics, so lenses will need upgrading too.

Sturdy tripod head
It’s most likely that a pro will already have invested in a carbon fibre tripod while they were a serious enthusiast. Once they’ve invested in a pro DSLR, it’s possible they may upgrade the head for one with a larger platform that can support a heavier DSLR and lens combo.

Digital accessories
Most pros will carry a back-up DSLR in case their main body develops a fault. As well as the ultra-wide zoom, they usually have a fast 70-200mm f/2.8 zoom and a macro lens for close-up details. A personal storage device allows them to back-up images, while a laptop offers the same functionality as well as allowing post-processing on the go. Add lens and sensor cleaning systems, spare batteries and memory cards and more, and they’re well prepared for the job.
Wide-angle lenses

If you’re serious about landscape photography, the first addition you should invest in is a decent wide-angle lens. The exaggerated perspective and wide-angle-of-view that these lenses give allows you to fill the frame with your scene and reveal an incredible amount of detail. When you’re confronted by a beautiful landscape, there is nothing like a wide-angle lens to ensure the whole scene is recorded, from foreground interest through to distant subjects. Experienced landscape photographers have learned how to use the way that wide-angle lenses stretch perspective to their advantage to give images with strong foreground interest and incredible depth. Another reason why wide-angles are wonderful choices for landscapes is because they have an apparent abundance of depth-of-field, even at mid-aperture settings, to produce images with an excellent amount of sharpness. So, now you’re sold on wide-angle lenses, you’ll need to decide which type is best for you.

Understanding focal lengths: Wide-angles

The focal length stated on a lens relates to SLRs using 35mm film and full-frame sensors. If your SLR has an APS-C-sized sensor (most have), then you’re effectively cropping the image and increasing the focal length of the lens (by 1.5x with Nikon, Pentax and Sony; 1.6x with Canon). The chart below shows popular wide-angles and the change in effective focal length.

<table>
<thead>
<tr>
<th>Focal length</th>
<th>DSLRs</th>
<th>Full-frame</th>
<th>APS-H</th>
<th>APS-C</th>
<th>APS-C (Canon)</th>
<th>Four-Thirds (Olympus)</th>
</tr>
</thead>
<tbody>
<tr>
<td>8mm</td>
<td>8mm</td>
<td>10mm</td>
<td>12mm</td>
<td>13mm</td>
<td>16mm</td>
<td></td>
</tr>
<tr>
<td>14mm</td>
<td>14mm</td>
<td>18mm</td>
<td>21mm</td>
<td>22mm</td>
<td>28mm</td>
<td></td>
</tr>
<tr>
<td>16mm</td>
<td>16mm</td>
<td>20mm</td>
<td>24mm</td>
<td>23mm</td>
<td>30mm</td>
<td></td>
</tr>
<tr>
<td>20mm</td>
<td>20mm</td>
<td>26mm</td>
<td>30mm</td>
<td>32mm</td>
<td>40mm</td>
<td></td>
</tr>
<tr>
<td>24mm</td>
<td>24mm</td>
<td>31mm</td>
<td>36mm</td>
<td>38mm</td>
<td>48mm</td>
<td></td>
</tr>
<tr>
<td>28mm</td>
<td>28mm</td>
<td>36mm</td>
<td>42mm</td>
<td>45mm</td>
<td>56mm</td>
<td></td>
</tr>
<tr>
<td>10-17mm</td>
<td>10-17mm</td>
<td>13-22mm</td>
<td>15-25mm</td>
<td>16-27mm</td>
<td>20-34mm</td>
<td></td>
</tr>
<tr>
<td>10-20mm</td>
<td>10-20mm</td>
<td>15-26mm</td>
<td>15-30mm</td>
<td>16-32mm</td>
<td>20-40mm</td>
<td></td>
</tr>
<tr>
<td>10-24mm</td>
<td>10-24mm</td>
<td>15-35mm</td>
<td>15-35mm</td>
<td>16-39mm</td>
<td>20-44mm</td>
<td></td>
</tr>
<tr>
<td>11-16mm</td>
<td>11-16mm</td>
<td>14-23mm</td>
<td>16-27mm</td>
<td>18-29mm</td>
<td>22-36mm</td>
<td></td>
</tr>
<tr>
<td>12-24mm</td>
<td>12-24mm</td>
<td>16-33mm</td>
<td>18-35mm</td>
<td>22-38mm</td>
<td>24-48mm</td>
<td></td>
</tr>
<tr>
<td>16-35mm</td>
<td>16-35mm</td>
<td>21-45mm</td>
<td>24-53mm</td>
<td>26-56mm</td>
<td>32-70mm</td>
<td></td>
</tr>
<tr>
<td>17-35mm</td>
<td>17-35mm</td>
<td>22-45mm</td>
<td>25-53mm</td>
<td>27-56mm</td>
<td>34-70mm</td>
<td></td>
</tr>
<tr>
<td>17-40mm</td>
<td>17-40mm</td>
<td>22-52mm</td>
<td>25-60mm</td>
<td>27-56mm</td>
<td>34-80mm</td>
<td></td>
</tr>
</tbody>
</table>
Choosing a wide-angle lens

If your DSLR was supplied with a ‘standard zoom’ kit lens, such as an 18-55mm, then you’ll already have a lens that is capable of shooting decent wide-angle images. However, its capabilities are restricted, as its field-of-view is not wide enough to really make the most of landscape photography, so while it’s a good enough choice to get started with, you should add a better wide-angle at your first opportunity. You’ll be presented with two main options: a fixed wide-angle lens or a wide-angle zoom. If you want the absolute sharpest possible results, then in theory you want a prime lens, with a 15mm being the best choice if your DSLR has an APS-C sized sensor, or a 20mm or 24mm if you use a full-frame model. While marquee lenses often offer the ultimate optical performance, they’re very expensive and your choice is very limited. If your DSLR uses the smaller APS-C sized sensor, we’d strongly recommend that you steer clear of fixed lenses and instead go for an ultra-wide-angle zoom, as you have far more choice, they’re relatively affordable and they deliver excellent quality.

Advances in optical technology saw the development of high-quality ultra-wide zooms in the late ’90s and the arrival of DSLRs has seen this group of lenses become increasingly popular. That’s no surprise as the range they cover offers incredible versatility in such a small and inexpensive lens. In fact, the ultra-wide-angle zoom is arguably one of the best value lenses you could own. There is a variety of focal lengths available, with those around 11-22mm being the most suitable for DSLRs with an APS-C sized sensor. In truth, all cover a very similar range, although they can be one or two exceptions to note. The Pentax 10-17mm fish-eye offers a 180° angle-of-view at its widest end, so in a sense you’re getting a fish-eye and ultra-wide zoom rolled into one. It’s also worth noting that, unlike most ultra-wide zooms, the Sigma 12-24mm can be used on full-frame and APS-C SLRs. Finally, while 16-28mm lenses are popular with film and full-frame DSLR users, the effective focal length of 24-35mm (26-56mm on a Canon) it covers when used with an APS-C sensor is quite limited, so we’d suggest you avoid it.

So which wide-angle lens should you buy? There’s little doubt that zooms represent superb value for money and you’re spoilt for choice as there aren’t any poor performers in this category. Here we recommend our favourite zooms, all of which will deliver great quality results. While primes offer the ultimate in quality, zooms are better value and deliver excellent results. We’ve stated average street prices at time of publication.

Wide-angle anatomy

1) PETAL HOOD
Ultra-wide angles come supplied with a dedicated hood to avoid vignetting and flare.

2) LARGE, CONCAVE FRONT ELEMENT
The front element normally has a prominent curve, leaving it prone to dust and scratches, so take care to keep it clean.

3) MANUAL FOCUS RING
Normally towards the front of the lens and reasonably wide. You’ll rarely need to use it, as wide-angle lenses have excellent AF.

4) ZOOM RING
These are normally found towards the back of the barrel. Most are wide with a grooved surface to allow you to grip it easily.

5) FOCUS DISTANCE
Many lenses have the focus distance scale marked on the barrel, while some of the more upmarket models have a focus distance window.

6) HYPERFOCAL SCALE
(See inset) This scale allows you to estimate how much of the scene will appear sharp thanks to the depth-of-field created by the choice of aperture that you set.

7) INTERNAL FOCUSING SYSTEM
If you’re planning on using lenses with an internal focusing system, offer the benefit that the front of the lens doesn’t rotate when focusing, so you don’t have to key realigning them.

Fixed or zoom lens?

It’s the age-old question – why buy a fixed lens with only one focal length when a zoom offers so much more versatility? Well, here’s why...

**FIXED (PRIME) WIDE ANGLE LENS**
- Smaller optical design generally means sharper results with better contrast
- Fast maximum aperture gives brighter viewfinder and better low-light capabilities
- Smaller and more compact than a zoom
- Most have a smaller filter thread
- Limited to one focal length
- Relatively expensive

**WIDE ANGLE ZOOM LENS**
- Covers several focal lengths, so you’re spoilt for wide-angle versatility
- At its wide-end, it offers far better coverage than a fixed lens
- Most zooms are optically excellent
- Lots of flexibility at a very good price
- Not as sharp as a fixed lens, especially towards the edges and corners of the frame
- Suffers from more distortion
- Maximum aperture isn’t as fast as fixed lens
- Most have a larger filter thread, so screw-in filters are more expensive

**Zeiss 21mm f/2.8 Distagon**
LENSS CONSTRUCTION: 16 elements in 13 groups
APERTURE RANGE: f/2.8 to f/22
FILTER THREAD: 82mm
DIMENSIONS: 87x95mm
WEIGHT: 650g
FITTINGS: Canon, Nikon and Pentax
WEBSITE: www.robertwhite.co.uk
This is an almost legendary lens for connoisseurs that has only recently become available in Canon, Nikon and Pentax fittings. It’s manual focus only, with a smooth focusing action and it uses a manual aperture ring. The depth-of-field scale is clear and allows for accurate depth-of-field calculations. This is an expensive lens but boasts an exceptional optical performance, resolving an amazing amount of detail. The ultimate choice for quality.

£1,240

**Canon 24mm f/1.4L II USM**
LENSS CONSTRUCTION: 13 elements in 10 groups
APERTURE RANGE: f/1.4 to f/22
FILTER THREAD: 77mm
DIMENSIONS: 83.5 x 86.9mm
WEIGHT: 650g
FITTINGS: Canon only
WEBSITE: www.canon.co.uk
This new addition to the Canon range is designed for pro use, as its price tag suggests. As well as offering an extremely fast aperture, it boosts weather and dust seals to protect it from the elements. Optical quality is superb thanks to the aspherical and UD glass elements, which ensure image sharpness is crisp throughout the frame. A dream lens for those that can afford it, but the Zeiss 21mm f/2.8 Distagon, while manual focus, offers a superior optical performance to the Canon.

£1,400
Nikon AF-S DX12-24mm f/4 ED-IF

LENS CONSTRUCTION: 11 elements in seven groups
APERTURE RANGE: 1/4 to 1/22
FILTER THREAD: 77mm
DIMENSIONS: 82.5 x 90mm
WEIGHT: 485g
FITTINGS: Nikon only
WEBSITE: www.nikon.co.uk

This excellent zoom, for DSLRs with APS-C sensors only, is compact considering the f/4 maximum aperture. It’s partly made of plastic but feels well made. The zoom ring is wide and the focusing ring is adequate with both offering a smooth action. The barrel sports a focusing window and internal focusing. Image quality is very high, delivering very sharp results throughout the range. Chromatic aberration and flare are barely noticeable but slight barrel distortion is evident.

£850

Sigma 10-20mm f/4-5.6 EX DC HSM

LENS CONSTRUCTION: 14 elements in ten groups
APERTURE RANGE: 1/18 to 1/22
FILTER THREAD: 77mm
DIMENSIONS: 83.5 x 81mm
WEIGHT: 470g
FITTINGS: Canon, Nikon, Pentax, Sigma and Sony
WEBSITE: www.sigma-imaging-uk.com

A real favourite with landscape lovers that is as compact as it is cheap. It’s perfectly designed and sharp optics. Like all Sigma EX lenses, it’s very nicely put together and it feels and looks the part. The barrel sports a wide zoom and manual focus rings, both of which have a smooth action. Optics deliver high sharpness and only slight evidence of distortion or aberration. It’s a better choice than the newer 1/3.5 version.

£430

Sigma 12-24mm f/4.5-5.6 EX DG HSM

LENS CONSTRUCTION: 16 elements in 12 groups
APERTURE RANGE: 1/4 to 1/22
FILTER THREAD: Rear gelatin
DIMENSIONS: 87 x 102mm
WEIGHT: 600g
FITTINGS: Canon, Nikon, Pentax, Sigma and Sony
WEBSITE: www.sigma-imaging-uk.com

What’s particularly impressive about Sigma’s 12-24mm is that it’s suitable for use with DSLRs with full-frame as well as APS-C sensors. It’s larger and wider than average, but very well made with smooth zoom and focusing actions. The barrel features a focus window with hyperfocal scale and an integral petal hood to protect from flare. Optical quality is high with good sharpness and low distortion.

£750

Voigtlander 20mm f/3.5 Color Skopar SL II

LENS CONSTRUCTION: Nine elements in six groups
APERTURE RANGE: 1/3.5 to 1/22
FILTER THREAD: 52mm
DIMENSIONS: 63 x 89mm
WEIGHT: 205g
FITTINGS: Nikon and Pentax
WEBSITE: www.robertharding.co.uk

This is one of the most affordable prime lenses on the market and also one of the smallest and lightest, as well as being manual focus only. This last point generally isn’t an issue for landscape photographers. The manual focus action is smooth and the barrel boasts a clear hyperfocal scale that makes achieving a good depth-of-field a breeze, as well as an aperture ring. Optically, this lens is a very good performer with excellent sharpness once stopped down. A great budget prime lens.

£455

Tamron 10-24mm f/3.5-4.5 Di II LD

LENS CONSTRUCTION: 12 elements in nine groups
APERTURE RANGE: 1/3.5 to 1/22
FILTER THREAD: 77mm
DIMENSIONS: 83.2 x 98.5mm
WEIGHT: 600g
FITTINGS: Canon, Nikon, Pentax and Sony
WEBSITE: www.tamron2020.co.uk

Tamron’s 11-18mm zoom has been a popular choice for years but this recent addition, with its extremely wide focal length range, brings even more versatility to wide-angle fans. It’s a compact and lightweight option with good handling and an internal focusing system that will please filter users. Optical quality is very good thanks to the inclusion of aspherical and LD (Low Dispersion) elements and enhanced multi-coatings.

£380
Make the most of your wide-angle lens

WITH ADAM BURTON Wide-angles are the lens of choice for the vast majority of landscape photographers and for very good reason. These lenses allow you to squeeze as much of a location into your viewpoint as is possible and capture a scene absolutely brimming with details and interest. This can work to the advantage of the landscape photographer, particularly when using wide-angles to include foreground subject matter. Interesting foreground subjects will spring to life when captured with a wide-angle lens, quite literally grabbing the viewer’s attention and pulling them in to explore the rest of the picture.

Using wide-angle zooms can be so addictive that you automatically zoom out to the widest setting at every opportunity. But this can have its problems too. Such lenses can be set so wide as to sometimes show up the corners of your equipment (lenses, filters and holders) in the frame, this is known as vignetting. Another problem with using extreme wide-angle lenses is barrel distortion, which shows up in the form of bendy horizons and buildings leaning over.

All this can be avoided by training yourself to set your wide-angle according to your subject matter. If shooting over water, then setting the focal length a few mm’s up from the widest setting will reduce the chances of a bendy horizon. But when shooting mountainous terrain with an already uneven horizon, you can get away with shooting as wide as possible.

As well as focal length, pay attention to the height and the angle from vertical at which you have the camera set up. Trees will lean over when composed from low to the ground, so try setting the camera at head height and you may notice a big difference.

The benefits of a wide-angle lens far outweigh these issues. The impact a wide-angle can bring to your photography is astounding and is the reason why most landscape photographers couldn’t shoot without them.

ABOVE: CHOOSE YOUR FORMAT
My first image was taken in a horizontal format. It may seem natural to shoot landscapes in this orientation, but wide-angle shots can work better when composed vertically. This allows more room for large foreground details while still including lots of sky.

FAR LEFT: DON’T GO TOO WIDE
If you go to the widest end of your zoom, you can suffer not only from barrel distortion, but also vignetting. Barrel distortion will mean that a horizon in the top half of the frame will curve downwards, especially noticeable if you are shooting seascapes. When you notice dark areas appear in the corners of your frame, you are suffering from a spot of vignetting. The wider your focal length the greater chance that the camera will include parts of your kit (e.g., filter holders). Both these problems can be avoided by not taking your lens to its absolute widest setting.

LEFT: GO LOW
The scene could do with something to focus attention on the rockpool. It’s common for many photographers to shoot with the tripod legs fully extended. But a viewpoint closer to the ground dramatically increases the impact of the foreground subject matter and can provide for a more dynamic composition.
**MAXIMISE SHARPNESS**

You shouldn't have a problem ensuring the entire scene is sharp. Set aperture-priority, use a small aperture like f/16. Make sure to set your ISO to a lower value.

---

**FINAL IMAGE**

Wide-angle landscapes are at their most effective when some interesting foreground is featured up close to pull the viewer's eye to the rest of the scene. Don't be afraid to compose so that your foreground is big and bold!
Telephoto zooms

There is no argument that landscape photographers should place a decent wide-angle lens (be it prime or zoom) at the top of their wishlist. However, that’s not to say that there shouldn’t be a little room allocated in the gadget bag for a telezoom. While you’ll predominately be filling the frame with wide-angle vistas, you’ll also find times when a telephoto can prove useful. This will usually be when you want to isolate a specific area or feature within the scene or when you want to create a layering effect through perspective compression (see below). There are a variety of telephoto zooms available but we’d recommend you opt for a focal length of around 55-200mm if you use a DSLR with an APS-C-sized sensor, or a 70-300mm or similar zoom if you have a full-frame DSLR. You’ll find the Tamron 55-200mm f/4-5.6 Di II in particular to be very good value for money, along with Sigma’s 70-300mm f/4-5.6 DG zoom. Both these types of telezooms are also great lenses to have available to fill the frame with any wildlife you may encounter as you roam the countryside.

EXPERT TUTORIAL

Perspective compression

Photographers often talk about using a telephoto to compress perspective, but what does it mean?

WITH MARK BAUER ‘Technically speaking, telephoto lenses don’t “compress perspective”, but practically speaking, you do get a different feeling of perspective from a telephoto shot than a scene captured with a wide-angle lens. Wide-angle lenses seem to open up perspective and make the scene appear larger, whereas telephotos make objects appear closer and more compressed. The static nature of the telephoto images suits the viewer, who is more aware of the overall composition of the image, whereas wide-angle images can seem more dynamic and immersive. The nature of perspective compression in a telephoto image is often confused with the idea of using the lens to exaggerate perspective. In reality, perspective compression is a natural phenomenon that occurs at all focal lengths, but is most pronounced at telephoto lengths. The idea of using telephotos to compress perspective is often misconstrued as an attempt to “compress” the scene, but this is not the case. Telephotos make the scene appear smaller and more distant, creating a sense of depth and perspective in the image.’

28mm

50mm

75mm
IT'S JUST AN ILLUSION!

While telephotos appear to compress perspective, the truth is that they don’t. Majority an area of a shot taken with a wide-angle lens or you'll see that it gives a virtually identical effect!

28-35mm
The apparent distance between the foreground and the castle creates a sense of depth, with the hills and village behind the castle stretching away into the distance.

60-85mm
Even at moderate telephoto settings, the perspective seems much flatter, and the castle seems to loom over the distant hills and the village.

105-200mm
As the focal length increases, perspective seems to flatten out, so that the castle and the hills behind seem to be almost in the same plane.
Choosing the right tripod

FOR LANDSCAPES, A TRIPOD should be viewed as an essential part of your outfit. You will use it using a small aperture setting to maximize depth-of-field, along with a low ISO rating to give the highest quality results, which will result in long shutter speeds. Hand-holding might be feasible with some shots but with a tripod you never need to worry about the shakes. You will also find that by placing the camera on a support, you can spend more time and attention on fine-tuning the framing of the scene to get the best possible composition. You’ll find a huge variety of tripods on offer, so choosing one isn’t straightforward, but there are two key factors to consider. The first is stability – while cheaper models may be tempting, the fact is if a tripod doesn’t provide a stable platform, it fails. So ensure you pick a model that is sturdy enough to keep your camera kit totally still when shooting. The second factor to think about is how much a tripod weighs, which is important as you’ll be carrying it, along with the rest of your gear, for considerable distances. Most tripods are made from aluminium, which is very sturdy and fairly lightweight, although you’re looking at tripods weighing around 2kg or more for decent models. If you want a tripod that’s just as sturdy but lighter, you’ll want to check out tripods made from carbon-fibre; although you’ll have to be prepared to pay a premium for one.

The selection of tripods recommended here have all received the highest ratings in Digital SLR Photography magazine. We’ve chosen examples that cover various price ranges to ensure you find a model that suits your budget. Bear in mind that with the more expensive models, you buy the tripod and the head separately, so you can mix and match to suit your needs. We’ve stated average street prices at time of publication.

Features

1) HEAD: There are various types of tripod head available, from ball and socket to three-way pan and tilt. Some have interchangeable heads. We have tested all the tripods here with three-way pan and tilt heads, which are the most versatile and precise.

2) QUICK RELEASE PLATE: These allow you to quickly attach and detach your DSLR to/from the tripod. All of the tripods in this review have one.

3) LEG LOCKS: Most of the tripods in this test feature ‘clip’ locks, which are easy to use and provide a firm lock.

4) LEG SECTIONS: Tripods with three leg sections or less tend to be the most sturdy, as the more sections you have, the less stable they can become.

5) SPIRIT LEVELS: Useful for landscape photography in particular, many tripods feature built-in spirit levels, but if not, your local photo store should sell one that slots on to your tripod.

6) BAG HOOK: Some tripods have hooks on the central column, from which a bag can be hung, using its weight to add stability to the tripod in windy conditions.

7) TRIPOD FEET: Spikes are good for grip outdoors but will scratch flooring. Rubber feet offer good grip indoors and outside and are the best choice for general use.

Interchangeable tripod heads

Most high-end tripods aren’t supplied with a head. This allows users to choose the preferred legs and a specialist or general-purpose head. The two most common types of heads are as follows:

BALL AND SOCKET: These range from very simple heads with one control to complex units with panoramic locks and gauges, gr-p-locks, and hydraulic ball-locking systems. Usually stronger and quicker to adjust than pan and tilt heads, they allow free movement in all directions. Slipping, used to be a problem, not so much now, though.

THREE-WAY HEADS: Commonly available as pan and tilt heads, these are good for precision work like macro photography, but are great for all types of photography. Fanning gauges, showing the shooting angle, are useful for panoramic shots, although there are specialised heads made for this too. Fluid heads have the smoothest panning motion, making them ideal for sports photographers.

Giotto's MTL9351B + MHS011 head

LENGTH (CLOSED): 64cm
NUMBER OF LEG SECTIONS: 3
HEIGHT (LEGS EXTENDED): 165cm
TYPE OF HEAD: Three-way pan and tilt
WEIGHT: 2.1kg
WEBSITE: www.daymen.co.uk

The Giotto's has very solid aluminium legs with foam insulators, to keep your hands from freezing to them on cold days. The nuts and locks are a combination of plastic and die-cast aluminium, and as solid as could be hoped for at this price. The three-way head is equally controllable and features three spirit levels in addition to the one on the legs, so there’s no excuse for wonky horizons! It has a lockable rotational central column, which can be removed and re-inserted horizontally or inverted for macro or copy work. The tripod is very sturdy for the price, and comes with its own tool kit in case you need to make any adjustments. There is also a hidden bag hook underneath the central column. The MTL9351B had only problems coping with our test camera (Nikon D30) and would provide a very suitable platform on which the amateur landscape photographer could mount his DSLR.

Giotto's MTL3361B + MH15001 head

LENGTH (CLOSED): 64cm
HEIGHT (LEGS EXTENDED): 165cm
NUMBER OF LEG SECTIONS: 3
MAXIMUM LOAD: 8kg
WEIGHT: 3.9kg
WEBSITE: www.daymen.co.uk

The build quality of the Giotto's is very good. It’s heavy, but very solid. The thick aluminium legs offer good stability, even in strong winds. The joints and locks are built to a high quality, and come with a tool kit should they need adjusting. At its maximum height with the central column extended, it still feels stable, and kept our test camera very steady. The tripod has rubber feet, which are slightly pointy, making it perfect for beaches and fields, but it takes a bit longer to stabilise on tarmac or hard surfaces; although once it is set up, it is perfectly steady. The central column can be removed and replaced horizontally, which, when combined with the three-position lockable legs (and they open really wide), allows the camera to get down really low for macro work. With this head fitted, there are three spirit levels to keep your shots straight, and panning a breeze. There is also a bag hook.
<table>
<thead>
<tr>
<th>Equipment</th>
<th>Tripods</th>
<th>Page 115</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Giottos MT8246B + MH1302: 652head</strong></td>
<td>LENGTH (CLOSED): 65cm</td>
<td><strong>£240</strong></td>
</tr>
<tr>
<td>HEIGHT (LEGS EXTENDED): 148cm</td>
<td>NUMBER OF LEG SECTIONS: 4</td>
<td><strong>£250</strong></td>
</tr>
<tr>
<td>MAXIMUM LOAD: 3kg</td>
<td>WEIGHT: 1.579kg</td>
<td><strong>£180</strong></td>
</tr>
<tr>
<td>WEBSITE: <a href="http://www.daymen.co.uk">www.daymen.co.uk</a></td>
<td><strong>£225</strong></td>
<td><strong>£110</strong></td>
</tr>
<tr>
<td>This tripod is exceptionally light, especially for its size, yet it is sturdy, although the maximum load may prove restrictive for some. The rubberised twist locks are secure and comfortable to use and foam leg grips give a comfortable grip in cold weather. The three-position angle locks ensure that the legs don’t slip, which is reassuring to those using expensive kit. The central column is reversible for low level and macro shots, and has a bag hook. The ball and socket head is also very secure, and it is easy to manoeuvre the head into just about any position. It has a variable friction control, allowing the user a great deal of control, which means that precision adjustments are quick and easy to implement. The three spirit levels help to ensure that horizontals and verticals are perfectly aligned, making this a great all-round tripod for almost any type of photography, not least landscapes.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

| **Manfrotto 190XPROB + 464RC2head** | LENGTH (CLOSED): 58cm | **£240** |
| HEIGHT (LEGS EXTENDED): 148cm | NUMBER OF LEG SECTIONS: 3 | **£250** |
| MAXIMUM LOAD: 3kg | WEIGHT: 1.139kg | **£180** |
| WEBSITE: www.bogenimaging.co.uk | **£225** | **£110** |
| This Manfrotto is exceptionally light, and its sleek design looks fantastic. Despite its thin legs, it was sturdy and supported our test camera with ease. The twist locks are very strong and prove quick to use. The central column can be raised and moved into horizontal position without removing it from the legs, making the tripod perfect for macro and low level shots, and very easy to use. The multi-position leg locks have a depressable button, making them much easier and nicer to use than those that have clips that must be lifted. The ball and socket head is very smooth and easy to use, as one switch controls everything. This is ideal for quick positioning, but not as precise as some of the other heads in the test. There is a spirit level, to ensure that your tripod is level, and the centre column boasts a bag hook, allowing extra weight to be attached for stability in high winds. |

| **Velbon Sherpa 435 with PHD-41Q head** | LENGTH (CLOSED): 53cm | **£240** |
| HEIGHT (OPEN): 136cm | NUMBER OF LEG SECTIONS: 3 | **£250** |
| MAXIMUM LOAD: 3kg | WEIGHT: 1.43kg | **£180** |
| MAX LOAD: 3kg | WEBSITE: www.introt2020.co.uk | **£225** |
| At the more affordable end of the market is this combined head and legs set from Velbon. The tripod’s black aluminium legs have three sections, locked in place with easy-to-open clip-style locks. The centre column is adjustable and available for low-angle shooting. For an entry level model, the PHD-41Q head is a good buy too. It’s bigger and more sturdy than others in this bracket and will take loads of up to 3kg with no problem. We like the head’s relative simplicity: using it quickly becomes second nature. Two padded handles control movement, and one of these unscrews and fits inside the other when the tripod is stored. A well-designed quick-release plate complements the package. This is a cracking buy for the beginner or intermediate photographer who wants a general purpose tripod to improve their images and open more options. |

| **Manfrotto 055XPROB + 322RC2 head** | LENGTH (CLOSED): 65.5cm | **£240** |
| HEIGHT (LEGS EXTENDED): 178.5cm | NUMBER OF LEG SECTIONS: 3 | **£250** |
| MAXIMUM LOAD: 7kg | WEIGHT: 3.3kg | **£180** |
| WEBSITE: www.bogenimaging.co.uk | **£225** | **£110** |
| The build quality of this die-cast aluminium tripod is excellent. It is sturdy, and very reassuring. The 055XPROB features the same dual positioning central column as the 190XPROB, as well as a spirit level, bag hook and foam leg grips, which help to protect the user’s hands when using the tripod in cold weather. The legs each have a four-position lock, which makes it versatile and secure. You’ll either love or hate the trigger-style grip head, but we found it incredibly quick and easy to adjust, getting your camera into just the right position with the minimum of fuss. Not having to tighten screws also saves time, and reduces the risk of knocking the head out of place. The head has its own spirit level, allowing you to make sure that your camera is level. This head is particularly useful when combined with the versatility of the central column of the tripod and when shooting macro. |

| **Slik Pro 700DX with 700DX pan & tilt head** | LENGTH (CLOSED): 76cm | **£240** |
| HEIGHT (LEGS EXTENDED): 190cm | NUMBER OF LEG SECTIONS: 3 | **£250** |
| MAXIMUM LOAD: 6.5kg | WEIGHT: 3.9kg | **£180** |
| WEBSITE: www.introt2020.co.uk | **£225** | **£110** |
| The largest tripod in this category is very sturdy and feels as though it could withstand any treatment. The design is simple but stylish, and it certainly looks like a tripod for serious use. Although it is quite heavy, it is still very portable for its size. The legs are strong and secure, yet easy to open, while the reversible central column allows users to take low level and macro shots with ease. This is particularly effective when used with the legs open wide, which can be done easily using the three-position locks, which hold them firmly in position. The pan and tilt head features a panning lock, and has a very smooth panning motion. The quick release plate is circular, which makes it very easy to attach and detach the camera. There are two spirit levels, which help to keep horizontals and verticals straight. Although there is no bag hook, the tripod is so sturdy you are unlikely to miss it. |
Gadget bags and backpacks

YOUR MAIN CONSIDERATIONS should be how much kit can it hold and whether to go for a bag that hangs on the shoulder or a backpack. Most outdoor photographers prefer backpacks as they distribute weight over your shoulders and back, making it easier to carry gear over long distances. The daypack holds photo gear in the bottom section and general items in the top compartment, while dedicated photo backpacks are designed with larger kits in mind. Consider the following:

Comfort: As you carry more kit, the weight increases, so shoulder straps are important. The more padded they are, the less they dig into your shoulders. Waist straps are useful, as they relieve tension from the lumbar region and help keep your back straight. Another important factor is the bag’s frame. Some are sturdier than others, which may seem uncomfortable at first, but can help keep your back straight on long treks.

Capacity: Think about how much kit you plan to carry. This will ultimately determine the size of bag you need. All the bags in this test have adjustable compartments, so they are quite versatile. We also list internal dimensions, so you can see exactly how much space they offer.

Features (see panel below): Some photographers just want a bag with lots of space, others are more demanding over specific features. Most have front pockets, designed to help you organise your memory cards and batteries into used and unused. Many of the bags have water bottle holders, tripod clips or pouches and rain covers.

Build Quality: How well the backpack is put together, including the stitching, zippers, and weatherproofing, determines how long it ought to last, how strong it is and how well it protects your equipment.

Price: We’ve stated average street prices at time of publication.

Features

1) STRAPS Check to see if the straps are adjustable, padded and wide to stop them from cutting into your shoulders on long journeys. Also look for waist straps.

2) PADDING Some bags have pressure pads on the back, which take a lot of the strain out of long journeys and spread the weight of the gear over a larger area.

3) STORAGE/CAPACITY Does the bag hold all the equipment you will need for your photography? If there is too much empty space, the bag will be unbalanced, which can be bad for your back. All the bags in this test feature adjustable dividers and offer quite a bit of versatility.

4) WEATHERPROOFING/RAIN COVER Most bags are weather resistant. Some are weather proof and others have all-weather covers that can be pulled out from a hidden compartment, usually on the base.

5) LAPTOP COMPARTMENT Make sure that the laptop compartment is big enough for your computer, as they vary in size. The padding is also important here.

6) ACCESSORY CLIPS Some bags allow you to add further bags, tripods and monopods, but some are only compatible with the manufacturer’s own clip systems.

7) ZIPS If you go out a lot in bad weather or near water, make sure that the zips are up to it. Wildlife photographers should also consider the condition made by the zips, as animals can be easily frightened off.

Camera Armor Seattle Sling

WEIGHT: 1.2kg
DIMENSIONS (OUTER): 370x240x215mm
DIMENSIONS (INNER): 270x140x230mm
WEBSITE: www.daymen.co.uk

The Seattle Sling strap is placed over the shoulder to hang the bag on the back, which means weight is better distributed. It has no zippers – the main flap features a large Velcro-type fastener. Inside is the bright orange nylon inner dry bag, which provides protection against water, dust and sand. The seal has magnetic strips and is rolled over three times before being secured by clips (outside the bag) to keep it firmly sealed. The interior compartment has padded, movable dividers. It is a bag designed to hold a small to medium-sized outfit – a central area is large enough to hold a standard DSLR with kit lens. Four smaller compartments hold lenses or accessories. There aren’t any pockets on the outside, so small accessories will need to be stored in this area too.

£110

Lowepro Classified 250 AW

WEIGHT: 1.9kg
DIMENSIONS (OUTER): 465x380x355mm
DIMENSIONS (INNER): 380x360x280mm
WEBSITE: www.daymen.com

A discreet camera bag with room for lots of camera gear as well as a laptop. The interior of the bag is very deep, so you can double-up on storage by stacking items on top of each other. The bag’s depth also makes it very suitable for cameras with long lenses. A padded section provides storage for a 15in laptop. Leather is used to good effect throughout the bag and the grab handles and shoulder strap are very well designed. Entry into the main section of the bag is through a clever roof zip set-up that is easy to access on the move and is protected by the handle buckling over it. Realistically, you’ll be able to fit at least two DSLRs with an additional two or three lenses in the spacious main section. A luggage sleeve means that you can attach the Classified 250 AW to the handles of a wheeled case. The bag is hand-luggage friendly too.

£115
Tamrac Expedition 8
WEIGHT: 3.38kg
DIMENSIONS (OUTER): 330x560x340mm
DIMENSIONS (INNER): 280x250x160mm
WEBSITE: www.intro20.co.uk

Despite its large size, this imperceptibly made bag is comfortable, even when fully laden. The soft pads disperse pressure across the back and the straps are secure and easily adjustable. The Expedition 8 has space for a pro DSLR body with a large telephoto zoom, as well as seven other lenses, two spare camera bodies and two flashes. There is also copious space for accessories with spent batteries and full memory cards down one side, full batteries and new cards down the other. Red tags indicate used or fresh. There is a wide range of accessories that can be clipped on either to the straps of the bag or the bag itself. The padding is where the bag really shines, and the pockets for the camera and lenses are well thought out. The compact size and the wide range of accessories make this a great choice for the professional photographer.

£140

Tamrac Adventure 6
WEIGHT: 0.88kg
DIMENSIONS (OUTER): 290x220x190mm
DIMENSIONS (INNER): 240x130x140mm
WEBSITE: www.intro20.co.uk

As a day or travel bag, this is a nice size for the amateur or snapper and, priced at just £50, it’s a great buy. Like most day sacks, it is divided into two main sections: the top compartment is like a normal bag, for storing maps, a packed lunch or a camera, though you’d struggle to squeeze a thick jacket. The bottom part is set up for photo gear and divided by removable pads. It’s quite a light fit for a DSLR and three lenses, though it is big enough for a camera with a standard lens and one compact zoom lens – ideal light travel kit. If you needed to carry more, you could always store chargers and a flashgun in the main compartment. The front pocket is also large enough for memory cards and batteries. The straps include the full waist and chest support but lack any padding around the waist, while the shoulder straps are quite thin, though the back of the bag has decent padding.

£40

Lowepro Fastpack 350
WEIGHT: 1.83kg
DIMENSIONS (OUTER): 315x245x89mm
DIMENSIONS (INNER): 280x210x270mm
WEBSITE: www.lowepro.com

Fastpack is designed for the multimedia snapper. The lower storage section is a ‘Slingshot’ design that allows you to quickly access your camera without fully opening the bag. There’s room for three or four lenses plus accessories and even a pro DSLR. The dividers are all modular too, so you can arrange them to suit your kit. The top section is designed as a normal day bag, plenty of space for clothing or equipment. The larger body of this bag also allows it to house a 15” laptop in a padded zipped section. There are additional pockets on the front for storing smaller items, while inside the bottom section are pockets for memory cards. The shoulder straps and back support are well padded and there are chest and waist straps for extra support. The bag is made from a tough, water-resistant fabric, though there’s no weatherproofing on the zips.

£70

Lowepro Vertex 200 AW
WEIGHT: 3.3kg
DIMENSIONS (OUTER): 320x260x70mm
DIMENSIONS (INNER): 300x260x40mm
WEBSITE: www.thelowepro.com

The Vertex can withstand rough handling and serious conditions. The main section is very spacious, with over a dozen compartments separated by adjustable, padded walls. There is plenty of room to fit a couple of cameras, six lenses and a spare compact zoom lens – ideal light travel kit. If you needed to carry more, you could always store chargers and a flashgun in the main compartment. The front pocket is also large enough for memory cards and small accessories such as you may need fast access to. Other features worth mentioning are the carry strap at the top, side pockets and the all-weather cover.

£115

Crumpler Pretty Boy backpack
WEIGHT: 0.9kg
DIMENSIONS (OUTER): 370x480x220mm
DIMENSIONS (INNER): 290x380x180mm
WEBSITE: www.intro20.co.uk

The Pretty Boy’s shell-like construction has the fresh look that Crumpler is famous for and is available in a variety of colours. Inside, it follows the normal day-sack set up – the top section is fairly large, while the bottom section is set up perfectly for a DSLR, a couple of lenses and accessories. Also, as the zips open straight across, you can access the bag from either side. The shoulder straps are wide, while the back support is well padded, but it lacks the waist and chest straps. While the fabric is thick and water-resistant, there’s no weatherproofing on the zips or fold out cover.

£90

Lowepro Pro Runner 350 AW
WEIGHT: 2.7kg
DIMENSIONS (OUTER): 330x260x455mm
DIMENSIONS (INNER): 285x150x385mm
WEBSITE: www.lowepro.com

If you’re planning a lengthy trip and need to carry a large photo outfit as well as a laptop and other accessories, then the Pro Runner, a recent replacement for the popular Gitzo, is definitely one that you should consider. Capable of holding two to three DSLRs, plus several lenses, the Pro Runner is a big bag that has been designed to offer a high level of protection to your kit. It’s one of the toughest and most rugged bags in this price bracket. In fact, the Lowepro’s standard feature is not only the level of padding it offers to your equipment but also how it’s designed to sit on your back. When fully laden backpacks can cause strain on your back, but the Lowepro’s enhanced lumbar padding will ensure your vertebrae remain ache-free. If you need a spacious bag, then make sure to check out this new backpack.

£140
TAMRON 18-270mm
f/3.5-6.3 Di II VC LD Aspherical (IF) Macro

Portraits

Few subjects are as popular or as challenging to photograph as people. Most people feel self-conscious and awkward when a lens is pointed in their direction, so achieving natural-looking portraits is far from easy.

Good communication is vital for a portrait photographer to help your subject feel comfortable and at ease. Lens focal length is another key factor, and the lens you use will dictate the feel of the image. A wide-angle lens can create an impression of space, solitude or scale, while a telephoto lens will isolate your subject from their surroundings and allow you to work from a distance. By taking pictures from further away, your subject will be less aware of the camera and therefore will act and behave more naturally.

Different focal lengths can create very different perspectives. However, when shooting portraits, you don’t want to waste valuable time by constantly switching lenses. With Tamron’s 18-270mm zoom, you don’t have to. Few optics can rival the versatility of Tamron’s AF 18-270mm f/3.5-6.3 Di II VC LD Aspherical (IF). The world’s first lens to deliver a zoom ratio of 1.5x, it covers wide-angle to telephoto and has a range equivalent to 35mm terms to around 80-405mm when attached to a DSLR with an APS-C sensor. It is a ‘one-lens does all’ zoom, allowing you to quickly adapt to any shooting situation. This can make the difference between success and failure when photographing people, particularly children. Kids have a tendency to do anything apart from what you want them to do, so when you try to take their photo. However, using the telephoto end of the 18-270mm, you can shoot from a distance and capture those magical and genuine expressions, and shoot frame-filling portraits, bursting with mood and energy.

Of course, some children love having their photo taken. If you know a child that’s happy to pose, try using a shorter focal length. The widest setting of the 18-270mm allows you to capture dynamic-looking portraits, full of depth, life and fun.

When photographing people, lens selection really is important. In order to react to your subject’s movements, you will often want to shoot handheld when photographing people, which makes image stabilization technology vital.

The Tamron 18-270mm is equipped with a highly effective Vibration Compensation (VC) mechanism. This tri-axial anti-shake system helps ensure sharp handheld images, even at the zoom’s longest telephoto setting.

Despite its impressive focal range and technology, this lens is compact and lightweight, and its handling is intuitive. It zips quickly and quietly into focus when using AF, and with a maximum magnification of 1:3.5. It’s also useful for isolating detail and interest.

With its impressive zoom ratio, this lens is a lens suited to practically any subject, including landscape, action or wildlife photography. However, photographers wishing to take images of people – either commercially or to capture professional-looking images of friends or family – are sure to be impressed with the quality and versatility of the Tamron 18-270mm.

SPECIFICATIONS

- Construction: 18 elements in 13 groups
- Maximum aperture: f/3.5-6.3
- Minimum aperture: f/22
- Minimum focus: 60cm
- Maximum magnification: 1:3.5
- Filter thread: 72mm
- Angle of view: 78° 33' to 9° 55'
- Diameter x length: 79 x 80.1mm
- Weight: 850g
- AF fittings: Canon EF and Nikon F
- Supplied accessory: Petal-shaped lens hood
Essential accessories

CHOOSING WHAT YOU NEED to take with you or leave behind isn’t easy. You have to balance the fact that you don’t want to be walking around with a heavy load with that of not wanting to discover miles from your base that you’re missing a vital piece of kit. Here we run through the items that make up a shortlist of accessories to consider.

1) NAVIGATIONAL AIDS There are a number of useful tools available to make sure you head in the right direction. A simple compass and an Ordnance Survey map are the basic requirements – both are available from high street camping shops. If you use a map, we’d recommend a waterproof casing, such as the Aquamount case from Outdoor Designs (www.outdoordesigns.co.uk). Handheld GPS units have become far more commonplace and if you’re serious about your outdoor photography, one that we’ve found to deliver a superb performance is the Active 10 by SatMap (www.satmap.com). It’s expensive at around £295 but is incredibly accurate and is preloaded with maps for the whole of the UK, with additional maps available on SD cards. If you’re keen on shooting sunrises and sunsets, there are a number of sun compasses that do a great job, from the credit-card sized £3 Deposi card by Blue Pond (www.bluepondimages.com) to the £20 Flight Logistics (www.flight-logistics.com).

2) MEMORY CARDS The price of memory cards has fallen to such a low that there is little excuse for not having a small collection of them in your bag. In terms of capacity, we recommend going for a set of two to six 4GB cards, depending on the length of your trip. Choose from a reputable brand like Lexar or SanDisk to minimise the risk of a card developing a fault and losing any images stored on it.

3) LENS HOOD As well as preventing flare from the sun, which can ruin picture quality, a lens hood also provides suitable protection for your lens in the rain, so leave it fitted all the time. Watch out for vignetting on ultra wide-angle lenses.

4) REMOTE RELEASES Long exposures mean camera shake is a real problem. Using an electronic remote release helps minimise camera movement when firing the shutter. The type you’ll need depends on the DSLR you own, so check your instruction book or the manufacturer’s website. Prices start at around £20 for a basic remote.

5) PERSONAL STORAGE DEVICE If you plan a trip running any longer than a weekend, you’ll most likely need some form of image backup. A memory card reader is the ideal choice if you want to quickly transfer your images while away, but for most, a personal storage device is a better option. Choose a model with a large LCD monitor so that you can review and edit images. The Jobo Giga Vu Evolution and Extreme models are excellent, but our favourite is the 80Gb Epson P-8000, which has slots for SD and CompactFlash cards and a bright, sharp 4in screen.

6) CLEANING KIT Keep one or even two lens cloths in your gadget bag. As well as being perfect for cleaning dirt marks and dust from your lens surfaces, they’re also ideal to wipe away raindrops. Two cloths allow you to use one just for moisture and heavy soiling.

7) HOTSHOE SPIRIT LEVEL Avoiding uneven horizons is relatively easy. Use a tripod with an integral spirit level or slip a cheap and cheerful spirit level onto your hotshoe. Alternatively, buy a Seculine Action Level (www.intro2020.co.uk) and use its colour LEDs and audible beeps to help you straighten up your camera.

8) LIGHT METER For perfect exposures, you can’t beat the precision of a hand-held meter. While your camera’s integral meter is very accurate, many pros still swear by the extra versatility and precision given by a hand-held meter. For those looking for absolute reassurance, we’d recommend the Sekonic L-308S, which is the latest version of the landscape’s favourite. Small, accurate and easy to use, this tidy little number represents excellent value for money at £130.

9) SPARE BATTERIES Make sure you take your charger away with you and charge your batteries the night before. If you can, carry a spare set with you. If your DSLR uses a lithium-ion cell, as well as the branded battery, there are various third party options too. Ask your dealer or check the classifieds and dealer ads in Digital SLR Photography magazine for details. If your DSLR uses AA batteries, you’ll find rechargeables from the likes of Energizer are superb, as is the new range of Eneloop batteries from Sanyo (www.intro2020.co.uk).

10) SAFETY PACK It’s worth keeping a small selection of high-energy snack bars in your kitbag to keep you going between meal times or in an emergency. You should also pack a whistle and a torch just in case you get lost or have an accident while on your own. If you’re heading to isolated areas, make sure you take your mobile phone and ensure it is fully charged before you leave. Always tell someone your plans.
TRY 3 ISSUES FOR £1
And stay ahead of the latest developments in the world of IT

Inside PC Pro:
- Real world computing advice from IT consultants
- The UK’s most trusted group product tests
- In-depth news analysis and opinion
- Hands on advice to get more from your PC
- DVD packed with full programs and trial software

ORDER ONLINE TODAY AT www.dennismags.co.uk/pcpro
OR CALL 0844 844 0083
quoting offer code G1007DP4
Clothing accessories

DEDICATED OUTDOOR PHOTOGRAPHERS are often shooting from before dawn until after dusk and you’ll find them dressed accordingly. As well as thick clothing to deal with cold temperatures and high winds, you should also consider breathable garments to allow perspiration to evaporate in the heat and comfortable footwear that can handle hours of trudging along green countryside, rocky mountains and wet bogs. Ensure you’re protected from the elements by following our guide to the best.

1) KEEP YOUR HEAD WARM WITH A BEANIE HAT! You lose close to a third of your body heat through your head and so it’s important to wear a hat or cap in cold conditions. While baseball caps are OK, their peak will get in the way when you hold the camera to your eye. You can always spin it round but maybe opt for a beanie hat instead, which will help keep your head warm and won’t take up much space when you take it off. You’ll find them available in plain or patterned designs to suit your fashion sense (or lack of it!).

2) KEEP YOUR FINGERS NIMBLE! Cold winds can really freeze up your fingers and make it more difficult to press buttons and tweak controls on your DSLR. The easiest solution is to wear gloves, although standard types are quite thick and still make it difficult to operate your camera. Our favourites are both made by Outdoor Designs (www.outdoordesigns.co.uk) and are well worth trying out. The Takustretch has a grip palm and is made from wind-resistant materials to keep your hands warm. Better still is the Kenagrip convertible, a windproof fleece glove with leather grip palm and flip-over finger mitt.

3) WEAR GOOD FOOTWEAR! You’re more than likely going to cover miles in pursuit of stunning landscapes, so your average trainers aren’t the best choice. Depending on how far you plan to walk, the type of terrain and time of year, you should look to wear shoes that are comfortable, hard-wearing and practical. Walking boots are best for serious treks and the likes of the £90 Berghaus Explorer (www.berghaus.com) are ideal, offering comfort, durability and support. You’ll find them available for men and women in various colours. Another great option is Patagonia’s Thatcher hiking shoes (www.patagonia.com), which are extremely comfortable and lightweight and incredibly durable. They’re fashionable too and very well priced at around £60.

4) DON’T FORGET YOUR SOCKS! Cold or wet feet make walking around a real misery, as can wearing too thick a sock in warmer conditions. It’s worth buying a couple of pairs of decent socks to suit the season and type of shoe you wear. Bridgedale (www.bridgedale.com) are leaders in this department, offering socks to suit cold weather, light treks or longer walks where comfort is essential. They’re a wiser choice than others, but we’d recommend the Endurance Trekker and Comfort Trekker for longer walks, and the lightweight Bamboo Crew in warmer weather.

5) KEEP YOUR BODY WARM AND DRY! The humble fleece is an unsung hero in outdoor clothing, proving relatively lightweight, incredibly warm and very hard-wearing. They’re also available in various designs and colours too, so are as fashionable as they are practical. You’ll find all high street fashion stores stock their own brands, but we’d really recommend you check out those from outdoor specialists like Patagonia. Paramo and Berghaus as they’re generally made from better quality materials. In cold weather the general rule is wear one or two thinner layers as opposed to one thick layer as the air between each layer is warmed up. So a fleece top with an outer fleece is a good option to consider. If it’s especially cold or windy, a waterproof jacket adds an extra layer of protection. For this guide, we tried out a number of fleeces and found the Patagonia R1 Pullover and Berghaus Araca to be excellent choices as a fleece top. The Berghaus Aura is a decent choice as an outer layer, while we found when shooting by the coast that Paramo’s Pajaro and Cascada offered superb protection from the wind and sea-spray and are well worth investing in, incidentally, when choosing colours, bear in mind right reds are great for visibility, so perfect when heading to remote locations, but not such a good choice if you ever plan on stalking wildlife.

6) PROTECT YOUR LEGS! In truth, few amateur photographers head outdoors in anything other than a pair of jeans and while they’re comfortable, they’re not ideal when the going gets wet. If the weather is unpredictable or you know you’ll be shooting near the coast, consider a pair of waterproof trousers. Again, outdoor specialists are best, with Paramo’s Cascada trousers generally considered to be one of the best.
SanDisk Extreme®
The Memory for Professionals

As a photographer, you've carefully chosen your camera, lenses and kit, but have you chosen the right memory to get the most out of it?

You need speed and performance. SanDisk Extreme memory cards deliver unrivalled speed you can shoot faster to capture the shots that others miss - the key moment in the game, the instant the world changes.

Faster shooting is just the beginning. More speed means quicker workflow. Take less time to run through your shots - and they are on the picture editor's desk while other photographers are still downloading theirs.

But performance means reliability as well as speed. SanDisk Extreme is built to perform in challenging environments. Desert heat, jungle humidity, arctic cold, shock and vibration; in conditions beyond those you can stand, your SanDisk memory keeps on working and keeping your images safe.

And with industry leading capacities, SanDisk Extreme will see you through the longest, most demanding assignments. Take all the shots you need - thousands of images, even with RAW formats - even on remote location shoots.

SanDisk Extreme memory is the choice of professionals around the world. Shouldn’t you go to the extreme?

www.SanDisk.co.uk

* Subject to stock availability. 1 gigabyte (GB) = 1 billion bytes. Speeds based on SanDisk internal testing. SanDisk, the SanDisk logo, SanDisk Extreme and CompactFlash are trademarks of SanDisk Corporation, registered in the US and other countries. SDHC and the SDHC logo are trademarks. Memory Stick PRO Duo mark and logo is a trademark and registered trademark of Sony Corporation. Other brand names mentioned herein are for identification purposes only and may be trademarks of their respective holder(s). Information correct as of April 2009 © 2009 SanDisk Corporation. All rights reserved.
LOCATION GUIDE

YOUR EXPERT GUIDE TO 40 OF THE UK'S MOST STUNNING LOCATIONS

REVISED & UPDATED
FANTASTIC NEW UK LOCATIONS ADDED!

INSIDE! WHERE TO TAKE GREAT LANDSCAPES WITH YOUR DSLR TODAY!
Northern England

Yorkshire Dales
North Yorkshire

Above: Sunburst on a lone tree at Malham, an area providing incredible photo potential.
Right: Bolton Abbey in Wharfedale, Yorkshire Dales National Park, is open every day.

LOCATED: North Yorkshire and Cumbria
GETTING THERE: The Yorkshire Dales are bordered by major trunk roads and easily accessible by car, with the M6 skirting the west, the A66 to the north, the A1 to the east, and the M65, A65 and A59 to the south.
O/S REF: SD875869 WEB: www.yorkshiredales.org

COVERING AN AREA OF 680 square miles, this National Park is located in the north of England, and straddles the central Pennines in the counties of North Yorkshire and Cumbria.

The Dales landscape is one of great variety. In the valleys, the network of dry stone walls and hay meadows show the impact centuries of farming have had on this landscape.

The limestone is famous for its stunning ‘pavements’ or scars – plateaux of bare and weathered rock that provide perfect foreground interest and lead-in lines. Deep crevasses have developed in the rock to create a mosaic of interlocking ‘clints’ and ‘grykes’. Illuminated by low, warm sunlight, they create stunning scenic images. Visit places like Malham Cove, White Scars near Ingleton, the plateau of Moughton near Austwick and waterfalls such as High Force at Teesdale in the north.

Photographers shouldn’t overlook the Dales’ popular riverside beauty spots, such as Bolton Abbey in Wharfedale and Aysgarth Falls in Wensleydale. Try some cheese, Gravetye!
Northern England

Embleton Bay
Northumberland

Below: Sunset doesn’t have to be over the sea at Embleton Bay. Here it lights the castle.

LOCATED: Northumberland  GETTING THERE: From the A1 between Newcastle and Berwick upon Tweed, take the B1340 from Alnwick or the B6347 – both towards Craster Bank. The B1349 then runs parallel to the coast, with minor roads leading to the sea at Newton and Embleton.

O/S REF: NU243231 WEB: www.visittynorthumberland.com

Embleton Bay is one of Northumberland’s finest bays. The iconic Dunstanburgh Castle stands on the cliffs at the south end of the bay and dominates this stretch of coastline. It is one of the UK’s most photographed castles, being particularly photogenic at sunrise – so set your alarm early and get there with time to spare. At low tide, a great sweep of golden sands is exposed, along with rockpools and wavy patterns that – if included within your composition – will add interest and depth to your pictures.

With the dramatic castle ruins beyond forming a key focal point, it’s easy to understand why this is such a good location for landscape photography. It’s a popular beach among tourists, who reach it from Embleton Village or Low Newton, so visit early to photograph clean sands, free of messy footprints.

When you visit Embleton Bay, don’t forget to explore the adjoining coastline and surrounding area for more photo options. Places like Alnmouth, Bamburgh and Holy Island are only a short drive away and are equally photogenic.

Northern England

Roseberry Topping
North Yorkshire

Above: Like a mini Matterhorn, Roseberry thrusts up from Cleveland. The approach to the hill has many features to give the peak context.

LOCATED: Newton-under-Roseberry, North Yorkshire
GETTING THERE: It is located one mile from Great Ayton next to Newton-under-Roseberry on the A173 Great Ayton-Guisborough road.
O/S REF: NZ579426 WEB: www.nationaltrust.org.uk

Roseberry Topping is a distinctive hill on the border between North Yorkshire and the borough of Redcar and Cleveland. Its summit is half-cone shaped with a jagged cliff. From the top, you can enjoy a magnificent 360° panorama stretching as far as Teesside in one direction and the Yorkshire Dales the other.

The area is rich in wildlife – particularly moorland birds – but most photographers visit to capture wider views of this iconic location. The ‘Cleveland Matterhorn’, to give it its ironic local nickname, is traditionally best photographed in context with its surroundings. An array of footpaths wind through this beautiful landscape – including the Cleveland Way – so it is easy to explore the area in order to find good viewpoints.

Visit in advance and earmark potential compositions; by doing so, you can ensure that you are in position and ready when the light is at its best. Being located on the northern edge of the North Yorkshire Moors, and not far from the coast, the whole region is bound to appeal to scenic photographers.
Northern England

Holy Island of Lindisfarne
Northumberland

Below: The ruins are best photographed in the evening light with the rough North Sea crashing into the shoreline.

LOCATED: Near Berwick-upon-Tweed, Northumberland
GETTING THERE: Take the A1 North of Alnwick or South of Berwick and head for Boulmer. Holy Island is signposted off the A1. Ensure you abide by the safe causeway crossing times.
OS REF: NU135447 WEB: www.lindisfarne.org.uk

LINDISFARNE IS A TIDAL ISLAND off the north-east coast of England, also known as Holy Island. It can only be reached via car by driving over a causeway at low tide. This is a truly photogenic place. Large parts of the island, and all of the adjacent intertidal area, are protected as Lindisfarne National Nature Reserve to help safeguard the internationally-important wintering bird populations. Its best-known and well photographed landmark is Lindisfarne Castle – a 16th century fortification, which has been under the care of the National Trust since 1944. Sited on top of a volcanic mound, the castle is distinct and picturesque. It can be seen for miles around and best shot from the beach, where the rocky shore creates ideal foreground interest. This is a great location for shooting close-ups of interesting and colorful texture of subjects like old fishing boats and rock detail. Therefore, in addition to a wide-angle, carry a medium telephoto or macro lens for isolating details when you visit. The light is best at first and last light. The castle can also look striking silhouetted against a colourful sky.

Northern England

Bamburgh Castle
Northumberland

Above: Sand patterns provide perfect lead-in lines towards the distant castle.

LOCATED: Near Belford, Northumberland
GETTING THERE: The castle is situated 42 miles north of Newcastle and 20 miles south of Berwick-upon-Tweed. From the A1, take either the B1342 or B1341 and follow the signs to Bamburgh, where there is parking.
OS REF: NU184351 WEB: www.bamburghcastle.com

THIS IS ONE OF THE MOST imposing and photogenic castles in England. Some photographers seem to live there! It’s certainly worth arriving early and staying until after the sun has set. Positioned on a basalt outcrop, it dominates this stretch of the beautiful Northumberland coastline. The stunning sandy bay here stretches for miles – starting three miles south of Bamburgh, at Seahouses, and extending virtually uninterrupted all the way to Cheswick Sands, 15 miles to the north. That’s a good hike in a day, so get your comfy socks on.

This is a location not short of foreground interest. North-west of the castle is interesting, deeply-scoured dolerite rock, which can be utilised to add interest and drama to views of the castle.

Alternatively, photograph the castle from the beach at low-tide, or from the sand dunes when the tide is high. Second World War defences, a ship wreck and a nearby lighthouse provide yet more picture potential. For the best light, visit at dawn or dusk, when you’ll also find the location will also be less populated.
The Lake District
Cumbria

Above: Not a caravan, nor another living soul in sight. Early morning in the Lakes. Right: Mountains and clouds reflected in lakes, everywhere you look.

LOCATED: Kendal and Keswick in Cumbria
GETTING THERE: The M6 runs to the east of the Lake District National Park, take junction 36 and then A590 for the southern end of the Lake District or junction 40 and the A66 or A592 for the northern end.
G/S REF: SD409575 WEB: www.cumbria-the-lake-district.co.uk

The Lake District – or ‘The Lakes’ – is renowned for its stunning beauty and as a result it gets very busy all year round.
Undulating hills are decorated with every shade of green, whilst moorland and peat bogs add their own charm. Colours and textures to the fabric of the fells. Woods and forests nestle in hillsides and, along the Cumbrian coast, sandstone cliffs meet sandy dunes.
However, it’s the lakes that landscape photographers will be most drawn to. All are photogenic, but Buttermere, Ullswater and Windermere are particularly well suited to scenic photography.
Visit on still, windless days for the best reflections. Derwentwater, the widest of the lakes, is overlooked by the mighty Skiddaw and, with the bustling market town of Keswick on its northern shore, it is a popular beauty spot. Photographers will adore this location. With its photogenic jetty and rowing boats, stunning landscape images are possible. Whilst the Lake District is worthy of a visit throughout the seasons, it is best during autumn, when the landscape is golden and colourful and the crowds have dwindled a bit.
Central England

Peak District
Derbyshire

Above: An ND graduated filter will help to balance the light levels of sky and land.
Right: Grindstones hewn from the rock then abandoned provide foreground interest.

LOCATED: Peak District, Derbyshire
GETTING THERE: From SE: M1 to junction 25, A52 to Derby, then A6 north through Duffield. Beber, or stay on A52 to Ashbourne. From NE: take the M1 to junction 33, through Sheffield and either A57 or A525. From SW: M6, M62, A42. M1 then as from SE.
O/S REF: SK141769 WEB: www.visitpeakdistrict.com

The Peak District is home to Britain’s first National Park. 126,000 acres of gritstone edges, limestone dales and peat moorland combine to create a diverse and photogenic landscape. From the ‘Dambusters’ practice reservoirs near Bamford, across the hills to Castleton and Chapel-en-le-frith, the High Peak is very popular among visitors to the park.

At the eastern edges, the park is punctuated with gritstone cliffs, from Stanage Edge in the north to Harland Edge in the south, which used to be quarried to produce grindstones. Some can still be seen abandoned on the hillside adding interest to images.

The southern area is littered with deep limestone dales carved from the soft rock during the last Ice Age. Locations like Lathkill Dale, Tissington and the beautiful Dove Dale are well worth visiting with your camera. The moors to the west of the park are bleak but atmospheric. Take the high road to Macclesfield. When skies are dark and stormy and the light becomes more dramatic, great landscapes are there just waiting to be captured.
Central England

The Cotswolds

Central England

Above: As well as
landscapes, also look
to shoot quaint village
scenes too.

Right: Broadway
Tower is a folly located
on Broadway Hill,
Worcestershire.

LOCATED: Six counties including Gloucestershire, west Oxfordshire, south-west Warwickshire. GETTING THERE: The Motorway network provides easy access via the M4 or M40 from London and the south-east, the M4 from Wales, and the M5 from the north Midlands, and the south-west.

O/S REF: SP988239 WEB: www.visitchester.co.uk

THE COTSWOLDS ARE A RANGE of limestone hills. To the west they have a scarp slope rising out of the Severn Vale to the highest point at Cleeve Common. From here they slope gently eastwards towards the upper Thames Valley – drained by picturesque rivers such as the Coln and the Windrush.

The underlying stone, with its thin soils, is responsible for the now scarce limestone grasslands that support a wonderful range of flora. The stone is also responsible for the famous Cotswold architecture – ‘chocolate box’ cottages, hamlets and villages of outstanding beauty. Chipping Campden, Stow-on-the-Wold, Moreton-in-Marsh and Bourton-on-the-Water are among the best known and picturesque, but you should also explore the less touristy areas.

Spring is a wonderful time to visit, when the rolling countryside is green and foliage is fresh and vibrant. The Cotswolds are also well known for their many miles of drystone walls – marking the borders of fields and farmland. They will appeal to scenic photographers, who will use them to aid composition and add interest and depth.
Eastern England
Southwold Pier
Suffolk

Below: Suffolk boasts of the most photogenic piers in the UK.

LOCATED: Southwold, Suffolk
GETTING THERE: From the A12, take the A1095 toward Reydon and follow signs for Southwold. There are several car parks in the town.
O/S REF: TMS12756 WEB: www.visit-suffolkcoast.co.uk

SOUTHWOLD PIER IS ONE of the finest examples of a pier to be found anywhere in the UK. Following extensive renovation, it is now complete with a pavilion, restaurant, bar, amusements and the well-known water clock.

It's a pier that has proven highly photogenic, particularly at sunrise. Also, make sure to try photographing it in silhouette, as its instantly recognisable shape is perfectly suited to being captured as an outline. The clean, sandy beach is punctuated by photogenic wooden groynes to the south of the pier and riprap rocks to the north, creating an interesting choice of foreground options.

Consider using an ND filter when photographing views of the beach and pier - the longer exposure time this creates will blur the movement of the water and enhance the sense of movement.

Don't overlook Southwold's row of impeccable, brightly-coloured beach huts lining the shore when you visit the attractive beach and seafront with your digital SLR.

There's also a famous brewery. What more could you want?

Central England
Chester Mill
Warwickshire

Above: Clever use of the furrow as a lead-in line draws the eye towards the mill.

LOCATED: Near Leamington Spa
GETTING THERE: From the M40, Chesterton Windmill is located just off the B4455 (Fosse Way), approx five miles to the south of Leamington Spa, near the village of Harbury.
O/S REF: SP348894 WEB: www.shakespears-country.co.uk

STANDING HIGH ON A HILLTOP overlooking the Roman Fosse Way, this unique windmill is an eye-catcher for miles around.

The mill is domed, circular and raised high on six stone pillars, creating beautiful arches. These support two raised floors. It is like no other building in the country. Landscape photographers should quickly recognise its picture potential.

In summer, crops like barley and wheat are grown nearby and on sunny evenings, the soft, evening light illuminates the mill, its white sails and the gently swaying crops. Attractive cloud will add interest to landscape images and, if you are fortunate, the setting sun will add colour and vibrancy to the sky.

A wide-angle lens will help you create images bursting with depth and life, and a deep depth-of-field will enable you to achieve back-to-front sharpness. This unique viewpoint is worth visiting at any time of the year. The mill can look as striking and dramatic in black & white as it does in colour, so don't overlook the possibility of converting your colour images during post-processing.
Thurne Mill
Norfolk

Above: The light colours of the mill contrast with the dark stormy clouds behind it. Try out various compositions, including using the river as foreground.

Located: Norfolk Broads

Getting There: From Norwich, take the A47 to Acle, then the A1064 to Billockby. Take the B1152 and follow the signs to the village of Thurne.

O/S Ref: TG401159 Web: www.welnorfolk.co.uk

Thurne is a small riverside Broadland village that either gives or takes its name from the River Thurne, which flows directly by.

Thurne Mill, which presumably takes its name from the village or the river, since they were there first, is owned by the Norfolk Windmills Trust and is a major local landmark. The mill is also known as Morse’s Mill (we don’t know who Morse was or where he got his name). This white painted structure, and its large sails, can be seen from miles away. The view of the mill and its surroundings epitomise the Broads – huge skies and low, distant horizons.

A wide-angle lens is essential in order to capture dramatic images of this stunning structure in context with its surroundings. The white mill looks stunning in contrast with a deep blue, polarised sky. It is equally dramatic when set against a dark, menacing stormy sky.

Unsettled weather often produces the most photogenic light and conditions for landscape photography and out here you can see the weather rolling in from miles away. So don’t be a fair weather photographer – visit whatever the conditions.
Happisburgh Norfolk

Above: These worn sea defences are perfect subjects for good foreground interest.
Right: The strong contrast of colour and dark clouds add impact to the composition.

LOCATED: North Norfolk coast
GETTING THERE: From the A149 to North Walsham, take the B1145 and then the B1159 signposted to Happisburgh.
O/S REF: TG384311. WEB: www.norfolk.gov.uk

HAPPISBURGH IS A SMALL VILLAGE on the coast of north Norfolk. This is a truly exposed location, battered by the sea. Wooden sea defences were built to protect the village more than 50 years ago, but they have been unable to stop the erosion. Of course this is tragic for the people living here, but it helps make Happisburgh a wonderful location for landscape photographers.

The decaying and broken sea defences offer huge amounts of foreground interest, particularly at sunrise, when this spot is arguably at its most photogenic. Outdoor photographers can easily spend hours on the beach experimenting with compositions and blurring the tide using long exposures.

There are also opportunities to shoot close-ups of texture and detail, as stones and shells have been driven into the battered wood and rock defences so swap your wide-angle lens for a macro.

When you have finished taking pictures on the beach turn your attention to the famous red-and-white striped lighthouse, which is perched on the cliffs above the beach.
Southern England

New Forest
Hampshire

Below: As well as general scene, head into the forest for dramatic compositions. An ND grad filter darkens the sky and even out the exposure of the scene.

LOCATED: Hampshire
GETTING THERE: The forest is easily accessible, regardless of the direction you approach it from. From Basingstoke, take the M3, M27, and then the A31 — which cuts across the National Park — or the A337 to Lyndhurst.
O/S REF: SU299075 WEB: www.thenewforest.co.uk

The New Forest is England’s smallest National Park and is an area of outstanding natural beauty. Located in the south-west of Hampshire, it consists mainly of lowland heath and woodland. This is a location bursting with potential for outdoor photographers. It is renowned for its wildlife and natural history, but its landscape is equally photogenic and that’s the bit we’re interested in, after all.

The heathlands are at their best in August, when the heather is flowering. Among good locations to visit are Isley Common, Backley Plain and Rockford Common. Early risers may be rewarded with mists hanging in the bottom of the valleys after still, clear nights, adding atmosphere and mood to your scenic shots.

However, the New Forest is undoubtedly at its best in late October and early November, when the autumn colours are at their peak. Soft morning or evening light will add even more warmth to your shots. A polarising filter will remove glare from foliage and help further saturate the stunning autumnal colours.

Southern England

Richmond Park
London

Above: Get up early and combine morning mist with the stunning colours of sunrise. It’s hard to believe that this incredible scene was taken inside the M25.

LOCATED: London
GETTING THERE: By tube/rail go to Richmond Station (British Rail or District Line) and then catch the 371 or 65 buses to the pedestrian gate at Petersham. If driving, there are six car parks within the park.
O/S REF: TQ194739 WEB: www.royalparks.org.uk/parks/richmond_park

At almost 1,000 hectares, Richmond Park is the largest Royal Park in London. Yes that’s right, these stunning scenes were shot in the suburbs of our nation’s metropolis. This attractive landscape of hills, woodland, ponds, gardens and grasslands, set amongst ancient trees, is a haven for outdoor photographers. But it’s so close to the heart of the capital. Get up early to beat the joggers and the most dedicated dog-walkers and make the most of sunrise.

You can visit at any time of year and return with stunning images, but Richmond Park is arguably at its best during autumn — when foliage is red and golden and mist hangs over the parkland after a clear, still night. The park is designated as a National Nature Reserve (NNR), a Site of Special Scientific Interest (SSSI) and a Special Area of Conservation (SAC) and is home to a wealth of flora and fauna, including over 600 free-roaming deer. They can sometimes be caught with a good telephoto or long zoom and included within the landscape to add scale and interest.

Visit at dawn or dusk to enjoy the best light of the day.
South-west England
Swanage Bay
Dorset

Above: The wooden groynes at Swanage bay create perfect lead-in lines in landscape images.

LOCATED: Swanage is South of Poole and East of Dorchester.
GETTING THERE: From Poole, take the A35 and then the A351 signposted to Corfe and Swanage. From Dorchester, take the A352 and then join the A351. There is ample parking within the town and seafront.
O/S REF: ST0378 WEB: www.visitdorset.co.uk

SWANAGE is a SMALL COASTAL TOWN in the south-east of Dorset, situated at the eastern end of the Isle of Purbeck, approximately eight miles south of Poole. Originally a small port and fishing village, Swanage flourished in the Victorian era as a seaside resort. This is a place bursting with picture potential, including an attractive pier, jetty, sandy bay, colourful beach huts and photogenic groynes, jutting out to sea. An early start will be rewarded with a quiet beach, mostly free of people, and good early light on fine days. Nearby are a number of other good locations for landscape photography, including Studland Bay, Poole harbour, Durlston Bay and the magical ruins of Corfe Castle. Swanage is busy with tourists during summer, so photographers are best visiting at quieter times of the year outside of the school holidays. A wide assortment of focal lengths is required to realise the full picture potential of this attractive town. Wellies are also useful if you wish to walk to Peveril Point Road along the seafront, the southernmost tip of Swanage Bay, which boasts sweeping views to Old Harry Rocks.

Southern England
Rottingdean
Sussex Downs

Above: The old wooden windmill is an instantly recognisable local landmark, which acts as a beacon, pointing visitors towards the coastal village of Rottingdean.

LOCATED: Near Brighton, Sussex.
GETTING THERE: From the M25, take the M23 and then the A23 towards Brighton. Take the A27 toward Lewes, before turning right onto the A223 signposted to Rottingdean.
O/S REF: TQ963325 WEB: www.visitbrighton.org

THIS UNUSUAL, BLACK SMOCK windmill was built in 1802, stands to the west of the village on Beacon Hill, which is why it is also known as Beacon Mill. This location boasts sweeping views towards the Sussex coast, but it is the often restored mill itself that will get digital SLR photographers reaching for their memory cards.

As always, light is the key ingredient. Morning and evening light create contrasting results – so visit at different times of the day. In spring and summer, the surrounding meadowland is punctuated with colourful wildflowers that generate good foreground interest.

Using a wide-angle lens, get close to the vegetation in order to stretch perspective – this will increase the three-dimensional feel of your landscapes. The bold outline of the mill is perfectly suited to being shot as a silhouette. A colourful sunset or sunrise will allow you to contrast its inky, black outline against a warm orange sky.
Kimmeridge Bay
Dorset

LOCEATED: Near Lulworth. GETTING THERE: Via the A351 through Wareham; heading towards Swanage. At the base of Corfe Castle turn right towards Church Knowle. Taking the second turning on the left to Kimmeridge. Toll road to the bay during the season.

G/S REF: SY905789 WEB: www.purbeck.gov.uk

Kimmeridge Bay forms part of Dorset’s famous Jurassic coastline. This location is not only renowned for its geology, rockpools and marine wildlife, but for its photographic potential. Parking is free and the walk down to the rocky beach is short, although there is a charge to drive the toll road from the village to the bay during the holiday season.

This location is best visited later in the day with the best light at sunset. At low tides, photogenic rock ledges are exposed and the Clavell Tower, a 19th century folly built by a vicar, perched on the adjacent cliff top, adds interest to the distance view. The tower was moved 25 metres away from the crumbing cliff between 2006 and 2008 by the Landmark Trust and can be rented for a holiday.

Other than the wider views, consider taking more abstract looking images of the rock ledges – maybe with the tide gently lapping over them – using a short telephoto lens. Also look for detail, rock formations, marine life and even fossils whilst visiting this stunning part of the Purbeck coast.
**Exmoor National Park**
Devon/Somerset

Above: The River Lyn is rushing in the foreground with houses of Lynmouth.
Right: Head to the coast late in the day and capture stunning coastal scenes like this.

**LOCATED:** Straddling Devon and Somerset. **GETTING THERE:** From the M5, take the A308 at Taunton and then join the A39 to Minehead. From here, you can follow the A39 along the Exmoor coast. There are numerous minor roads that will take you inland, in order to fully explore the Park.

O/S REF: SS89145. WEB: www.visit-exmoor.co.uk

EXMOOR NATIONAL PARK covers 267 square miles of the beautiful rolling Devon and Somerset countryside. Boasting both wonderful coastline and lush countryside, this is a rich landscape.

The Park has 34 miles of coastline, including the highest cliffs in England - which reach a height of 1,320ft at Culbone Hill. The coast varies greatly, from the sandy bay at Combe Martin to the pebbly shores of Porlock and Bossington. Near Lynmouth is the Valley of the Rocks - a remarkable stretch of coastline. The rocky outcrops look striking bathed in soft, warm evening sunlight.

Exmoor is best known for its wooded valleys and moorland. On a clear day, the view from the summit of Dunkery Beacon, or Quantock Hills, is thrilling. In late summer, the moors are carpeted in pink and purple heather. Wind-swept trees add interest and a focal point to wide-angled views. Exmoor is home to photogenic rural towns and hamlets, like Barnstaple, Dunster and Selworthy. Don’t forget to visit Tarr Steps - a prehistoric clapper bridge across the River Barle - one of the Park’s most recognisable landmarks.
**South-west of England**

**Porth Nanven, Cornwall**

Below: A small aperture on a wide lens gives “dinosaur egg-to-Bristows” sharpness. Set up a tripod at the water’s edge for a motion blurred foreground.

**LOCATED:** Near St Just, west Cornwall  
**GETTING THERE:** From Penzance, take the A3071 to St Just. From the town centre, follow the signs to the Cot Valley. At the end of this narrow, minor road is a small parking area.  
**O/S REF:** SW355367  
**WEB:** www.visitcornwall.com

PORTH NANVEN (also known as Cot Valley Beach) is a secluded little beach at the seaward end of the Cot Valley in Cornwall. It has been designated a Site of Special Scientific Interest and is a location just bursting with photogenic landscape potential.

The beach is referred to locally as ‘dinosaur egg beach’ due to the remarkable number of ovoid boulders – ranging greatly in size and covering the beach and foreshore. They can be photographed in context – as part of a bigger beach scene and seascape – or isolated, using a longer focal length lens in order to emphasize their fascinating colour and shape.

A mile or so out to sea is a pair of big rocks called the ‘v’. They are perfectly positioned for landscape photography, as they can be utilised to harness the horizon in wide-angle views of the beach. They can also look good photographed alone, particularly in the evening when there is a colourful sunset behind them.

Porth Nanven is best photographed in the evening, when the beach and coast are bathed in soft, warm light.

---

**South-west of England**

**Dartmoor, Devon**

Above: Early morning is a good time for clear skies before cloud blows in from the west but when it’s this dark and brooding, conditions are perfect for moody shots.

**LOCATED:** Between Exeter and Plymouth  
**GETTING THERE:** Dartmoor is reached by both the A30 and A39, which offer rapid journey times from the M5 straight to the fringes of the National Park.  
**O/S REF:** SX669758  
**WEB:** www.dartmoor-npa.gov.uk

DARTMOOR IS GREAT BRITAIN’S LAST remaining wilderness. The designated National Park covers an area of 368 square miles, the largest region of open country in southern England.

Its rugged, windswept appearance makes it an attractive landscape photographer’s paradise. In late summer, the bracken, heathers and gorse combine to carpet large areas with colour.

The best views of its outstanding scenery are enjoyed from one of 150 or so granite tors that dominate the landscape. Haytor and Houndtor are among the most spectacular and popular.

The unusual rock formation of Bowerman’s Nose, near Manaton, will also appeal to photographers, as will the picturesque villages of Widecombe and Buckland-in-the-Moor. The ancient clapper bridge at Postbridge is also well worth visiting, as is Brentor – a tiny church perched on the top of a rocky outcrop near Tavistock, with wonderful sweeping moorland views. With Dartmoor boasting moorland streams, steep wooded valleys, ancient archaeology and curious granite crosses, landscape photographers are spoilt rotten.
South-west England

Trebarwith Strand
Cornwall

Above: A lengthy exposure creates ethereal, atmospheric looking seascapes.

LOCATED: Near Tintagel, north Cornwall. GETTING THERE: Follow the A30 from Wadebridge north to Camelford. At Camelford take the B3265, then the B3263 to Tintagel. About a mile before Tintagel, turn left and follow signs to Trebarwith Strand. There is a car park near the beach.
O/S REF: SX 05056 86408 WEB: www.north-cornwall.com

Trebarwith Strand has to be one of the most photogenic locations along the north Cornish coast. It is approximately two and a half miles south of Tintagel and a great location to visit with your DSLR – all either high or low tide. The beach is at the bottom of a deep valley with many attractive views along the Heritage Coastline. You can either photograph the rugged coastline from the coastpath above, or shoot from the beach itself. Low tides reveal a wonderful sandy bay with jagged outcrops. Over centuries, the tide has carved interesting shapes into the rock, so there is no shortage of picture potential or foreground interest here. Rough seas can prove particularly dramatic and Gull Rock, positioned around 500 metres offshore, further enhances the picturesque setting.

A wide-angle lens is essential when you visit and a moderate zoom will also be useful for isolating detail and photographing crashing waves. The rocks can be slippery, so watch your footing and wear appropriate footwear. Also, the tide can rise quickly and catch you unaware, so check tide times before your visit.
South-west of England

Land's End
Cornwall

Above: Enys Dodman arched rock is one of Cornwall’s most famous and photogenic landmarks.

LOCATED: Near Sennen, West Cornwall
GETTING THERE: From Penzance, follow the A30 signposted to Sennen and Land’s End. The visitor centre and attractions at Land’s End are well signed. There is ample parking here, but you have to pay to park.
G/S REF: SW3425254. WEBSITE: www.visitcornwall.com

FAMOUSLY, LAND’S END is the UK’s most westerly point. It might be a major tourist attraction today, complete with a shopping centre, but the main attraction remains its unique location and amazing coastline. A short walk in either direction along the coastal path from the main complex provides fantastic ocean views as far as the eye can see. There are many interesting and unusual rock formations just off shore, which are perfect for wild landscape images. These include the famous Enys Dodman arched rock, which is situated just off Porthmeor Point above Gribin Farm. Also visible is the scenic Longships Lighthouse, a couple of miles out to sea. Although photogenic in the morning light, it is often best in the evening when the sun is setting out to sea. This is a wonderful location from which to photograph winter storms and large waves crashing against the Cornish headland. It is a great place to visit throughout the seasons and whatever the weather. As it’s at the very tip of the country, it’s worth taking some time to explore the coastline as you’re unlikely to visit too often.
South-west England

Botallack tin mines
Cornwall

Below: You can photograph the twin mine shafts from adjacent cliffs in order to achieve a natural, parallel viewpoint.

LOCATED: Near St Just. GETTING THERE: From the A30, drive to Penzance. Take the A3071 to St Just, then the B3306 toward Pendennis. When you reach Botallack, turn left just before righthand bend. Follow this track for 300m before parking adjacent to The Count House, a National Trust property.

OS REF: SW362333 WEB: www.cornish-mining.org.uk

PERCHED PRECARIOUSLY on the cliffs at Botallack are the Crowns engine houses. Located between St Just and Pendennis in west Cornwall, this area is littered with the remains of Cornwall’s once great mining industry. The twin remains of the Crown’s engine houses are one of Cornwall’s most recognisable landmarks. Built around 1815, today they are protected as part of the Cornwall and West Devon Mining Landscape World Heritage Site. They are best photographed at high tide, when the sea is crashing over the jagged rocks below. A short to medium telephoto lens is a good lens choice, allowing you to isolate the mine shafts. A lengthy exposure can create ethereal, atmospheric results, so an ND filter is a useful attachment. Wear good, supportive footwear, as the coast path is steep in places. Our advice is to visit in early evening, when the light is best suited to the location. Pictures of the mines often suit black & white conversion, so don’t overlook this possibility when processing your images, or you could try taking a series of exposures and generate a dynamic HDR landscape.

South-west of England

Cherhill
Wiltshire

Above: Cherhill white horse looks particularly photogenic in context with the surrounding countryside.

LOCATED: East of Calne, Wiltshire
GETTING THERE: It is situated on the edge of Cherhill Down, off the A4 Calne to Marlborough road just east of the village of Cherhill.
OS REF: SU049696 WEB: www.visitwiltshire.co.uk

THE CHERHILL WHITE HORSE is a 38-metre stone structure, erected in 1845, and is the second oldest of the Wiltshire horses. Situated on the edge of Cherhill Down, it is located just below earthworks known as Oldbury Castle and also found nearby is the . The horse is wonderfully placed, being high on a steep slope, and is easily visible from below and from a distance. Facing north-east, the horse is best photographed in the warm, evening light and particularly suits dappled light or when there is dramatic sky overhead. A good viewpoint is from a lay-by alongside the westbound carriageway of the A4, which passes below the horse. From near here, a footpath climbs the hill towards the horse itself. Although it can be tempting to photograph it so that it fills the frame – either by getting close to it, or by shooting it using a telephoto lens – often the best approach is to photograph it in context with its surroundings. In late spring and summer, the nearby farmland is usually vibrant with grasses or crops, adding interest and colour to wide-angle shots.
South-west England

Bedruthan Steps
Cornwall

Above: In late spring, the cliff tops are carpeted with wild flowers – perfect foreground interest.

LOacted: Near Newquay
GETTING THERE: Just off B3276 from Newquay to Padstow, six miles south west of Padstow. Park at the National Trust car park at Carnewas and Bedruthan Steps.
O/S REF: SX049692 WEB: www.cornwallbeachguide.co.uk

BEDRUTHAN STEPS is one of the most spectacular stretches of coastline in the UK. Coasal erosion has worn back the cliff face, leaving huge outcrops of volcanic rock scattered along the length of the beach. These towering monoliths are surrounded by water at high tide and are best photographed form the coastal path above. In spring, the cliff tops are carpeted in colourful thrift and the rugged cliffs glow in the warm, late evening light. At low tide the beach is accessible via a steep staircase. The descent and climb back up is steep, but it is well worth the effort, as this sandy bay is a spectacular site when the tide is low and sunset bathes the view in golden light. However, due to safety, the gate providing access to the steps is locked between November and February. Bedruthan Steps is photogenic throughout the seasons, but particularly in spring with the emerging foliage and during the winter months when stormy clouds create images with intense drama. A wide-angle lens is essential, together with a tripod for stability. An ND filter will be useful if you wish to blur the water’s motion.
Scotland

Plockton
Ross-Shire

Below: On calm mornings, photograph the picturesque reflections in the attractive harbour of Plockton.

LOCATED: Ross-Shire, West Highlands.
GETTING THERE: Take the A87 toward the Kyle of Lochalsh. It is approximately six miles from here and Plockton village is clearly signed.
OS REF: NJ38033334. WEB: www.plockton.com

NEAR THE SEAWARD END of Loch Carron lies the picturesque village of Plockton – on the coastal route from Stromeferry to Kyle of Lochalsh. This delightful, small lochside village is one of the most attractive in Scotland – it is an idyllic place in an idyllic setting, and thanks to the warm Gulf Stream even boosts a number of palm trees! A row of neatly painted cottages hugs the shoreline, following the curve of the modest harbour. Across the harbour are views of whitewashed cottages standing on a craggy point with the mountains of Western Ross forming a dramatic backdrop. On calm, still mornings the boats moored in the harbour, together with their perfect reflections, create a picturesque scene waiting to be exploited by photographers. This is a place where it appears time has stood still. Within an hour’s drive are similarly photogenic locations, like Eilean Donan Castle, Glenelg and the Brochs, the Isle of Skye and Applecross Bay. You will take countless pictures when you visit, so carry plenty of memory cards and a portable storage device to keep your images safely backed-up.

South-west of England

St Michael’s Mount
Cornwall

Above: Knowing tide times is critical when photographing this location.

LOCATED: Marazion, near Penzance.
GETTING THERE: Follow the A30 past Hayle. Drive through the village of Crowlas, before coming to a roundabout. Take the 2nd exit, signposted to Marazion. Follow the signs to Marazion, where there is ample parking.
OS REF: SW594596. WEB: www.stmichaelsmount.co.uk

THIS IS ONE OF THE SOUTH-west’s most recognisable and dramatic landmarks and a favorite with landscape photographers. Perched upon this craggy little island is an enchanting medieval castle and church. St Michael’s Mount, which is cared for by the National Trust, can be reached via a causeway at low tide, or by boat at high tide. However, photographers will prefer to take pictures from the beautiful sandy bay at Marazion.

This is a location that is good at both sunrise and sunset, at both high and low tide, and throughout the seasons. However, it is best at low-tide, as you can utilise the brick causeway – leading to the mount – as foreground interest to help lead the viewer’s eye towards the island. Don’t just visit when the conditions are sunny – this is a location well suited to stormy, dramatic skies, rough seas and crashing waves. A wide-angle lens will help you to include lots of interest in your foreground to help you create image bursting with depth. Don’t forget your wellies when you visit and make sure to check tide times in advance.
Isle of Skye
West Scotland

Above: Old Man of Storr basalt columns creates a scene of prehistoric beauty.
Right: The Quiraing offers incredible scenes and is easily accessible by road.

LOCATED: Off the west coast of Scotland
GETTING THERE: Skye can be reached via road and also ferry. From Glasgow, take the A82 and then the A87 to the Kyle of Lochalsh. From here, travel over the toll bridge and onto Skye itself.
G/S REF: NG999297. WEB: www.skye.co.uk

EVERY LANDSCAPE PHOTOGRAPHER should make a resolution to visit and photograph the incredible Isle of Skye at some point. Found on the west coast of mainland Scotland, it is the largest and best known of the Inner Hebrides. Skye is renowned for its stunning natural beauty. This is simply a magnificent location for photography – a wonderful variety of landscapes awaits.

Rising straight out of the sea to a height of over three thousand feet – and often shrouded in mist – the Cuillin mountains are regarded by many as the finest in Britain. The fantastic pinnacles of the Storr and the Quiraing are among the natural wonders of Scotland. In addition to its natural beauty, Skye also has many man-made features with picture appeal. These include standing stones, brochs (small drystone roundhouses) and many ruined buildings and deserted settlements. And, of course, the fairly new and controversial road bridge.

However, it is the magical light, created by ever-changing weather, which makes Skye such a special place for scenic photographers.
SITUATED ON ITS OWN island at the meeting point of three great sea-lochs and surrounded by magnificent mountain scenery, Eilean Donan Castle is one of Scotland’s most stunning locations. It’s also very close to Skye, so drop in on the way.

It is possibly the most photographed castle in the UK and, when the light and conditions are right, you will return from this viewpoint with wonderfully dramatic and atmospheric images. When the water is still, you will capture mirror-like reflections of the castle and highland scenery, adding yet more interest to your photos.

Don’t pack your DSLR away and return home too soon – the castle is photogenic at dusk when the castle is often illuminated by floodlighting. A long exposure of several seconds will be required, so don’t forget to pack a sturdy tripod!

Being such a dramatic, atmospheric location, images of the castle can suit black & white photography too, so shoot colour with possible conversion later in mind. Revisit your images during post-processing and make some moody mono prints.
Scotland

Rannoch Moor & Glencoe, Scotland

Above: No visit to Glencoe is complete without a shot of Black Rock Cottage.
Right: This foreground lighting will last for just seconds, but you can wait for hours.

LOCATED: Scotland
GETTING THERE: From Glasgow, follow the M8 and cross the Erskine Bridge. Join the A82 to Dumbarton and Loch Lomond. Take the A82 over Rannoch Moor and to Glencoe.
G/S REF: NN666667 WEB: www.visitscotland.com

The Glencoe region contains some of the most magnificent and spectacular scenery anywhere in the UK. The glen lies east to west, with the steep hillsides of The Three Sisters to the south, and the Aonach Eagach to the north.

Guarding the entrance to the glen, from Rannoch Moor, is the mighty Buachaille Etive Mor. It is everything a mountain should be - an almost perfect pyramid that is often snow-capped during the winter months. The classic view of the mountain is from Black Rock Cottage. This iconic dwelling can be found on the A82 before you enter into Glencoe fully. It is on a small single track road that ends at the Glencoe Ski Centre.

The vast expanse of Rannoch Moor stretches across Argyll to Glencoe and is crossed if approaching the glen from the east. The moor is wild and sombre and well worth visiting throughout the year, but autumn and winter are normally best. Unsettled weather suits this wild landscape, so wear warm, waterproof clothing and always take care when walking in mountainous regions.
Above: Dramatic views towards Rum are possible from Egg.

**LOCATED:** Near Mallaig, Inverness-shire

**GETTING THERE:** There are daily sailings to Egg on the Caledonian Macbrayne ferry service from Mallaig, located around an hour’s drive from Fort William on the A830. For more information, visit: www.arnsag.co.uk

**OS REF:** NM4884 **WEB:** www.isleofegg.net

LYING TEN MILES off the Scottish west coast, the Isle of Egg is one of the most beautiful Hebridean Islands. The island has a fascinating history, superb wildlife and birdlife and a temperate maritime climate. Although only a small Island, this is a haven for photographers.

The spectacular beach at Lag Bay is a favourite among landscape photographers. The rugged shore is full of interest, detail and colour and, together with the spectacular backdrop of Rum in the distance and the cliffs of Cleardale behind, great scenic images are almost guaranteed. Also worth visiting is the sandy beach of Sandaig Sand Bay. This is slightly further up the coast, but shares the dramatic view of Rum, which is often shrouded in low hanging cloud. Graduated Neutral Density filters can be used to enhance stormy, menacing skies – both hard and soft transition filters are worth having in your camera bag. Egg is also home to lush woodland and an old colonial style mansion. Photographers should be prepared to walk reasonable distances to reach the best viewpoints so remember to pack some suitable footwear and warm, waterproof clothing.
The Isle of Lewis is a very remote location but offers plenty of photographic potential for those willing to make the journey to reach it.

**LOCATED:** North West of the Hebrides  **GETTING THERE:** Caledonian MacBrayne run ferries to two ports in Lewis and Harris. Stornoway Airport, is the main airport for flights to the Western Isles. Flights run direct from Edinburgh, Glasgow, Aberdeen and Inverness.

**OS REF:** NB426340  **WEB:** www.isle-of-lewis.com

The isles of Lewis and Harris are at the north west corner of the Hebrides, a group of Islands known as the ‘long islands’. As they stretch for 100 miles, both the east and west coasts of the Island have rugged stretches of cliffs often giving way to huge beaches of clean white sand. Inland, the terrain is principally level moorland dotted with fresh water lochs. Quite simply, this is a location bustling with picture potential. The Butt of Lewis, in the extreme north, is home to high, steep cliffs. The highest point is 142ft high, and crowned with a spectacular lighthouse - its light is visible for 19 miles. Tolsta is a crofting village, notable for its long, white sandy beaches. The tranquil and beautiful beach of nearby Traigh Mhor is about two miles in length and its wonderful white sands are full of beautiful patterns and texture. Lewis is also steeped in history. Callanish Standing Stones is one of the most important megalithic complexes in Europe. The circle is particularly photogenic set against a dramatic or colourful sky. Take along a ten-stop ND filter to capture motion in the clouds.
ElegugStacks
Pembrokeshire

Below: A menacing, stormy sky will help landscape photographers realise the full drama of this unique location.

LOCATED: Nr Mennor on the Castlemartin Peninsula. GETTING THERE: From Cardiff, follow the M4 and then the A48 to Carmarthen. Join the A40, A77 and then the A4075 to Pembrok and then to Mennor. Follow the sign for ‘Stack Rocks’ just past the army base in Mennor on the B4319.
O’S REF: SH9397944. WEB: www.visitpembrokeshire.com

ELEGUG STACKS are two limestone pillars standing freely a short distance from the cliffs on the coastline of Pembrokeshire in southwest Wales. The stacks are found on the Castlemartin peninsula, where colonies of guillemots, razorbills and kittiwakes can be found – Elegug is actually Welsh for Guillemot. This is one of the most dramatic coastal viewpoints in Wales and is particularly photogenic when there is a stormy sky overhead. A wide-angle lens is essential in order to capture the full drama of this unique viewpoint, while photographers who also enjoy shooting nature may want to carry a powerful telezoom for photographing seal birds. The rock stacks lie just to the east of the Green Bridge of Wales, another fascinating and photogenic rock formation, worth visiting while you are in the area. Stack Rocks car park is approached through the Castlemartin military zone. Because the Ministry of Defence train in this area, there is only access to Elegug Stacks on certain days, when the shooting ranges are closed. We advise you ring before you visit on 01646 662367 to avoid making a wasteful trip.

Brecon Beacons
South Wales

Above: The green peaks of the Brecon Beacons are easily reached by foot.

LOCATED: South Wales. GETTING THERE: The Park is well served by good trunk roads from the motorway network. From the M4, take the A449 to Raglan and then the A40. From Cardiff, simply take the A470. From the M5, take the M50 to Monmouth and join the A40 into the area.
O’S REF: SO03498. WEB: www.breconbeaconstourism.co.uk

THE BRECON BEACONS National Park contains some of the most spectacular and distinctive upland formations in southern Britain. The park stretches from Hay on Wye in the east to Llandedda in the west. Its photogenic and diverse landscape boasts moorland, forests, steep valleys, impressive waterfalls, lakes, caves and gorges.

Arguably, autumn and winter are the best times to plan your visit, with the snow-capped Beacons providing a dramatic backdrop. Changeable weather conditions, when sun and rain alternate rapidly, suit this rugged landscape well.

The mountains are mostly gentle and grassy on the southern side, with steep escarpments on the north. The summits are easily accessed – good news for photographers wishing to shoot impressive, far-reaching panoramas. On a clear day, the view from Pen y Fan (the highest summit) is awe-inspiring. This is also ‘waterfall country’, being home to some of the UK’s most magnificent falls – like Henrhyd Falls, the highest in south Wales. The curtain waterfall of Sgwâr yr Eira is among the most photogenic.
Dunraven Bay
South Wales

FORMING PART OF THE stunning Glamorgan Heritage Coast, Dunraven Bay is one of the most photogenic beaches in Wales. At low tide, its wide sandy bay is often wet and reflective, enabling photographers to shoot a mirror image of the scenery and sky. The rugged cliffs boast fascinating geology, with wonderful shapes and texture carved into the rock. Rockpools and patterns in the sand create interesting foregrounds and, even at high tide – a time to avoid at many coastal locations – the wide pebble ridge is photogenic as the waves lap over it. You may prefer to take pictures from the cliff tops. If so, the best place to catch the evening light is around Trwyn Y Witch (Witch’s Nose Point). As this coastline mostly faces south-west, winter is the best time of year for photographers to visit, when the low sun is further south in the sky. However, as Dunraven Bay is oriented in a more westerly direction, this mitigates the seasons to a degree – Trwyn Y Witch looks great in low summer sun. Book a B&B and spend a couple of days here to ensure you make the most of this location’s potential.
Snowdonia
North Wales

Above: Spend a couple of hours shooting
Llyn Idwal overflow, near
right: A silo on Mount
Snowdon, lit by sunset
light, provides
foreground interest.

LOCATED: North Wales
GETTING THERE: From Birmingham, take the M6 north and
then the M54 for north and mid Wales. Join the A5 to Snowdonia.
The A6, along with the A493 are the Parks main roads.
O/S REF: SH752562 WEB: www.visitsnowdonia.info

SNOWDONIA NATIONAL PARK is an area of outstanding natural
beauty. Covering 838 square miles, it is home to some of the most
magnificent scenery in Wales. And while some locations look best
in good weather, the rugged beauty of Snowdonia suits stormier
conditions. Snowdon – at 1,085 meters, the highest mountain in
Wales – is an impressive sight and will provide a focal point for
many successful images. During winter, the mountain peaks are
usually capped with snow and stormy, white dramatic skies help
photographers capture the wild beauty of this landscape. Aside
from its impressive mountain ranges, there is much to entice
landscape photographers. The region is renowned for its beautiful
forests, reflective lakes and large waterfalls. Check out the vast
slate quarries, too. The area around Capel Cunig is particularly
photogenic, but with so much picture potential everywhere, this
really is an area that you need to spend time exploring. Much can
be reached by car but we’d recommend you explore the mountains
on foot to really feel in touch with the scenery you’re shooting.
Carlingford Bay
County Louth, Eire

Above: The Mourne mountains are the most picturesque mountain district in Ireland. Right: Make sure to visit the beautiful Glen River in the Mourne mountains.

LOCATED: Near both Belfast and Dublin
GETTING THERE: It is just over an hour’s drive from Dublin and Belfast airports. From the M1 take the R173 and follow the signs to Carlingford.
O/S REF: J18616 WEB: www.carlingford.ie

LESS THAN AN HOUR’S drive from Dublin or Belfast, Carlingford nestles between Slieve Foy, Carlingford Lough and the Mourne mountains. This is an area of spectacular panoramas, unspoiled natural beauty and historic landmarks.

Carlingford Lough is a sheltered inlet of the Irish Sea, over ten miles long and flanked by mountains. Its sheltered sands, rocky islands and boulder shores will appeal to scenic photographers.

The shapes and textures of the pebbles on the beach are very photogenic. Still weather creates attractive reflections, while unsettled conditions produce stormy views, with dramatic lighting.

Fishing remains an important industry on the Lough, and stone quays pepper the shoreline. The region offers a rich heritage of ancient and not so ancient monuments – prehistoric stone formations and earth works, Norman castles and medieval abbeys all add further picture potential.

Also worth visiting with your camera are the nearby Victorian seaside resorts of Warrenpoint, Rostrevor and Onenath.
Northern Ireland

Waterfoot Co Antrim, Northern Ireland

Below: With over a mile of stony beach, there is no shortage of photo opportunities.

LOCATED: Co Antrim, Northern Ireland
GETTING THERE: From the M2, take the A43 toward Cushendall. Join the A2 and follow the signs to Waterfoot.
O/S REF: D242248 WEB: www.discovernorthernireland.com

WATERFOOT IS A PRETTY HAMLET in County Antrim, situated between the towns of Carnlough and Cushendall on the north-west coast of Northern Ireland.

It is situated at the foot of Glenariff – one of the Gien of Antrim – and has a beautiful mile-long beach. The village lies by Red Bay, named due to the reddish sand that washes from the exposed sandstone on the cliffs down to the shore. Landscape photographers will be drawn to Waterfoot’s photogenic beach, but there is much more in this area to shoot, aside from the bay.

The harbour is one of the most sheltered and picturesque on the Antrim coast and, a short distance away, stands the White Lady, a chalk figure carved by the sea washing against the cliffs.

Nearby Glenariff Forest Park boasts outstanding scenery. It is a designated ‘Area of Outstanding Natural Beauty’. Bisection the Park are two small but beautiful rivers – the Inver and the Glenariff. Here you will find spectacular waterfalls, tranquil pools and stretches of fast-flowing water tumbling through rocky steep-sided gorges.

Northern Ireland

Giant’s Causeway
Northern Ireland

Above: Balanced composition creates journey through the fore-, mid- and background. Shoot with the camera upright and use the Causeway to lead the eye into the scene.

LOCATED: North coast of County Antrim, Northern Ireland
GETTING THERE: From the A2, take the B146 Causeway to Dunseverick road two miles east of Bushmills and follow signs for the Causeway.
O/S REF: C952452 WEB: www.giantscausewaycentre.com

GIANT’S CAUSEWAY IS STEEPED in history and legend, most relating to Irish warrior Finn McCool’s feud with Scottish rival Benandonner. McCool was said to have built the ‘causeway’ to walk across the sea to Scotland.

It is a World Heritage site and is Northern Ireland’s most iconic and best known viewpoint. It is renowned for its striking, polygonal columns of layered basalt – actually a geological phenomenon caused by the cooling of lava after an ancient volcanic eruption.

The stunning coastal scenery here is quite simply among the most awe-inspiring you will find anywhere – this is a location that landscape photographers must visit whilst in Northern Ireland.

A wide-angle lens is essential to capture sweeping views of the Causeway. Explore this location and search for the distinctive stone formations that are found here, like the fancifully named ‘wishing chair’, ‘candle’, ‘harp’ and ‘organ’. This is a hugely popular tourist attraction, so try to avoid visiting during peak times when other people can inhibit good landscape photography.
North-west Ireland

Donegal
Ireland

Above: Dunlewy Church is located in Derryveagh, Poisoned Glen. Right: Fanad Head lighthouse warns shipping away from the dangers near Fanet Point.

LOCATED: North West Ireland
GETTING THERE: County Donegal is serviced by the main N15 and N56 roads, from which you can explore the region.
O/S REP: G933757 WEB: www.discoverireland.com

WITH ITS SOARING SEA CLIFFS, which plummet up to 300 metres, deserted white sandy beaches and rugged landscape, Donegal is a spectacular county in Ireland’s north west corner. The county consists chiefly of low mountains with a deeply indented and photogenic coastline, forming natural loughs of which Lough Swilly and Lough Foyle are notable. The famous Hills of Donegal consist of two major ranges, the Derryveagh mountains in the north and the Bluestack mountains in the south. The Slieve League cliffs are the second highest sea cliffs in Europe. Malin Head is the most northerly point in the island of Ireland. It lies at the top of the Inishowen Peninsula, jutting out into the wild North Atlantic, and is a great location for coastal photography. Landscape photographers should allow themselves plenty of time to explore this beautiful region. The coast here is a typical of an ocean coastline - rocky coves interspersed with sandy beaches and numerous small settlements, which are just begging to be explored and photographed. This is a wild place, full of atmosphere.
How to use your free exposure metering and WB cards

The 18% grey card can be used to ensure perfect exposures when shooting in tricky lighting conditions (see below). Both reference cards can also be used to set a custom White Balance. Depending on the camera you use, you need to take a White Balance reading off the grey or the white card (your camera’s instructions will show you how).

DIGITAL SLR'S USE sophisticated exposure systems and all work using the same assumption: that the average of the scene that is being metered from is a mid-tone, or 18% grey to be exact; i.e. the average of all dark, light and mid-tones mixed together is 18% grey. It’s the basis of all metering patterns and works surprisingly well but it’s fine for the majority of shooting situations, it can lead to incorrect exposures when the scene or subject is considerably lighter or darker in tone than 18% grey. For example, very dark areas can fool the metering system into overexposing the image. Similarly, very light subjects, such as a snow scene, can fool the camera into underexposing them – making them appear darker than they are – as the light meter will take a reading designed to render them as a mid-tone. As a camera is trying to render an image ‘grey’, it’s your job to ensure you compensate to keep the tones true to life. You can do this by either using one of your camera’s exposure override facilities, such as exposure compensation or the AE-Lock button, or by metering from an area of the scene that has a mid-tone. And that’s where our grey card comes in. Using it is very simple as our step-by-step guide below illustrates. The key thing to remember is that you need to place the grey card in similar lighting to your scene, for instance, don’t place it in a shaded area if your scene is bathed in sunlight. Also, make sure that the card fills the metering area – we’d recommend you use spot or partial metering as the card won’t need to fill the entire image area – but any is suitable. You can either lock the exposure using your camera’s AE-Lock facility or note the aperture and shutter speed and then switch to Manual mode and set these, although this method isn’t suitable to days here lighting is variable. The card has AF reference lines to help your camera’s autofocus lock on to it. However, you don’t necessarily need it to be in-focus to work correctly. The grey card (as well as the white card) can also be used to take a custom White Balance reading from too.

1 GETTING STARTED Place your grey card on the ground angled towards you and ensure it’s located in a spot that is bathed in the same light as the majority of your scene you plan to shoot.
2 TAKE A METER READING Ensure that the entire metering area is filled by the grey card (in this instance we’re using multi-zone metering) and lock the exposure with the AE-Lock button.
3 COMPOSE & SHOOT With this exposure locked, you can compose your scene and take your shots. When you check it on your LCD monitor, the exposure should be perfect.
THE ESSENTIAL GUIDE TO LANDSCAPE PHOTOGRAPHY

START SHOOTING TODAY!
Our experts show how you can take your first steps to shooting brilliant images

LANDSCAPES MADE EASY
Leading pros provide you with jargon-free advice and easy to follow step-by-steps

MASTER BASIC TECHNIQUES
Fundamental photo skills explained including composition and exposure

LEARN THE PROS’ SECRETS
Leading landscape masters reveal their techniques to ensuring perfect pictures

SHOOT FROM DAWN TO DUSK
Experts reveal the secrets to stunning images from dawn to dusk and beyond!

THE UK’S BEST LOCATIONS
Explore and capture over 40 of the UK’s best landscapes with our location guide

CHOOSE THE BEST GEAR
Top rated landscape accessories including tripods, bags and lenses

INSIDE!
EXPERT ADVICE TO HELP YOU TAKE BETTER PICTURES

FROM THE EXPERTS AT Digital SLR photography